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Create Excel Add-In
1 Type libraryCompiler at the MATLAB command line to open the Library Compiler app.
2 In the Library Compiler app project window, specify the files of the MATLAB application that

you want to deploy.

a
In the Exported Functions section of the toolstrip, click .

b In the Add Files window, browse to the example folder, and select the function you want to
package. Click Open.

The function is added to the list of exported function files. Repeat this step to package multiple
files in the same application.

3 In the Packaging Options section of the toolstrip, decide whether to include the MATLAB
Runtime installer in the generated application by selecting one of the options:

• Runtime downloaded from web — Generate an installer that downloads the MATLAB
Runtime and installs it along with the deployed MATLAB application. You can specify the file
name of the installer.

• Runtime included in package — Generate an application that includes the MATLAB
Runtime installer. You can specify the file name of the installer.

Note The first time you select this option, you are prompted to download the MATLAB
Runtime installer.

4 Verify that the MATLAB function you are packing into an Excel add-in is mapped onto a class. You
can change the name from the default name Class 1 to something more meaningful.

5 Customize the packaged application and its appearance:

• Library information — Editable information about the deployed application. You can also
customize the standalone applications appearance by changing the application icon and
splash screen. The generated installer uses this information to populate the installed
application metadata. See “Customize the Installer”.

• Additional installer options — Edit the default installation path for the generated installer
and selecting custom logo. See “Change the Installation Path” .

• Files required for your library to run — Additional files required by the generated
application to run. These files are included in the generated application installer. See
“Manage Required Files in Compiler Project”.

• Files installed for your end user — Files that are installed with your application.

See “Specify Files to Install with Application”.
• Additional runtime settings — Platform-specific options for controlling the generated

executable. See “Additional Runtime Settings”.
6 When you are finished selecting your packaging options, save your Library Compiler project

and generate the packaged application.

1 Click Package.

In the Save Project dialog box, specify the location to save the project.
2 In the Package dialog box, verify that Open output folder when process completes is

selected.

1 Create Excel Add-Ins
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When the packaging process is complete, examine the generated output in the target folder.

• Three folders are generated: for_redistribution,
for_redistribution_files_only, and for_testing.

For more information about the files generated in these folders, see “Files Generated
After Packaging MATLAB Functions”.

• The log file PackagingLog.html contains packaging results.

See Also

More About
• “Create Excel Add-In from MATLAB” on page 2-5
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Getting Started

• “How Excel Add-In Compilation Works” on page 2-2
• “ Excel Target Requirements and Limitations for MATLAB Compiler” on page 2-3
• “Create Excel Add-In from MATLAB” on page 2-5
• “Distribute Add-Ins and Integrate into Microsoft Excel” on page 2-11
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How Excel Add-In Compilation Works
With MATLAB Compiler, you create deployable add-ins that run in Microsoft® Excel applications from
MATLAB code. To convert MATLAB functions for use in an Excel add-in, you use the Library
Compiler app, the compiler.build.excelAddIn function, or the mcc function.

When you compile your MATLAB code, MATLAB Compiler generates two primary artifacts, a COM
component (.dll) and a VBA module (.bas), which it then integrates into a Microsoft Excel add-in
(.xla).

To support integration with Microsoft Excel, MATLAB Compiler builds each Excel add-in as a COM
object based on the component object model, a Microsoft binary standard for object interoperability.
COM components use a common integration architecture that provides a consistent model across
multiple applications, including Microsoft Office applications.

To integrate the COM component with your application, you access the COM object from Microsoft
Excel through Microsoft Visual Basic® for Applications (VBA). The COM object exposes a single class
to the Visual Basic programming environment. This class provides the interface to the MATLAB
functions in the form of methods, which correspond to the original MATLAB functions that you
include in your project. The VBA module contains simple call wrappers, each implemented as a
function procedure for each method of the class.

See Also

Related Examples
• “Write Deployable MATLAB Code”
• “How Does MATLAB Deploy Functions?”
• “Distribute Add-Ins and Integrate into Microsoft Excel” on page 2-11
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Excel Target Requirements and Limitations for MATLAB
Compiler

In this section...
“Compiler Prerequisites” on page 2-3
“Macro Execution Security Levels in Microsoft Excel” on page 2-3
“MATLAB Compiler Excel Add-In Limitations” on page 2-3
“Work with Struct Arrays” on page 2-4
“Deployment Target Architectures and Compatibility” on page 2-4

Compiler Prerequisites
To generate Microsoft Excel add-ins using MATLAB, you must have the following installed on a
Windows® system:

• MATLAB
• MATLAB Compiler
• A supported C or C++ compiler
• Microsoft Excel, to generate the Visual Basic code

For instructions on deploying Microsoft Excel add-ins, see “Distribute Add-Ins and Integrate into
Microsoft Excel” on page 2-11.

Macro Execution Security Levels in Microsoft Excel
To generate add-ins and create macros with MATLAB Compiler, you must adjust the security settings
accordingly in Microsoft Excel. Failure to do so may result in VBA code not being generated or
warning messages sent to MATLAB Compiler.

For Microsoft Excel 2010 or newer:

1 Click File > Options > Trust Center > Trust Center Settings > Macro Settings.
2 In Developer Macro Settings, select Trust access to the VBA project object model.

MATLAB Compiler Excel Add-In Limitations
MATLAB Compiler supports the following function outputs for Excel add-ins:

• No outputs
• Figure (graphical) output
• Scalar output
• Multidimensional matrix output
• Structure array output

It does not support MATLAB objects as inputs or outputs for compiled or deployed functions with
Excel add-ins.
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Dependencies on MATLAB objects or functions that are not compatible with MATLAB Compiler can
prevent your code from compiling. For a list of functions that cannot be compiled, see “Functions Not
Supported for Compilation by MATLAB Compiler and MATLAB Compiler SDK”. For detailed
information about how MATLAB Compiler evaluates MATLAB code dependencies during compilation,
see “Dependency Analysis Using MATLAB Compiler”. For information on ensuring your code is
deployable, see “Write Deployable MATLAB Code”.

Work with Struct Arrays
To deploy a MATLAB function with structure arrays as input arguments, build Microsoft Excel macros
and pass them (with the Excel add-in) to the end users. For more details on using struct array
arguments in the Function Wizard, see “Define Input Arguments” on page 4-3.

If you do not create a macro, let your end users know which arguments correspond to the struct
arrays and the field names of the struct arrays.

Deployment Target Architectures and Compatibility
Applications developed on one architecture must be compatible with the architecture on the system
where they are deployed. For example, if you have a 64-bit system, you usually install a 64-bit version
of MATLAB (and most other applications) by default.

Add-ins created with MATLAB Compiler are compatible with both 32–bit and 64–bit versions of
Microsoft Excel. MATLAB Compiler itself is in 64–bit only.

See Also

Related Examples
• “Create Excel Add-In from MATLAB” on page 2-5
• “Write Deployable MATLAB Code”
• “How Excel Add-In Compilation Works” on page 2-2
• “Deployment Product Terms” on page B-8
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Create Excel Add-In from MATLAB
Supported Platform: Microsoft Windows only.

This example shows how to use MATLAB Compiler to generate a Microsoft Excel add-in containing a
custom function for use within Excel. The function mymagic returns an n-by-n magic square matrix
that has equal row and column sums. The target system does not require a licensed copy of MATLAB
to run the add-in.

Before you begin, verify that you have met all of the Excel target requirements for MATLAB Compiler.
For details, see “Excel Target Requirements and Limitations for MATLAB Compiler” on page 2-3.

Note To generate the Visual Basic files, enable Trust access to the VBA project object model in
Excel. If you do not do this, you can manually create the add-in by importing the .bas file into Excel.

Create Function in MATLAB
In MATLAB, locate the MATLAB code that you want to deploy as an Excel add-in.

For this example, compile the function mymagic.m located in matlabroot\toolbox\matlabxl
\examples\xlmagic.

function y = mymagic(x)
y = magic(x)

At the MATLAB command prompt, enter mymagic(5).

The output is a 5-by-5 square.

    17    24     1     8    15
    23     5     7    14    16
     4     6    13    20    22
    10    12    19    21     3
    11    18    25     2     9

Create Excel Add-In Using Library Compiler App
Package the function into an Excel add-in using the Library Compiler app. Alternatively, if you want
to create an Excel add-in from the MATLAB command window using a programmatic approach, see
“Create Excel Add-in Using compiler.build.excelAddIn” on page 2-8.

1 To open the Library Compiler app, type libraryCompiler at the MATLAB prompt.

Alternatively, on the MATLAB Apps tab, on the far right of the Apps section, click the arrow. In
Application Deployment, click Library Compiler.

2 In the MATLAB Compiler project window, select Excel Add-in in the TYPE section.
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3 In the Library Compiler app project window, specify the files of the MATLAB application that
you want to deploy.

a
In the Exported Functions section of the toolstrip, click .

b In the Add Files window, browse to the example folder, and select the function you want to
package. Click Open.

The function is added to the list of exported function files. Repeat this step to package multiple
files in the same application.

4 In the Packaging Options section of the toolstrip, decide whether to include the MATLAB
Runtime installer in the generated application by selecting one of the options:

• Runtime downloaded from web — Generate an installer that downloads the MATLAB
Runtime and installs it along with the deployed MATLAB application. You can specify the file
name of the installer.

• Runtime included in package — Generate an application that includes the MATLAB
Runtime installer. You can specify the file name of the installer.

Note The first time you select this option, you are prompted to download the MATLAB
Runtime installer.

5 Next, define the name of your add-in and verify the class mapping for the .m file that you are
building into your application.

a The Library Name field is automatically populated with mymagic as the name of the
assembly. Rename it as xlmagic. The same name is followed through in the implementation
of the add-in.

b Verify that the function defined in mymagic.m is mapped into xlmagicclass. Double-click
on the class to change the class name.

6 Customize the packaged application and its appearance:
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• Library information — Editable information about the deployed application. The generated
installer uses this information to populate the installed application metadata. See “Customize
the Installer”.

• Additional installer options — Edit the default installation path for the generated installer
and selecting custom logo. See “Change the Installation Path” .

• Files required for your library to run — Additional files required by the generated
application to run. These files are included in the generated application installer. See
“Manage Required Files in Compiler Project”.

• Files installed for your end user — Files that are installed with your application.

See “Specify Files to Install with Application”.
• Additional runtime settings — Platform-specific options for controlling the generated

executable. See “Additional Runtime Settings”.
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Package the Application
When you are finished selecting your packaging options, save your Library Compiler project and
generate the packaged application.

1 Click Package.

In the Save Project dialog box, specify the location to save the project.
2 In the Package dialog box, verify that Open output folder when process completes is

selected.

When the packaging process is complete, examine the generated output in the target folder.

• Three folders are generated: for_redistribution, for_redistribution_files_only,
and for_testing.

For more information about the files generated in these folders, see “Files Generated After
Packaging MATLAB Functions”.

• The log file PackagingLog.html contains packaging results.

Create Excel Add-in Using compiler.build.excelAddIn
As an alternative to the Library Compiler app, you can create an Excel add-in using a programmatic
approach. If you have already created an add-in using the Library Compiler, see “Install Add-In in
Excel” on page 2-9.

1 In MATLAB, locate the MATLAB code that you want to deploy as a standalone application. For
this example, compile using the file mymagic.m located in matlabroot\toolbox\matlabxl
\examples\xlmagic.
appFile = fullfile(matlabroot,'toolbox','matlabxl','examples','xlmagic','mymagic.m');

2 Build the Excel add-in using the compiler.build.excelAddIn function. Use name-value
arguments to set the library and class names, and enable the generation of Visual Basic files.
buildResults = compiler.build.excelAddIn(appFile, ...
'AddInName','xlmagic', ...
'ClassName','xlmagicclass', ...
'GenerateVisualBasicFile','on');

You can specify additional options in the compiler.build command by using name-value
arguments. For details, see compiler.build.excelAddIn.

The compiler.build.Results object buildResults contains information on the build type,
generated files, included support packages, and build options.

The function generates the following files within a folder named mymagicexcelAddIn in your
current working directory:

• dlldata.c
• GettingStarted.html
• includedSupportPackages.txt
• xlmagic.def
• xlmagic.bas
• xlmagic.rc
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• xlmagic.xla
• xlmagic_1_0.dll
• xlmagic_dll.cpp
• xlmagic_idl.h
• xlmagic_idl.idl
• xlmagic_idl.tlb
• xlmagic_idl_i.c
• xlmagic_idl_p.c
• xlmagicClass_com.cpp
• xlmagicClass_com.hpp
• mccExcludedFiles.log
• mwcomtypes.h
• mwcomtypes_i.c
• mwcomtypes_p.c
• readme.txt
• requiredMCRProducts.txt
• unresolvedSymbols.txt

Note The generated add-in does not include MATLAB Runtime or an installer. To create an
installer using the buildResults object, see compiler.package.installer.

Install Add-In in Excel
1 Open Microsoft Excel.
2 Click the File tab, click Options, and then click the Add-Ins category.
3 In the Manage box, click Excel Add-ins, and then click Go. The Add-Ins dialog box appears.
4 Click Browse and locate the add-in xlmagic.xla.
5 You are prompted to copy xlmagic.xla to the Addins folder associated with your user name.

You can choose to copy the add-in or run it directly. For this example, select, YES. The add-in is
copied and added to your workbook.

6 Click OK to close the Add-Ins dialog box

Test Add-In
1 Select a grid of 3-by-3 cells in the Excel workbook.
2 Enter the following custom function in the formula bar:

=mymagic(3)

As you type my in the formula bar, mymagic appears as a custom function in Excel.
3 Press Ctrl+Shift+Enter on the keyboard.

The selected cells display the following output:

8    1    6
3    5    7
4    9    2
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4 For additional examples, open the file xlmagic.xls located in matlabroot\toolbox
\matlabxl\examples\xlmagic. This spreadsheet contains three custom VBA macros that
demonstrate various ways of using the compiled MATLAB function.

Distribute Add-In
To distribute your add-in to end users, see “Distribute Add-Ins and Integrate into Microsoft Excel” on
page 2-11.

See Also
libraryCompiler | compiler.build.excelAddIn

More About
• “Distribute Add-Ins and Integrate into Microsoft Excel” on page 2-11
• “How Excel Add-In Compilation Works” on page 2-2
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Distribute Add-Ins and Integrate into Microsoft Excel

In this section...
“Files for Excel Add-In Deployment” on page 2-11
“Install MATLAB Runtime” on page 2-11
“Register Add-Ins and COM Components” on page 2-12
“Register MATLAB Utility Libraries” on page 2-12
“Install Excel Add-Ins” on page 2-13
“Use MATLAB Functions in Excel Spreadsheet” on page 2-13

To create a Microsoft Excel add-in, see “Create Excel Add-In from MATLAB” on page 2-5.

After you have created your Excel add-in, follow these steps to deploy the add-in on another machine.

1 Verify that you have received all the files necessary for deployment.
2 Install MATLAB Runtime.
3 Register your add-in DLL using the generated installer, the _install.bat installation script, or

mwregsvr.
4 Register the utility libraries mwcomutil.dll and mwcommgr.dll using mwregsvr.
5 Install the add-in in Excel.
6 Call the add-in functions directly in your worksheet.
7 (Optional) Create macros using the Function Wizard or custom VBA code.

Files for Excel Add-In Deployment
If you create your Excel add-in using the Library Compiler or create an installer using
compiler.package.installer, distribute the generated installer to your end user. The installer
installs the Excel add-in and MATLAB Runtime and registers the add-in DLL on the target machine.
The Library Compiler also generates an installation script named _install.bat that registers the
add-in DLL. To register the DLL without using the installer or script, see “Register Add-Ins and COM
Components” on page 2-12 below.

If you do not create an installer, distribute the files that the Library Compiler generates in the
for_redistribution_files_only folder. For a list of files generated in each folder, see “Files
Generated After Packaging MATLAB Functions”.

Install MATLAB Runtime
MATLAB Runtime contains the libraries needed to use compiled MATLAB code on a target system
without a licensed copy of MATLAB. For instructions, see “Install and Configure MATLAB Runtime”.

The MATLAB Runtime installer for Windows automatically sets the system path and registers the
MATLAB Runtime DLLs required for Excel add-ins. To perform these steps manually, see “Run
Applications Using a Network Installation of MATLAB Runtime”.
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Register Add-Ins and COM Components
When you create your COM component, it is registered in either HKEY_LOCAL_MACHINE or
HKEY_CURRENT_USER, based on your log-in privileges.

If you find you need to change your run-time permissions due to security standards imposed by
Microsoft or your installation, you can do one of the following before deploying your COM component
or add-in:

• Log on as administrator before running your COM component or add-in
• Run the following mwregsvr command prior to running your COM component or add-in, as

follows:

mwregsvr [/u] [/s] [/useronly] project_name.dll 

where:

• /u allows any user to unregister a COM component or add-in for this server
• /s runs this command silently, generating no messages. This is helpful for use in silent

installations.
• /useronly allows only the currently logged-in user to run the COM component or add-in on

this server

Caution If your COM component is registered in the USER hive, it will not be visible to Windows
Vista™ or Windows 7 users running as administrator on systems with UAC (User Access
Control) enabled.

If you register a component to the USER hive under Windows 7 or Windows Vista, your COM
component may fail to load when running with elevated (administrator) privileges.

If this occurs, do the following to re-register the component to the LOCAL MACHINE hive:

1 Unregister the component with this command:

mwregsvr /u /useronly my_dll.dll
2 Reregister the component to the LOCAL MACHINE hive with this command:

mwregsvr my_dll.dll

Register MATLAB Utility Libraries
To handle data conversion, the VBA code that you generate with MATLAB Compiler references the
mwcomutil.dll and mwcommgr.dll utility libraries. To register these libraries:

1 Open a system command prompt
2 Navigate to matlabroot\bin\win64, where matlabroot represents the location of MATLAB

or MATLAB Runtime that corresponds to the MATLAB release that you used to compile the Excel
add-in.

3 Run the following commands:

mwregsvr mwcomutil.dll
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mwregsvr mwcommgr.dll

Install Excel Add-Ins
Install the add-in in Microsoft Excel by following the steps for your Excel version.

Excel 2010 or Newer

1 In Excel, click the File tab.
2 On the left navigation pane, select Options.
3 In the Excel Options dialog box, on the left navigation pane, select Add-ins.
4 In the Manage drop-down list, select Excel Add-ins, and click Go.
5 In the Add-ins dialog box, click Browse.
6 Browse to and select your add-in. Click OK.
7 In the Excel Add-ins dialog box, verify that the entry containing your add-in is selected. Click OK.

Excel 2007

1 Start Microsoft Excel.
2 Click the Office button

(

) and select Excel Options.
3 In the left pane of the Excel Options dialog box, click Add-ins.
4 In the right pane of the Excel Options dialog box, select Excel Add-ins from the Manage drop-

down list.
5 Click Go.
6 Click Browse.
7 Browse to and select your add-in. Click OK.
8 In the Excel Add-ins dialog box, verify that the entry containing your add-in is selected. Click OK.

Use MATLAB Functions in Excel Spreadsheet
After you have installed the add-in in Excel, invoke the add-in function directly with a method call in
the form of an Excel custom function.

Optionally, use an Excel macro to specify input and output cells, execute multiple functions at a time,
or handle multiple outputs. Create a macro using the Function Wizard add-in provided with MATLAB
Compiler. For additional functionality, create or modify macros using custom VBA code.

Call Method Directly in Spreadsheet

To run the MATLAB function in the Excel spreadsheet, invoke the function with a method call in the
target output cells. For example, if you deployed MATLAB code called mymagic.m or a figure called
mymagic.fig, invoke that code by entering the following function in a cell in the spreadsheet:

=mymagic()

If your function returns an array, select a range of cells to match the array size.
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Tip If the method call does not evaluate immediately, press Ctrl, Shift, and Enter simultaneously.

Create Excel Macros Using Function Wizard

The Function Wizard provides a control panel for creating macros using one or more compiled
MATLAB functions. Use the Function Wizard to control the placement of MATLAB input and output
data in Excel worksheets.

For more details, see “Install and Use Function Wizard” on page 4-2.

Create Excel Macros Using VBA

Use VBA code to create Excel macros with more functionality than the Function Wizard allows. You
can use variables, loops, forms, controls, and other programming techniques to create custom Excel
programs.

For an example on using VBA code to create a custom graphical Excel application, see “Implement
User Interface Using Visual Basic Form Controls” on page 6-11.

See Also

Related Examples
• “How Excel Add-In Compilation Works” on page 2-2
• “Integrate Components Using VBA” on page 6-2
• “Reference Utility Classes” on page 9-2
• “Errors and Solutions” on page B-2
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Customizing a Compiler Project

• “Customize an Application” on page 3-2
• “Manage Support Packages” on page 3-9

3



Customize an Application
You can customize an application in several ways: customize the installer, manage files in the project,
or add a custom installer path using the Application Compiler app or the Library Compiler app.

Customize the Installer
Change Application Icon

To change the default icon, click the graphic to the left of the Library name or Application name
field to preview the icon.

Click Select icon, and locate the graphic file to use as the application icon. Select the Use mask
option to fill any blank spaces around the icon with white or the Use border option to add a border
around the icon.

To return to the main window, click Save and Use.

Add Library or Application Information

You can provide further information about your application as follows:

• Library/Application Name: The name of the installed MATLAB artifacts. For example, if the name
is foo, the installed executable is foo.exe, and the Windows start menu entry is foo. The folder
created for the application is InstallRoot/foo.

The default value is the name of the first function listed in the Main File(s) field of the app.
• Version: The default value is 1.0.
• Author name: Name of the developer.
• Support email address: Email address to use for contact information.
• Company name: The full installation path for the installed MATLAB artifacts. For example, if the

company name is bar, the full installation path would be InstallRoot/bar/ApplicationName.
• Summary: Brief summary describing the application.
• Description: Detailed explanation about the application.

All information is optional and, unless otherwise stated, is only displayed on the first page of the
installer. On Windows systems, this information is also displayed in the Windows Add/Remove
Programs control panel.
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Change the Splash Screen

The installer splash screen displays after the installer has started. It is displayed along with a status
bar while the installer initializes.

You can change the default image by clicking the Select custom splash screen. When the file
explorer opens, locate and select a new image.

You can drag and drop a custom image onto the default splash screen.

Change the Installation Path

This table lists the default path the installer uses when installing the packaged binaries onto a target
system.

Windows C:\Program Files\companyName\appName
Mac OS X /Applications/companyName/appName
Linux® /usr/companyName/appName

You can change the default installation path by editing the Default installation folder field under
Additional installer options.
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A text field specifying the path appended to the root folder is your installation folder. You can pick the
root folder for the application installation folder. This table lists the optional custom root folders for
each platform:

Windows C:\Users\userName\AppData
Linux /usr/local

Change the Logo

The logo displays after the installer has started. It is displayed on the right side of the installer.

You change the default image in Additional Installer Options by clicking Select custom logo.
When the file explorer opens, locate and select a new image. You can drag and drop a custom image
onto the default logo.

Edit the Installation Notes

Installation notes are displayed once the installer has successfully installed the packaged files on the
target system. You can provide useful information concerning any additional setup that is required to
use the installed binaries and instructions for how to run the application.

Determine Data Type of Command-Line Input (For Packaging
Standalone Applications Only)
When an executable standalone application is run in the command prompt, the default input type is
char. You can keep this default, or choose to interpret all inputs as numeric MATLAB doubles.

To pass inputs to the standalone application as MATLAB character vectors, select Treat all inputs to
the app as MATLAB character vectors. In this case, you must include code to convert char to a
numeric MATLAB type in the MATLAB function to be deployed as a standalone application.

To pass inputs to the standalone application as numeric MATLAB variables, select Treat all inputs to
the app as numeric MATLAB doubles. option in the Application Compiler App. Thus, you do not
need to include code to convert char to a numeric MATLAB type. Non numeric inputs to the
application may result in an error.

Manage Required Files in Compiler Project
The compiler uses a dependency analysis function to automatically determine what additional
MATLAB files are required for the application to package and run. These files are automatically
packaged into the generated binary. The compiler does not generate any wrapper code that allows
direct access to the functions defined by the required files.
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If you are using one of the compiler apps, the required files discovered by the dependency analysis
function are listed in the Files required for your application to run or Files required for your
library to run field.

To add files, click the plus button in the field, and select the file from the file explorer. To remove files,
select the files, and press the Delete key.

Caution Removing files from the list of required files may cause your application to not package or
not to run properly when deployed.

Using mcc

If you are using mcc to package your MATLAB code, the compiler does not display a list of required
files before running. Instead, it packages all the required files that are discovered by the dependency
analysis function and adds them to the generated binary file.

You can add files to the list by passing one or more -a arguments to mcc. The -a arguments add the
specified files to the list of files to be added into the generated binary. For example, -a hello.m
adds the file hello.m to the list of required files and -a ./foo adds all the files in foo and its
subfolders to the list of required files.

Sample Driver File Creation
Sample driver files are used to implement the generated component into an application in the target
language.

The following target types support sample driver file creation in MATLAB Compiler SDK™:

• C++ shared library
• Java® package
• .NET assembly
• Python® package

The sample file creation feature in Library Compiler uses MATLAB code to generate sample files in
the target language. In the app, click Create New Sample to automatically generate a new MATLAB
script, or click Add Existing Sample to upload a MATLAB script that you have already written. After
you package your functions, a sample file in the target language is generated from your MATLAB
script and is saved in a folder named samples. Sample files are also included in the installer.
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To automatically generate a new MATLAB file, click Create New Sample. This opens up a MATLAB
file for you to edit. The sample file serves as a starting point, and you should edit it as necessary
based on the behavior of your exported functions.

The sample MATLAB files must follow these guidelines:

• The sample file must be a MATLAB script, not a function.
• The sample file code must use only exported functions. Any user-defined function called in the

script must be a top-level exported function.
• Each exported function must be in a separate sample file.
• Each call to the same exported function must be a separate sample file.
• The input parameters of the top-level function are analyzed during the process. An input

parameter cannot be a field in a struct.
• The output of the exported function must be an n-dimensional numeric, char, logical, struct, or cell

array.
• Data must be saved as a local variable and then passed to the exported function in the sample file

code.
• Sample file code should not require user interaction.
• The sample script is executed as part of the process of generating the target language sample

code. Any errors in execution (for instance, undefined variables) will prevent a sample from being
generated, although the build target will still be generated.

Additional considerations specific to the target language are as follows:

• C++ mwArray API — varargin and varargout are not supported.
• .NET — Type-safe API is not supported.
• Python — Cell arrays and char arrays must be of size 1xN and struct arrays must be scalar. There

are no restrictions on numeric or logical arrays, other than that they must be rectangular, as in
MATLAB.

To upload a MATLAB file that you have already written, click Add Existing Sample. The MATLAB
code should demonstrate how to execute the exported functions. The required MATLAB code can be
only a few lines:

input1 = [1 4 7; 2 5 8; 3 6 9];
input2 = [1 4 7; 2 5 8; 3 6 9];
addoutput = addmatrix(input1,input2);

This code must also follow all the same guidelines outlined for the Create New Sample option.

If you have already created a MATLAB sample file, you can include it in a compiler.build function
for the supported targets using the 'SampleGenerationFiles' option.

You can also choose not to include a sample file at all during the packaging step. If you create your
own code in the target language, you can later copy and paste it into the appropriate directory once
the MATLAB functions are packaged.

Specify Files to Install with Application
The compiler packages files to install along with the ones it generates. By default, the installer
includes a readme file with instructions on installing the MATLAB Runtime and configuring it.
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These files are listed in the Files installed for your end user section of the app.

To add files to the list, click , and select the file from the file explorer.

JAR files are added to the application class path as if you had called javaaddpath.

Caution Removing the binary targets from the list results in an installer that does not install the
intended functionality.

When installed on a target computer, the files listed in the Files installed for your end user are
saved in the application folder.

Additional Runtime Settings
Type of Packaged
Application

Description Additional Runtime Settings Options

Standalone
Applications

• Do not display the
Windows Command
Shell (console) for
execution — If you
select this option on a
Windows platform,
when you double-click
the application from
the file explorer, the
application window
opens without a
command prompt.

• Create log file —
Generate a MATLAB
log file for the
application. The
packaged application
can't create a log file if
installed in the C:
folder on Windows
because the
application does not
have write permission
in that folder.
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Type of Packaged
Application

Description Additional Runtime Settings Options

Excel Add-Ins • Register the
component for the
current user
(Recommended for
non-admin users) —
This option enables
registering the
component for the
current user account.
It is provided for users
without admin rights.

• Create log file —
Generate a MATLAB
log file for the
application. The
packaged application
can't create a log file if
installed in the C:
folder on Windows
because the
application does not
have write permission
in that folder.

See Also
applicationCompiler | libraryCompiler

More About
• “Create Standalone Application from MATLAB”
• “Create Excel Add-In from MATLAB” on page 2-5
• “Generate a C++ mwArray API Shared Library and Build a C++ Application” (MATLAB

Compiler SDK)
• “Generate a C++ MATLAB Data API Shared Library and Build a C++ Application” (MATLAB

Compiler SDK)
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Manage Support Packages
Using a Compiler App
Many MATLAB toolboxes use support packages to interact with hardware or to provide additional
processing capabilities. If your MATLAB code uses a toolbox with an installed support package, the
app displays a Suggested Support Packages section.

The list displays all installed support packages that your MATLAB code requires. The list is
determined using these criteria:

• the support package is installed
• your code has a direct dependency on the support package
• your code is dependent on the base product of the support package
• your code is dependent on at least one of the files listed as a dependency in the mcc.xml file of

the support package, and the base product of the support package is MATLAB

Deselect support packages that are not required by your application.

Some support packages require third-party drivers that the compiler cannot package. In this case,
the compiler adds the information to the installation notes. You can edit installation notes in the
Additional Installer Options section of the app. To remove the installation note text, deselect the
support package with the third-party dependency.

Caution Any text you enter beneath the generated text will be lost if you deselect the support
package.

Using the Command Line
Many MATLAB toolboxes use support packages to interact with hardware or to provide additional
processing capabilities. If your MATLAB code uses a toolbox with an installed support package, use
the-a flag with mcc command when packaging your MATLAB code to specify supporting files in the
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support package folder. For example, if your function uses the OS Generic Video Interface
support package, run the following command:

mcc -m -v test.m -a C:\MATLAB\SupportPackages\R2016b\toolbox\daq\supportpackages\daqaudio -a 'C:\MATLAB\SupportPackages\R2016b\resources\daqaudio'

Some support packages require third-party drivers that the compiler cannot package. In this case,
you are responsible for downloading and installing the required drivers.
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Install and Use Function Wizard
The Function Wizard add-in, available with MATLAB Compiler, provides a control panel that you use
in Microsoft Excel to create custom Excel macros using one or more MATLAB Compiler Excel add-ins.
The generated macro consists of Microsoft Visual Basic for Applications (VBA) code that you can
modify for additional customization. To use the wizard, you do not need knowledge of VBA
programming.

The Function Wizard enables you to create Excel macros that specify the placement and output of
data from compiled MATLAB functions to the worksheets. You pass Excel worksheet values to a
compiled MATLAB model, and then return model output to a cell or range of cells in the worksheet.
Use the Function Wizard to handle MATLAB functions that have structure array arguments or
multiple outputs.

For a complete example on creating an Excel macro using the Function Wizard, see “Create Macro
Using Multiple MATLAB Functions” on page 5-3.

Install Function Wizard
You install the Function Wizard in Excel the same way you install MATLAB Compiler generated add-
ins. For instructions, see “Install Excel Add-Ins” on page 2-13.

The add-in file for the Function Wizard is located at matlabroot\toolbox\matlabxl\matlabxl
\win64\FunctionWizard.xlam. For example, if you compiled your add-in using MATLAB R2022b,
install the file C:\Program Files\MATLAB\R2022b\toolbox\matlabxl\matlabxl
\win64\FunctionWizard.xlam. This file contains a macro that adds the Function Wizard add-in
button to the Home tab.

Start Function Wizard

Note Before you can use the Function Wizard add-in, you must first register the MATLAB utility
libraries. For details, see “Register MATLAB Utility Libraries” on page 2-12.

Click the Function Wizard add-in button on the Home tab to start the Function Wizard. When the
wizard has initialized, the control panel opens.

Function Wizard Control Panel

Note Closing the Function Wizard control panel does not remove any MATLAB functions or
arguments that you add in an Excel session, but closing Excel resets the Function Wizard.

Define Functions to Execute
Add the MATLAB function you want to execute with the Function Wizard.

1 In the control panel, click Add Function in the Setup Functions area. The MATLAB
Components dialog box opens.
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2 In the Available Components area, select the name of your component from the drop-down list.

Note If your component is not listed, make sure you have registered its DLL. For details, see
“Register Add-Ins and COM Components” on page 2-12.

3 From Functions for Class classname, select the function you want to execute.
4 Click Add Function. The Function Properties dialog box opens.

Tip The Function Syntax and Help area in the Function Properties dialog box displays the first
help text line in a MATLAB function. This description can be helpful for end users who are
unfamiliar with the MATLAB function.

Define Input Arguments

Note The Function Wizard does not currently support the MATLAB sparse or complex data types.

From the Function Properties dialog box, define input argument properties for your MATLAB
function.

1 On the Input tab, click Set Input Data. The Input Data for x dialog box opens, where x is the
name of the input variable.

2 Select the type of input argument.
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• Range refers to a range of cells in the worksheet. Click the text box or the cell select button
on the right, then choose the cells from your worksheet that contain input data.

To automatically recalculate the spreadsheet data each time it changes, select the Auto
recalculate on change option.

Caution Avoid selecting ranges using arrow keys. If you must use arrow keys to select
ranges, apply the necessary fix from the Microsoft site: https://mskb.pkisolutions.com/kb/
291110.

• Value refers to a value you specify in the text box. Enter a value to use as the input data and
select the data type in the dropdown list.

• If the argument refers to a structure array (struct), select This is a MATLAB structure
array argument and click OK. The Input Data for Structure Array Argument x dialog box
opens.

The Function Wizard supports one and two-dimensional structure arrays for both input and
output.

When you deploy a function with struct array arguments, let end users know which arguments
are structure arrays and list their field names.
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a In the Structure Array Organization area, select either Element by Element
Organization or Plane Organization. For more information, see “Ways to Organize
Data in Structure Arrays”.

b To add fields for each of your struct array arguments, click Add Field. The Field for
Structure Array Argument dialog box opens.

c In the Name field, define the name for the structure array field. The name you specify
must exactly match the field name of the structure array in your MATLAB function.

d In the Range field, specify the range of the field for the structure array.
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e Click OK to add the field.

Repeat these steps for each field in the structure array.
3 To specify how to format dates and handle empty cells for this input data, click Options in the

Input Data for x dialog box. The Input Conversion Options dialog box opens.

• From the Coerce Numeric to Type drop-down list, select a data type to control the
conversion of numeric data.

• From the Treat Missing Data As drop-down list, specify either Zero or NaN (Not a
Number).

4 Click OK to add the input argument.

Repeat the procedure for each input argument for your function.
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Define Output Arguments
In the Function Properties dialog box, define output argument properties for your MATLAB function.

1 On the Output tab, click Set Output Data. The Output Data for y dialog box appears, where y is
the name of the output variable.

Tip You can also specify MATLAB Compiler to automatically resize output data (Auto Resize),
transpose it (Transpose), or output it in date format (Output as date).

2 In the Range field, specify the type of output argument as either a range of cells or a MATLAB
structure array.

For details on using structure array arguments, see “Define Input Arguments” on page 4-3.
3 To enable Excel to dynamically select the number of output cells, select Auto Resize if it is not

already selected.
4 Click Done in the Output Data for y dialog box to add the output argument.

Repeat the procedure for each output argument for your MATLAB function.

Note When working with functions that have multiple outputs, define a separate output range for
each argument.

Test and Save Macro
Once you are finished adding arguments to your MATLAB function, click Done in the Function
Properties dialog box. Your function appears in the Active Functions list of the control panel in the
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Function Wizard. You can edit function arguments at any time by selecting your function in the list
and then clicking Edit/Set Data.

To test your macro, click Execute in the Execute Functions area. Cell ranges defined as output
arguments are automatically populated with your function output on the current Excel sheet.

To save your macro:

1 In the Create Macros area of the control panel, enter a name for your macro in the Macro
Name field.

2 From the Store Macro In drop-down list, select the workbook to store the macro.
3 In the Description field, enter a brief description of the macro functionality.
4 Click Create Macro.

A macro is created and saved in the target Excel workbook.

Execute Macro in Excel
Run the macro in Microsoft Excel.

Tip You may need to enable the proper security settings before running macros in Microsoft Excel.
For information about macro permissions and related error messages, see “Errors and Solutions” on
page B-2.

1 In Microsoft Excel, click View > Macros > View Macros.
2 Select the macro from the Macro name drop-down list.
3 Click Run. Cell ranges defined as output arguments are automatically populated with your

function output.

Access Microsoft Visual Basic Code (Optional)
To access or modify the Visual Basic code in your macro:

1 From the Excel Developer tab, click Visual Basic, or press ALT+F11 to open the Visual Basic
Editor. In older versions of Excel, it may be located under Tools > Macro > Visual Basic
Editor .

2 In the Project - VBAProject window, double-click to expand VBAProject (Book1).
3 Expand the Modules folder and double-click the Matlab Macros module.

The Visual Basic Code window opens with the code for this project.

Map Macro to Button (Optional)
To create a form control button that runs the macro when you click the button:

1 From the Excel Developer tab, click Insert.
2 From the Form Controls menu, select the Button (Form Control) icon.
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Tip To see the various control labels, point your mouse over the Form Controls menu.
3 In the Assign Macros dialog box, select the macro you want to assign the button to and click OK.

See Also

Related Examples
• “Create Macro Using Multiple MATLAB Functions” on page 5-3
• “Create Macros with Graphical Functions” on page 5-7
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Microsoft Excel Add-In Creation,
Function Execution, and Deployment
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The Library Compiler and the Command Line Interface
In this section...
“Using Graphical Interface” on page 5-2
“Using Command Line Interface” on page 5-2

Using Graphical Interface
For a complete example of how to create an Excel add-in using the Library Compiler app, see “Create
Excel Add-In from MATLAB” on page 2-5.

Using Command Line Interface
As an alternative to using the Library Compiler, you can use the command line to create your
deployable executable. Use compiler.build.excelAddIn or the mcc function.
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Create Macro Using Multiple MATLAB Functions
This example shows you how to create macros with functions that have variable-length inputs and
outputs.

Before you begin, verify that you have met all of the MATLAB Compiler Excel target requirements.
For details, see “Excel Target Requirements and Limitations for MATLAB Compiler” on page 2-3.

Create Add-In In MATLAB
1 Copy the xlmulti example folder that ships with MATLAB to your work folder:

copyfile(fullfile(matlabroot,'toolbox','matlabxl','examples','xlmulti'),'xlmulti')

At the MATLAB command prompt, navigate to the xlmulti folder in your work folder.
2 Examine the myplot, myprimes, and mysum functions.

myplot takes a single integer input and plots a line from 1 to that number.
function myplot(x)
plot(1:x)

myprimes takes a single integer input n and returns all the prime numbers less than or equal to
n.
function p = primes(n)
if length(n)~=1, error('N must be a scalar'); end
if n < 2, p = zeros(1,0); return, end
p = 1:2:n;
q = length(p);
p(1) = 2;
for k = 3:2:sqrt(n)
  if p((k+1)/2)
     p(((k*k+1)/2):k:q) = 0;
  end
end
p = p(p>0);

mysum takes an input of varargin of type integer, adds all the numbers, and returns the
result.
function y = mysum(varargin)
y = sum([varargin{:}])

3 Build the Excel add-in with the Library Compiler app or compiler.build.excelAddIn using
the following information:

Field Value
Library Name xlmulti
Class Name xlmulticlass
Files to compile myplot.m

myprimes.m
mysum.m

For example, if you are using compiler.build.excelAddIn, type:
buildResults = compiler.build.excelAddIn(["myplot.m","myprimes.m","mysum.m"], ...
    'AddInName','xlmulti', ...
    'ClassName','xlmulticlass', ...
    'GenerateVisualBasicFile','on');

For more details, see the instructions in “Create Excel Add-In from MATLAB” on page 2-5.

 Create Macro Using Multiple MATLAB Functions

5-3



Create Excel Macro Using Function Wizard
Start Microsoft Excel on your system and create a new spreadsheet.

If you have not already done so, install and launch the Function Wizard add-in provided with MATLAB
Compiler. For instructions, see “Install Function Wizard” on page 4-2.

Add myplot Function

1 On the Function Wizard Control Panel, click Add Function in the Setup Functions area. The
MATLAB Components dialog box opens.

2 In the Available Components area of the MATLAB Components dialog box, select xlmulti 1.0
from the drop-down box.

3 Select the function myplot from the box labeled Functions for Class xlmulticlass.
4 Click Add. The Function Properties dialog box opens.
5 On the Input tab, click Set Input Data. The Input Data for x dialog box opens.
6 Select Value and enter the value 4. Click OK.
7 Click Done. If you execute the macro at this point, the function myplot plots a line from 1

through 4 in a MATLAB Figure window. This graphic can be manipulated similarly to the way one
would manipulate a figure in MATLAB. Some functionality, such as the ability to change line style
or color, is not available.

Add mysum Function

1 Enter 1 into cell A1.
2 Select the cells B1:J1. Enter the formula = A1 + 1, then press CTRL+Enter to apply the

formula to the selected cells.

This procedure fills the range B1:J1 with the interval 1–10 incremented by 1.
3 On the Function Wizard Control Panel, click Add Function and add the function mysum from

the xlmulti 1.0 component.
4 On the Inputs tab, click Add and then Set Input Data. The Input Data for varargin[1] dialog

box opens.
5 Click the button at the end of the Range field and select the cell range A1:J1 in your worksheet.

The range Sheet1!$A$1:$J$1 is entered in the text box.
6 Select Auto recalculate on change to allow Excel to dynamically update the sum if the input

cells change.
7 Click OK. The input argument varargin[1] = Sheet1!$A$1:$J$1 is added to the Select

Input Ranges/Values area.

Optionally, you can add additional cell ranges or values as input arguments. Cell ranges do not
need to be the same size, and selected cells do not require a value.

8 On the Outputs tab, click Set Output Data and select cell A2 in the range field.
9 Click Done. The function mysum is added to the Active Functions list with the specified input and

output arguments.
10 Once the macro runs, the cell A2 displays the sum 55. Changing any cells in the input range

automatically updates the output cell.

Add myprimes Function

1 Enter 10 into cell A4.
2 On the Function Wizard Control Panel, click Add Function and add the function myprimes from

the xlmulti 1.0 component.
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3 On the Inputs tab, click Set Input Data and select the cell A4 in the range field.
4 Select Auto recalculate on change to allow Excel to dynamically update when the input cell

changes.
5 Click OK. The input argument n = Sheet1!$A$4 is added to the Select Input Ranges/Values

area.
6 On the Outputs tab, click Set Output Data and select cell B4 in the range field.

Ensure Auto Resize is checked to enable the output to fill neighboring cells.
7 Click Done. The function myprimes is added to the Active Functions list.
8 Once the macro runs, the cells in row 4 display all prime numbers less than the value in A4.

Changing this cell automatically updates the output.

Create and Run Macro

1 In the Create Macros area, enter a name for your macro in the Macro Name field.
2 Choose where to store your macro by using the dropdown menu in the Store Macro In field.
3 (Optional) Add a description for your macro.
4 Click Create Macro to save your macro in the selected workbook.

The Function Wizard generates VBA code that call your functions with the specified arguments.
5 To execute the macro, from the main Excel window, open the Macro dialog box by pressing Alt +

F8, or by selecting Macros in the Developer tab.

(Optional) Inspect Microsoft Visual Basic Code
1 From the Developer tab, click Visual Basic, or press ALT+F11 to open the Visual Basic

Editor. In older versions of Excel, it may be located under Tools > Macro > Visual Basic
Editor .

2 In the Project - VBAProject window, double-click to expand VBAProject (Book1).
3 Expand the Modules folder and double-click the matlabMacros module. This opens the VB

Code window with the code for this project. You can use this code to develop your own custom
VBA macros.

For Additional Examples
The Microsoft Excel spreadsheet xlmulti.xls located in matlabroot\toolbox\matlabxl
\examples\xlmulti demonstrates these functions in several ways.
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In this example, the myplot and mysum functions are called directly in the worksheet using the
custom function syntax. The macro myprimes executes the myprimes function and dynamically
resizes the output.

See Also
libraryCompiler | compiler.build.excelAddIn | deploytool

Related Examples
• “Create Excel Add-In from MATLAB” on page 2-5
• “Install and Use Function Wizard” on page 4-2
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Create Macros with Graphical Functions
The “Create Macro that Displays Graphical Output” on page 5-7 example shows you how to create
an add-in and macro using a function that displays graphical output. For an example that uses a
MATLAB function that displays a dialog box, see “Create Macro that Displays Error Message” on
page 5-8.

Create Macro that Displays Graphical Output
Create an add-in and macro using a function that displays graphical output.

Create Add-In Using Function with Graphical Output

Build your COM component and add-in with MATLAB Compiler.

1 Create a MATLAB function with a graphical output. For this example, create a function named
mysurf.m.

function mysurf
surf(peaks);

2 Build the Excel add-in using the mysurf function with the Library Compiler app or
compiler.build.excelAddIn.

For example, if you are using compiler.build.excelAddIn, type:
buildResults = compiler.build.excelAddIn('mysurf.m', ...
'GenerateVisualBasicFile','on');

For more details, see the instructions in “Create Excel Add-In from MATLAB” on page 2-5.

Create Graphical Macro Using Function Wizard

Note For complete Function Wizard workflows, see “Install and Use Function Wizard” on page 4-2.

Create a macro that executes a graphical function on a Microsoft Excel spreadsheet using the
Function Wizard.

1 Install and start the Function Wizard in Microsoft Excel. For details, see “Install Function
Wizard” on page 4-2.

2 Click Add. Select the function mysurf in the Functions for Class mysurfClass box.
3 Click Add. The Function Properties dialog box appears.
4 Click Done. Since mysurf.m does not have any inputs or outputs, there is no need to specify

Properties.

The Function Wizard Control Panel appears with mysurf selected in the list of Active
Functions.

5 In the Execute Functions area of the Function Wizard Control Panel, click Execute. The
graphical output for mysurf appears in a separate window.
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6 Try interacting with the generated figure. For example, try dragging the figure window or
inserting color bars and legends using the toolbar.

Save and Execute Macro

Once you are satisfied that your macro is usable, save the macro to execute it at your convenience.

1 In the Function Wizard Control Panel, label the macro by entering mysurf in the Macro Name
field of the Create Macros area.

2 If desired, change the default value in the Store Macro In field.
3 Click Create Macro.
4 For details on executing macros, see “Execute Macro in Excel” on page 4-8. When the macro

runs, you should see output similar to the surf peaks image above.

Create Macro that Displays Error Message
Create an add-in and macro using a function that displays an error message dialog box.

Create Add-In Using Function with Dialog Box

Build your COM component and add-in with MATLAB Compiler.

1 Create a MATLAB function that displays a dialog box. For this example, create a function named
myerror.m.

function out = myerror(in)
if (in < 0)
    error('Negative input not expected');
else
    out = sqrt(in);
end

2 Build the Excel add-in using the myerror function with the Library Compiler app or
compiler.build.excelAddIn.

For example, if you are using compiler.build.excelAddIn, type:
buildResults = compiler.build.excelAddIn('myerror.m', ...
'GenerateVisualBasicFile','on');

For more details, see the instructions in “Create Excel Add-In from MATLAB” on page 2-5.
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Create Macro Using Function Wizard

Set arguments for the function using the Function Wizard.

1 Install and start the Function Wizard in Microsoft Excel. For details, see “Install Function
Wizard” on page 4-2.

2 Click Add. Select the function myerror in the Functions for Class myerrorClass box.
3 Click Add. The Function Properties dialog box appears.
4 Add an argument with an input value of -1 to myerror.

a On the Inputs tab, click Set Input Data. The Input Data for in dialog box appears.
b Select Value and enter -1.
c Click Done.

5 Define the output of myerror — in this case, choose any empty spreadsheet cell.

a Navigate to the Outputs tab and click Set Output Data. The Output Data for out dialog
box appears.

b Select Range and select a spreadsheet cell value, C1, for example. The range field is
automatically populated with Sheet1!$C$1.

c Click Done. The Function Wizard Control Panel appears with myerror selected in the list of
Active Functions.

Tip If you have functions besides myerror listed in the Active Functions list that you don't
want to execute when you test myerror, deactivate these functions by selecting them and
clicking Deactivate.

6 Click Execute. The following dialog box is displayed.

Save and Execute Macro

Create a macro to display your error message on demand.

1 In the Function Wizard Control Panel, label the macro by entering myerror in the Macro Name
field of the Create Macros area.

2 If desired, change the default value in the Store Macro In field.
3 Click Create Macro.
4 For details on executing macros, see “Execute Macro in Excel” on page 4-8.
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Integrate Components Using VBA
In this section...
“When to Use Formula Functions or Subroutines” on page 6-2
“Initialize MATLAB Compiler Libraries with Microsoft Excel” on page 6-2
“Create an Instance of a Class” on page 6-3
“Call the Methods of a Class Instance” on page 6-4
“Program with Variable Arguments” on page 6-6
“Modify Flags” on page 6-7
“Handle Errors During a Method Call” on page 6-10

When to Use Formula Functions or Subroutines
VBA provides two basic procedure types: functions and subroutines.

You access a VBA function directly from a cell in a worksheet as a formula function. Use function
procedures when the original MATLAB function returns one or no outputs.

You access a subroutine as a general macro. Use a subroutine procedure when the original MATLAB
function returns an array of values or multiple outputs, because you need to map these outputs into
multiple cells/ranges in the worksheet.

When you create a component, MATLAB Compiler produces a VBA module (.bas file). This file
contains simple call wrappers, each implemented as a function procedure for each method of the
class. For more information, see “How Excel Add-In Compilation Works” on page 2-2.

Initialize MATLAB Compiler Libraries with Microsoft Excel
Before you use any MATLAB Compiler component, initialize the supporting libraries with the current
instance of Microsoft Excel. Do this once for an Excel session that uses the MATLAB Compiler
components.

To do this initialization, call the utility library function MWInitApplication, which is a member of
the MWUtil class. This class is part of the MWComUtil library. For details, see “Class MWUtil” on
page 9-3.

One way to add this initialization code into a VBA module is to provide a subroutine that does the
initialization once, and simply exits for all subsequent calls. The following Microsoft Visual Basic code
sample initializes the libraries with the current instance of Excel. A global variable of type Object
named MCLUtil holds an instance of the MWUtil class, and another global variable of type Boolean
named bModuleInitialized stores the status of the initialization process. The private subroutine
InitModule() creates an instance of the MWComUtil class and calls the MWInitApplication
method with an argument of Application. Once this function succeeds, all subsequent calls exit
without reinitializing.

Dim MCLUtil As Object
Dim bModuleInitialized As Boolean

Private Sub InitModule()
   If Not bModuleInitialized Then
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      On Error GoTo Handle_Error
      If MCLUtil Is Nothing Then
         Set MCLUtil = CreateObject("MWComUtil.MWUtil")
      End If
      Call MCLUtil.MWInitApplication(Application)
      bModuleInitialized = True
      Exit Sub
Handle_Error:
      bModuleInitialized = False
   End If
End Sub

This code is similar to the default initialization code generated in the VBA module created when the
component is built. Each function that uses MATLAB Compiler components can include a call to
InitModule at the beginning to ensure that the initialization always gets performed as needed.

Create an Instance of a Class
Before calling a class method (compiled MATLAB function), you must create an instance of the class
that contains the method. VBA provides two techniques for doing this:

• CreateObject on page 6-3 function
• New on page 6-3 operator

CreateObject Function

This method uses the Microsoft Visual Basic application programming interface (API) CreateObject
function to create an instance of the class. Microsoft refers to calling CreateObject as late binding
and using new as early binding.

To use this method, declare a variable of type Object using Dim to hold a reference to the class
instance and call CreateObject using the class programmatic identifier (ProgID) as an argument,
as shown in the next example:

Function foo(x1 As Variant, x2 As Variant) As Variant
       Dim aClass As Object
     
       On Error Goto Handle_Error
       Set aClass = CreateObject("mycomponent.myclass.1_0") 
       ' (call some methods on aClass)
       Exit Function
Handle_Error:
   foo = Err.Description
End Function 

New Operator

This method uses the Visual Basic New operator on a variable explicitly dimensioned as the class to be
created. Before using this method, you must reference the type library containing the class in the
current VBA project. Do this by selecting the Tools menu from the Visual Basic Editor, and then
selecting References to display the Available References list. From this list, select the necessary
type library.

The following example illustrates using the New operator to create a class instance. It assumes that
you have selected mycomponent 1.0 Type Library from the Available References list before
calling this function.

 Integrate Components Using VBA

6-3



Function foo(x1 As Variant, x2 As Variant) As Variant
   Dim aClass As mycomponent.myclass

   On Error Goto Handle_Error
   Set aClass = New mycomponent.myclass
   ' (call some methods on aClass)
   Exit Function
Handle_Error:
   foo = Err.Description
End Function 

In this example, the class instance can be dimensioned as simply myclass. The full declaration in the
form <component-name>.<class-name> guards against name collisions that can occur if other
libraries in the current project contain types named myclass.

Using both CreateObject and New produce a dimensioned class instance. The first method does not
require a reference to the type library in the VBA project; the second results in faster code execution.
The second method has the added advantage of enabling the Auto-List-Members and Auto-Quick-
Info capabilities of the Microsoft Visual Basic editor to work with your classes. The default function
wrappers created with each built component all use the first method for object creation.

In the previous two examples, the class instance used to make the method call was a local variable of
the procedure. This creates and destroys a new class instance for each call. An alternative approach
is to declare one single module-scoped class instance that is reused by all function calls, as in the
initialization code of the previous example.

The following example illustrates this technique with the second method:

Dim aClass As mycomponent.myclass

Function foo(x1 As Variant, x2 As Variant) As Variant
   On Error Goto Handle_Error
   If aClass Is Nothing Then
      Set aClass = New mycomponent.myclass
   End If
   ' (call some methods on aClass)
   Exit Function
Handle_Error:
   foo = Err.Description
End Function

How MATLAB Runtime Is Shared Among Classes

MATLAB Compiler creates a single MATLAB Runtime instance when the first Microsoft COM class is
instantiated in an application. This MATLAB Runtime is reused and shared among all subsequent
class instances within the component, resulting in more efficient memory usage and eliminating the
MATLAB Runtime startup cost in each subsequent class instantiation.

All class instances share a single MATLAB workspace and share global variables in the MATLAB files
used to build the component. This makes properties of a COM class behave as static properties
instead of instance-wise properties.

Call the Methods of a Class Instance
After you have created a class instance, you can call the class methods to access the compiled
MATLAB functions. MATLAB Compiler applies a standard mapping from the original MATLAB
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function syntax to the method's argument list. For a detailed description of the mapping from
MATLAB functions to COM class method calls, see “Reference Utility Classes” on page 9-2.

When a method has output arguments, the first argument is always nargout, which is of type Long.
This input parameter passes the normal MATLAB nargout parameter to the compiled function and
specifies how many outputs are requested. Methods that do not have output arguments do not pass a
nargout argument. Following nargout are the output parameters listed in the same order as they
appear on the left side of the original MATLAB function. Next come the input parameters listed in the
same order as they appear on the right side of the original MATLAB function. All input and output
arguments are typed as Variant, the default Visual Basic data type.

The Variant type can hold any of the basic VBA types, arrays of any type, and object references. For
a detailed description of how to convert Variant types of any basic type to and from MATLAB data
types, see “Data Conversion Rules” on page A-2. In general, you can supply any Visual Basic type
as an argument to a class method, with the exception of Visual Basic UDTs. You can also pass
Microsoft Excel Range objects directly as input and output arguments.

When you pass a simple Variant type as an output parameter, the called method allocates the
received data and frees the original contents of the Variant. In this case it is sufficient to dimension
each output argument as a single Variant. When an object type (like an Excel Range) is passed as
an output parameter, the object reference is passed in both directions, and the object's Value
property receives the data.

The following examples illustrate the process of passing input and output parameters from VBA to the
MATLAB Compiler component class methods.

The first example is a formula function that takes two inputs and returns one output. This function
dispatches the call to a class method that corresponds to a MATLAB function of the form function
y = foo(x1,x2).

Function foo(x1 As Variant, x2 As Variant) As Variant
   Dim aClass As Object
   Dim y As Variant
   
   On Error Goto Handle_Error
   Set aClass = New mycomponent.myclass
   aClass = CreateObject("mycomponent.myclass.1_0")
   Call aClass.foo(1,y,x1,x2)
   foo = y
   Exit Function
Handle_Error:
   foo = Err.Description
End Function

The second example rewrites the same function as a subroutine and uses Excel ranges for input and
output.

Sub foo(Rout As Range, Rin1 As Range, Rin2 As Range)
   Dim aClass As Object

   On Error Goto Handle_Error
   aClass = CreateObject("mycomponent.myclass.1_0")
   Call aClass.foo(1,Rout,Rin1,Rin2)
   Exit Sub
Handle_Error:
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   MsgBox(Err.Description)
End Sub

Program with Variable Arguments
Process varargin and varargout Arguments

When varargin and/or varargout are present in the MATLAB function that you are using for the
Excel component, these parameters are added to the argument list of the class method as the last
input/output parameters in the list. You can pass multiple arguments as a varargin array by
creating a Variant array, assigning each element of the array to the respective input argument.

The following example creates a varargin array to call a method resulting from a MATLAB function
of the form y = foo(varargin):

Function foo(x1 As Variant, x2 As Variant, x3 As Variant, _ 
             x4 As Variant, x5 As Variant) As Variant 
   Dim aClass As Object 
   Dim v As Variant 
   Dim y As Variant 
   Dim MCLUtil As Object 
    
   On Error GoTo Handle_Error 
   set aClass = CreateObject("mycomponent.myclass.1_0") 
   Set MCLUtil = CreateObject("MWComUtil.MWUtil") 
   Call MCLUtil.MWPack(v, x1, x2, x3, x4, x5) 
   Call aClass.foo(1, y, v) 
   foo = y 
   Exit Function 
Handle_Error: 
   foo = Err.Description 
End Function 

The MWUtil class included in the MWComUtil utility library provides the MWPack helper function to
create varargin parameters. See “Class MWUtil” on page 9-3 for more details.

The next example processes a varargout parameter into three separate Excel Ranges. This function
uses the MWUnpack function in the utility library. The MATLAB function used is
varargout = foo(x1,x2).

Sub foo(Rout1 As Range, Rout2 As Range, Rout3 As Range, _
        Rin1 As Range, Rin2 As Range)
   Dim aClass As Object
   Dim aUtil As Object
   Dim v As Variant
    
   On Error Goto Handle_Error
   aUtil = CreateObject("MWComUtil.MWUtil")
   aClass = CreateObject("mycomponent.myclass.1_0")
   Call aClass.foo(3,v,Rin1,Rin2)
   Call aUtil.MWUnpack(v,0,True,Rout1,Rout2,Rout3)
   Exit Sub
Handle_Error:
   MsgBox(Err.Description)
End Sub
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Pass an Empty varargin from Microsoft Visual Basic Code

In MATLAB, varargin inputs to functions are optional, and may be present or omitted from the
function call. However, from Microsoft Visual Basic, function signatures are more strict—if varargin
is present among the MATLAB function inputs, the VBA call must include varargin, even if you want
it to be empty. To pass in an empty varargin, pass the Null variant, which is converted to an empty
MATLAB cell array when passed.

Pass an Empty varargin from VBA Code

The following example illustrates how to pass the null variant in order to pass an empty varargin:

Function foo(x1 As Variant, x2 As Variant, x3 As Variant, _ 
             x4 As Variant, x5 As Variant) As Variant 
   Dim aClass As Object 
   Dim v(1 To 5) As Variant 
   Dim y As Variant 
    
   On Error Goto Handle_Error 
   v(1) = x1 
   v(2) = x2 
   v(3) = x3 
   v(4) = x4 
   v(5) = x5 
   aClass = CreateObject("mycomponent.myclass.1_0") 

   'Call aClass.foo(1,y,v) 
   Call aClass.foo(1,y,Null) 

   foo = y 
   Exit Function 
Handle_Error: 
   foo = Err.Description 
End Function

For More Information

For more information about working with variable-length arguments, see “Create Macro Using
Multiple MATLAB Functions” on page 5-3.

Modify Flags
Each MATLAB Compiler component exposes a single read/write property named MWFlags of type
MWFlags. The MWFlags property consists of two sets of constants: array formatting flags on page 6-
8and data conversion flags on page 6-9. Array formatting flags affect the transformation of
arrays, whereas data conversion flags deal with type conversions of individual array elements.

The data conversion flags change selected behaviors of the data conversion process from Variants
to MATLAB types and vice versa. By default, the MATLAB Compiler components allow setting data
conversion flags at the class level through the MWFlags class property. This holds true for all Visual
Basic types, with the exception of the MATLAB Compiler MWStruct, MWField, MWComplex,
MWSparse, and MWArg types. Each of these types exposes its own MWFlags property and ignores the
properties of the class whose method is being called. The MWArg class is supplied specifically for the
case when a particular argument needs different settings from the default class properties.
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This section provides a general discussion of how to set these flags and what they do. For a detailed
discussion of the MWFlags type, as well as additional code samples, see “Class MWFlags” (MATLAB
Compiler SDK).

Array Formatting Flags

Array formatting flags guide the data conversion to produce either a MATLAB cell array or matrix
from general Variant data on input or to produce an array of Variants or a single Variant
containing an array of a basic type on output.

The following examples assume that you have referenced the MWComUtil library in the current
project by selecting Tools > References and selecting MWComUtil 7.5 Type Library from the list:

Sub foo( )
   Dim aClass As mycomponent.myclass
   Dim var1(1 To 2, 1 To 2), var2 As Variant
   Dim x(1 To 2, 1 To 2) As Double
   Dim y1,y2 As Variant
   
   On Error Goto Handle_Error
   var1(1,1) = 11#
   var1(1,2) = 12#
   var1(2,1) = 21#
   var1(2,2) = 22#
   x(1,1) = 11
   x(1,2) = 12
   x(2,1) = 21
   x(2,2) = 22
   var2 = x
   Set aClass = New mycomponent.myclass
   Call aClass.foo(1,y1,var1)
   Call aClass.foo(1,y2,var2)
   Exit Sub
Handle_Error:
   MsgBox(Err.Description)
End Sub

In addition, these examples assume you have referenced the COM object (DLL file) created with
MATLAB Compiler (mycomponent) as mentioned in “New Operator” on page 6-3.

Here, two Variant variables, var1 and var2 are constructed with the same numerical data, but
internally they are structured differently: var1 is a 2-by-2 array of Variants with each element
containing a 1-by-1 Double, while var2 is a 1-by-1 Variant containing a 2-by-2 array of Doubles.

In MATLAB Compiler, when using the default settings, both of these arrays will be converted to 2-
by-2 arrays of doubles. This does not follow the general convention listed in COM VARIANT to the
MATLAB Conversion Rules. According to these rules, var1 converts to a 2-by-2 cell array with each
cell occupied by a 1-by-1 double, and var2 converts directly to a 2-by-2 double matrix.

The two arrays both convert to double matrices because the default value for the
InputArrayFormat flag is mwArrayFormatMatrix. The InputArrayFormat flag controls how
arrays of these two types are handled. This default is used because array data originating from Excel
ranges is always in the form of an array of Variants (like var1 of the previous example), and
MATLAB functions most often deal with matrix arguments.
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But what if you want a cell array? In this case, you set the InputArrayFormat flag to
mwArrayFormatCell. Do this by adding the following line after creating the class and before the
method call:

aClass.MWFlags.ArrayFormatFlags.InputArrayFormat = 
mwArrayFormatCell

Setting this flag presents all array input to the compiled MATLAB function as cell arrays.

Similarly, you can manipulate the format of output arguments using the OutputArrayFormat flag.
You can also modify array output with the AutoResizeOutput and TransposeOutput flags.

AutoResizeOutput is used for Excel Range objects passed directly as output parameters. When this
flag is set, the target range automatically resizes to fit the resulting array. If this flag is not set, the
target range must be at least as large as the output array or the data is truncated.

The TransposeOutput flag transposes all array output. This flag is useful when dealing with
MATLAB functions that output one-dimensional arrays. By default, MATLAB realizes one-dimensional
arrays as 1-by-n matrices (row vectors) that become rows in an Excel worksheet.

Tip If your MATLAB function is specifically returning a row vector, for example, ensure you assign a
similar row vector of cells in Excel.

You may prefer worksheet columns from row vector output. This example auto-resizes and transposes
an output range:

Sub foo(Rout As Range, Rin As Range )
   Dim aClass As mycomponent.myclass

   On Error Goto Handle_Error
   Set aClass = New mycomponent.myclass
   aClass.MWFlags.ArrayFormatFlags.AutoResizeOutput = True
   aClass.MWFlags.ArrayFormatFlags.TransposeOutput = True
   Call aClass.foo(1,Rout,Rin)
   Exit Sub
Handle_Error:
   MsgBox(Err.Description)
End Sub

Data Conversion Flags

Data conversion flags deal with type conversions of individual array elements. The two data
conversion flags, CoerceNumericToType and InputDateFormat, govern how numeric and date
types are converted from VBA to MATLAB. Consider the example:

Sub foo( )
   Dim aClass As mycomponent.myclass
   Dim var1, var2 As Variant
   Dim y As Variant
   
   On Error Goto Handle_Error
   var1 = 1
   var2 = 2#
   Set aClass = New mycomponent.myclass
   Call aClass.foo(1,y,var1,var2)
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   Exit Sub
Handle_Error:
   MsgBox(Err.Description)
End Sub

This example converts var1 of type Variant/Integer to an int16 and var2 of type Variant/
Double to a double.

If the original MATLAB function expects doubles for both arguments, this code might cause an error.
One solution is to assign a double to var1, but this may not be possible or desirable. In such a case
set the CoerceNumericToType flag to mwTypeDouble, causing the data converter to convert all
numeric input to double. In the previous example, place the following line after creating the class
and before calling the methods:

aClass.MWFlags.DataConversionFlags.CoerceNumericToType = 
mwTypeDouble

The InputDateFormat flag controls how the VBA Date type is converted. This example sends the
current date and time as an input argument and converts it to a string:

Sub foo( )
   Dim aClass As mycomponent.myclass
   Dim today As Date
   Dim y As Variant
   
   On Error Goto Handle_Error
   today = Now
   Set aClass = New mycomponent.myclass
   aClass. MWFlags.DataConversionFlags.InputDateFormat = 
mwDateFormatString
   Call aClass.foo(1,y,today)
   Exit Sub
Handle_Error:
   MsgBox(Err.Description)
End Sub

Handle Errors During a Method Call
Errors that occur while creating a class instance or during a class method create an exception in the
current procedure. Microsoft Visual Basic provides an exception handling capability through the On
Error Goto <label> statement, in which the program execution jumps to <label> when an error
occurs. (<label> must be located in the same procedure as the On Error Goto statement). All
errors are handled this way, including errors within the original MATLAB code. An exception creates
a Visual Basic ErrObject object in the current context in a variable called Err. (See the Visual Basic
for Applications documentation for a detailed discussion on VBA error handling.) All of the examples
in this section illustrate the typical error trapping logic used in function call wrappers for MATLAB
Compiler components.
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Implement User Interface Using Visual Basic Form Controls
Overview
This example illustrates the creation of a comprehensive Excel application to perform spectral
analysis. It requires knowledge of Visual Basic forms and controls, and Excel workbook events. See
the VBA documentation for a complete discussion of these topics.

You create an Excel add-in using functions that perform a fast Fourier transform (FFT) on an input
data set and plot the power spectral density. The function returns the FFT results, an array of
frequency points, and the power spectral density of the input data. You then create a custom VBA
macro with form controls to designate input and output ranges in the current worksheet. Invoke the
spectral analysis application from the Excel Tools menu.

To create the add-in:

1 Build an Excel add-in from MATLAB code.
2 Implement the necessary VBA code to collect input and dispatch the calls to your component.

This code also creates a menu item for the application in Excel.
3 Create the UI using form controls.
4 Save the finished Excel add-in and package all necessary components for application deployment.

Before creating Excel add-ins, verify that you have met all of the MATLAB Compiler Excel target
requirements. For details, see “Excel Target Requirements and Limitations for MATLAB Compiler” on
page 2-3.

Build Excel Add-In
1 Save the path to the xlspectral folder that ships with MATLAB.

copyfile(fullfile(matlabroot,'toolbox','matlabxl','examples','xlspectral'))
2 Examine the MATLAB functions computefft.m and plotfft.m.

computefft.m
function [fftdata, freq, powerspect] = computefft(data, interval)
    if (isempty(data))
        fftdata = [];
        freq = [];
        powerspect = [];
        return;
    end
    if (interval <= 0)
        error('Sampling interval must be greater then zero');
        return;
    end
    fftdata = fft(data);
    freq = (0:length(fftdata)-1)/(length(fftdata)*interval);
    powerspect = abs(fftdata)/(sqrt(length(fftdata)));

plotfft.m
function [fftdata, freq, powerspect] = plotfft(data, interval)
    [fftdata, freq, powerspect] = computefft(data, interval);
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    len = length(fftdata);
    if (len <= 0)
        return;
    end
    t = 0:interval:(len-1)*interval;
    subplot(2,1,1), plot(t, data)
    xlabel('Time'), grid on
    title('Time domain signal')
    subplot(2,1,2), plot(freq(1:len/2), powerspect(1:len/2))
    xlabel('Frequency (Hz)'), grid on
    title('Power spectral density')

3 Build the Excel add--in with the Library Compiler app or compiler.build.excelAddIn.

Use the following information for your project:

Project Name Fourier
Class Name Fourier
File to compile plotfft.m

Note In this example, the application that uses the fourier class does not call computefft
directly. The computefft method is required only by the plotfft method. Thus, you do not
need to manually add the computefft function to the package, as the compiler automatically
includes it during dependency analysis.

For example, if you are using compiler.build.excelAddIn, type:
buildResults = compiler.build.excelAddIn('plotfft.m', ...
'AddInName','Fourier', ...
'ClassName','Fourier', ...
'GenerateVisualBasicFile','on', ...
'Verbose','on');

Your component has one class with two methods:

• computefft — Computes the FFT and power spectral density of the input data, and
computes a vector of frequency points based on the length of the data entered and the
sampling interval.

• plotfft — Performs the same operations as computefft, and also plots the input data and
the power spectral density in a MATLAB figure window.

Implement VBA code
Having built your component, implement the necessary VBA code to integrate it into Excel.

Note The shipped Excel add-in Fourier.xla in the xlspectral folder already contains the
following VBA code. To use the shipped add-in, open it in Excel, add references to Fourier 1.0 Type
Library and MWComUtil X.X Type Library in the Excel Visual Basic Editor, and save the add-in.
You can then skip to “Test the Add-In” on page 6-18.

1 Start Excel.
2 Open your generated Excel add-in.
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3 From the Developer tab, click Visual Basic, or press ALT+F11 to open the Visual Basic
Editor. In older versions of Excel, it may be located under Tools > Macro > Visual Basic
Editor .

4 In the Visual Basic Editor, select Tools > References to open the Project References dialog box.
5 Select the Fourier 1.0 Type Library entry that corresponds to your generated Excel add-in and

MWComUtil X.X Type Library that corresponds to your version of MATLAB or MATLAB
Runtime. Click OK to add the references.

Create Main VB Code Module

The add-in requires initialization code and global variables to hold the application state between
function invocations. Implement a Visual Basic code module to manage these tasks.

1 If there is not already a module present under Modules, right-click the VBAProject item in the
project window and select Insert > Module.

A new module appears under Modules in the VBA Project.
2 In the module property page, change the Name property from Module1 to FourierMain. You

may need to show the property window by pressing F4.
3 Enter the following code in the FourierMain module and close the code window.

'
' FourierMain - Main module stores global state of controls
' and provides initialization code
'
Public theFourier As Fourier.Fourier 'Global instance of Fourier object
Public theFFTData As MWComplex   'Global instance of MWComplex to accept FFT
Public InputData As Range        'Input data range
Public Interval As Double        'Sampling interval
Public Frequency As Range        'Output frequency data range
Public PowerSpect As Range       'Output power spectral density range
Public bPlot As Boolean          'Holds the state of plot flag
Public theUtil As MWUtil         'Global instance of MWUtil object
Public bInitialized As Boolean   'Module-is-initialized flag

Private Sub LoadFourier()
'Initializes globals and Loads the Spectral Analysis form
    Dim MainForm As frmFourier
    On Error GoTo Handle_Error
    Call InitApp
    Set MainForm = New frmFourier
    Call MainForm.Show
    Exit Sub
Handle_Error:
    MsgBox (Err.Description)
End Sub

Private Sub InitApp()
'Initializes classes and libraries. Executes once
'for a given session of Excel
    If bInitialized Then Exit Sub
    On Error GoTo Handle_Error
    If theUtil Is Nothing Then
        Set theUtil = New MWUtil
        Call theUtil.MWInitApplication(Application)
    End If
    If theFourier Is Nothing Then
        Set theFourier = New Fourier.Fourier
    End If
    If theFFTData Is Nothing Then
        Set theFFTData = New MWComplex
    End If
    bInitialized = True
    Exit Sub
Handle_Error:
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    MsgBox (Err.Description)
End Sub

Create Visual Basic Form

Develop a user interface for your add-in using the Visual Basic Editor.

1 Right-click VBAProject in the VBA project window and select Insert and then UserForm.

A new form appears under Forms in the VBA project window.
2 In the form property page, set the Name property to frmFourier and the Caption property to

Spectral Analysis.
3 Add the following controls to the blank form:
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Controls for Spectral Analysis

Control Type Control Name Properties Purpose
CheckBox chkPlot Caption = Plot

time domain
signal and power
spectral density

Plot input data and
power spectral
density.

CommandButton btnOK Caption = OK

Default = True

Execute the function
and dismiss the dialog
box.

CommandButton btnCancel Caption = Cancel

Cancel = True

Dismiss the dialog
box without executing
the function.

Frame Frame1 Caption = Input
Data

Group all input
controls.

Frame Frame2 Caption = Output
Data

Group all output
controls.

Label Label1 Caption = Input
Data:

Label the RefEdit
for input data.

RefEdit refedtInput  Select range for input
data.

Label Label2 Caption = Sampling
Interval:

Label the TextBox
for sampling interval.

TextBox edtSample  Select sampling
interval.

Label Label3 Caption =
Frequency:

Label the RefEdit
for frequency output.

RefEdit refedtFreq  Select output range
for frequency points.

Label Label4 Caption = FFT -
Real Part:

Label the RefEdit
for real part of FFT.

RefEdit refedtReal  Select output range
for real part of FFT of
input data.

Label Label5 Caption = FFT -
Imaginary Part:

Label the RefEdit
for imaginary part of
FFT.

RefEdit refedtImag  Select output range
for imaginary part of
FFT of input data.

Label Label6 Caption = Power
Spectral Density

Label the RefEdit
for power spectral
density.
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Control Type Control Name Properties Purpose
RefEdit refedtPowSpect  Select output range

for power spectral
density of input data.

Your form should look similar to the following image. The text in the boxes is for your reference
only.

4 When the form and controls are complete, right-click the form and select View code.

Enter the following code in the form code window. If you used different names for any of the
controls or any global variable, change this code to reflect those differences.

'
'frmFourier Event handlers
'
Private Sub UserForm_Activate()
'UserForm Activate event handler. This function gets called before
'showing the form, and initializes all controls with values stored
'in global variables.
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    On Error GoTo Handle_Error
    If theFourier Is Nothing Or theFFTData Is Nothing Then Exit Sub
    'Initialize controls with current state
    If Not InputData Is Nothing Then
        refedtInput.Text = InputData.Address
    End If
    edtSample.Text = Format(Interval)
    If Not Frequency Is Nothing Then
        refedtFreq.Text = Frequency.Address
    End If
    If Not IsEmpty (theFFTData.Real) Then
    If IsObject(theFFTData.Real) And TypeOf theFFTData.Real Is Range Then
            refedtReal.Text = theFFTData.Real.Address
        End If
    End If
    If Not IsEmpty (theFFTData.Imag) Then
    If IsObject(theFFTData.Imag) And TypeOf theFFTData.Imag Is Range Then
            refedtImag.Text = theFFTData.Imag.Address
        End If
    End If
    If Not PowerSpect Is Nothing Then
        refedtPowSpect.Text = PowerSpect.Address
    End If
    chkPlot.Value = bPlot
    Exit Sub
Handle_Error:
    MsgBox (Err.Description)
End Sub

Private Sub btnCancel_Click()
'Cancel button click event handler. Exits form without computing fft
'or updating variables.
    Unload Me
End Sub
Private Sub btnOK_Click()
'OK button click event handler. Updates state of all variables from controls
'and executes the computefft or plotfft method.
    Dim R As Range
    
    If theFourier Is Nothing Or theFFTData Is Nothing Then GoTo Exit_Form
    On Error Resume Next
    'Process inputs
    Set R = Range(refedtInput.Text)
    If Err <> 0 Then
        MsgBox ("Invalid range entered for Input Data")
        Exit Sub
    End If
    Set InputData = R
    Interval = CDbl(edtSample.Text)
    If Err <> 0 Or Interval <= 0 Then
        MsgBox ("Sampling interval must be greater than zero")
        Exit Sub
    End If
    'Process Outputs
    Set R = Range(refedtFreq.Text)
    If Err = 0 Then
        Set Frequency = R
    End If
    Set R = Range(refedtReal.Text)
    If Err = 0 Then
        theFFTData.Real = R
    End If
    Set R = Range(refedtImag.Text)
    If Err = 0 Then
        theFFTData.Imag = R
    End If
    Set R = Range(refedtPowSpect.Text)
    If Err = 0 Then
        Set PowerSpect = R
    End If
    bPlot = chkPlot.Value
    'Compute the fft and optionally plot power spectral density
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    If bPlot Then
        Call theFourier.plotfft(3, theFFTData, Frequency, PowerSpect, _ 
     InputData, Interval)
    Else
        Call theFourier.computefft(3, theFFTData, Frequency, PowerSpect, _ 
     InputData, Interval)
    End If
    GoTo Exit_Form
Handle_Error:
    MsgBox (Err.Description)
Exit_Form:
    Unload Me
End Sub

Add Event Handlers to Workbook

1 Right-click the ThisWorkbook item in the VBA project window and select View code.
2 Place the following code into ThisWorkbook.

Private Sub Workbook_AddinInstall()
'Called when Addin is installed
    Call AddFourierMenuItem
End Sub

Private Sub Workbook_AddinUninstall()
'Called when Addin is uninstalled
    Call RemoveFourierMenuItem
End Sub

Private Sub AddFourierMenuItem()
    Dim ToolsMenu As CommandBarPopup
    Dim NewMenuItem As CommandBarButton
    
    'Remove if already exists
    Call RemoveFourierMenuItem
    'Find Tools menu
    Set ToolsMenu = Application.CommandBars(1).FindControl(ID:=30007)
    If ToolsMenu Is Nothing Then Exit Sub
    'Add Spectral Analysis menu item
    Set NewMenuItem = ToolsMenu.Controls.Add(Type:=msoControlButton)
    NewMenuItem.Caption = "Spectral Analysis..."
    NewMenuItem.OnAction = "LoadFourier"
End Sub

Private Sub RemoveFourierMenuItem() 
Dim CmdBar As CommandBar 
Dim Ctrl As CommandBarControl 
On Error Resume Next 
'Find tools menu and remove Spectral Analysis menu item 
Set CmdBar = Application.CommandBars(1) 
Set Ctrl = CmdBar.FindControl(ID:=30007) 
Call Ctrl.Controls("Spectral Analysis...").Delete 
End Sub

The code adds event handlers for the workbook events AddinInstall and AddinUninstall
that install and uninstall menu items. The menu item calls the LoadFourier function in the
FourierMain module.

3 When you are finished, click the save icon or press CTRL + S to save the add-in.

Test the Add-In
Before distributing the add-in, test it with a sample problem. Spectral analysis is commonly used to
find the frequency components of a signal buried in a noisy time domain signal. Create a data
representation of a signal containing two distinct components and add to it a random component.
This data, along with the output, is stored in columns of an Excel worksheet, and you plot the time-
domain signal along with the power spectral density.
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Create Test Problem

1 Start a new session of Excel with a blank workbook.
2 From the Developer tab, select Excel Add-Ins.
3 In the Add-Ins dialog box, click Browse.
4 Browse to Fourier.xla and click OK.

The Spectral Analysis add-in appears in the available Add-Ins list with a checked box.
5 Click OK to load the add-in.

This add-in installs a menu item under the Excel Add-ins menu.

Create Data

Before invoking the add-in, create test data that contains a signal with components at 15 Hz and 40
Hz. Sample the signal for 10 seconds at a sampling rate of 0.01 s. Put the time points into column A
and the signal points into column B.

1 Enter 0 into cell A1 in the current worksheet.
2 Press F5 or CTRL+G to launch the Go To dialog. Add the reference A2:A1001 and click OK to

select the cells.
3 Enter the formula = A1 + 0.01, then press CTRL+Enter to apply the formula to the selected

cells.

This procedure fills the range A1:A1001 with the interval 0–10 incremented by 0.01.
4 Repeat the Go To procedure to enter the following formula into each cell in the range B1:B1001:

= SIN(2*PI()*15*A1) + SIN(2*PI()*40*A1) + RAND()

Run Test

Using the column of data (column B), test the add-in.

1 To display the Spectral Analysis UI, select Add-ins > Spectral Analysis.
2 Click the Input Data box.
3 Select the B1:B1001 range from the worksheet, or type this range into the Input Data field.
4 In the Sampling Interval field, type 0.01.
5 Select Plot time domain signal and power spectral density.
6 Enter C1:C1001 for frequency output, and likewise enter D1:D1001, E1:E1001, and F1:F1001

for the FFT real part, FFT imaginary part, and spectral density.
7 Click OK to run the analysis.

The following figure shows an example of the output.
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The power spectral density reveals the two signals at 15 Hz and 40 Hz.
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For More Information
For more information about... See...
Functions available through MATLAB Compiler Function reference in MATLAB Compiler

documentation
Utility functions you can use to customize COM
components created with MATLAB Compiler

“Reference Utility Classes” on page 9-2
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Assign Multiple MATLAB Functions to Excel Class

Create Add-In In MATLAB

Note In order to call a MATLAB function using the Microsoft Excel function syntax
(=myfunction(input)), the MATLAB function must return a single scalar output argument. To
specify multiple outputs, create a macro using the Function Wizard or custom VBA code.

1 Copy the xlbasic folder that ships with MATLAB to your work folder:

copyfile(fullfile(matlabroot,'toolbox','matlabxl','examples','xlbasic'),'xlbasic')

At the MATLAB command prompt, navigate to the new xlbasic folder in your work folder.
2 Examine the MATLAB functions doubleit.m, incrementit.m, and powerit.m.

 function output = doubleit(input)
   output = input * 2;

function output = incrementit(input1, input2)
   output = input1 + input2;

 function output = powerit(input1, input2)
   output = power(input1, input2);

3 Build the Excel add-in with the Library Compiler app or compiler.build.excelAddIn.

Use the following information for your project:

Add-in Name myexcelfunctions
Class Name myexcelfunctionsclass
Files to Compile doubleit.m

incrementit.m
powerit.m

For example, if you are using compiler.build.excelAddIn, type:
buildResults = compiler.build.excelAddIn(["doubleit.m","incrementit.m","powerit.m"], ...
'AddInName','myexcelfunctions', ...
'ClassName','myexcelfunctionsclass', ...
'GenerateVisualBasicFile','on', ...
'Verbose','on');

For more details, see the instructions in “Create Excel Add-In from MATLAB” on page 2-5.

Deploy Add-In to Microsoft Excel
1 To deploy your add-in to end users, see “Distribute Add-Ins and Integrate into Microsoft Excel”

on page 2-11.

After you register the component and install the add-in, you can use the doubleit,
incrementit, and powerit functions in your spreadsheet.

2 Open Microsoft Excel with a blank workbook.
3 Test the functions by doing the following:

7 Distribution to End Users

7-2



a Enter =doubleit(2.5) in cell A1.
b Enter =incrementit(11,17) in cell A2.
c Enter =powerit(7,2) in cell A3.

You should see the values 5, 28, and 49 in cells A1, A2, and A3, respectively.
4 (Optional) Use the doubleit, powerit, and incrementit functions in new Microsoft Excel

spreadsheets by saving it as a template.

a Select File > Save As and select the file type .xlt (Template).
b Browse to the Office_Installation_folder\XLSTART folder.
c Save the file as Office_Installation_folder\XLSTART\Book.xlt.

Note  Your Microsoft Excel Macro Security level must be set at Medium or Low to save this
template.
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Improve Data Access Using the MATLAB Runtime User Data
Interface and COM Components

Overview
The MATLAB Runtime user data interface is a lightweight interface to easily access MATLAB Runtime
data. It allows data to be shared between the MATLAB Runtime instance, the MATLAB code running
on that MATLAB Runtime instance, and the wrapper code that created the MATLAB Runtime
instance. Through calls to the MATLAB Runtime user data interface API, you access the MATLAB
Runtime data by creating a per MATLAB Runtime instance associative array of mxArrays, consisting
of a mapping from string keys to mxArray values. Reasons for doing this include, but are not limited
to:

• You need to supply run-time profile information to a client running an application created with the
Parallel Computing Toolbox™. Profile information may be supplied (and change) on a per-
execution basis. For example, two instances of the same application may run simultaneously with
different profiles.

• You want to initialize MATLAB Runtime with constant values that can be accessed by all your
MATLAB applications.

• You want to set up a global workspace — a global variable or variables that the MATLAB and your
client can access.

• You want to store the state of any variable or group of variables.

MATLAB Compiler supports per the MATLAB Runtime instance state access through an object-
oriented API. Unlike MATLAB Compiler, access to per the MATLAB Runtime instance state is
optional, rather than on by default. You can access this state by adding setmcruserdata.m and
getmcruserdata.m to your deployment project or by specifying them on the command line.
Alternately, you use a helper function to call these methods, as shown in “Supply Run-Time Profile
Information for Parallel Computing Toolbox Applications” on page 7-4.

For more information, see the MATLAB Compiler User's Guide.

Supply Run-Time Profile Information for Parallel Computing Toolbox Applications

Following is a complete example of how you can use the MATLAB Runtime User Data Interface as a
mechanism to specify a profile for Parallel Computing Toolbox applications.

Note Standalone executables and shared libraries generated from MATLAB Compiler or MATLAB
Compiler SDK for parallel applications can now launch up to twelve local workers without MATLAB
Parallel Server™.

Step 1: Write Your Parallel Computing Toolbox Code

1 Create sample_pct.m in MATLAB.

This example code uses the cluster defined in the default profile for Parallel Computing Toolbox.

function speedup = sample_pct (n)
warning off all;
tic
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if(ischar(n))
    n=str2double(n);
end
for ii = 1:n
   (cov(sin(magic(n)+rand(n,n))));
end
time1 =toc;
parpool;
tic
parfor ii = 1:n
   (cov(sin(magic(n)+rand(n,n))));
end
time2 =toc;
disp(['Normal loop time: ' num2str(time1) ...
    ', parallel loop time: ' num2str(time2) ]);
disp(['parallel speedup: ' num2str(1/(time2/time1)) ...
    ' times faster than normal']);
delete(gcp);
disp('done');
speedup = (time1/time2);

2 Run the function with the input 400.

a = sample_pct(400)

3 The following is an example of the output, assuming the default profile is set to local:

Starting parallel pool (parpool) using the 'local' profile ...
Connected to the parallel pool (number of workers: 6).
Normal loop time: 2.5651, parallel loop time: 1.6371
parallel speedup: 1.5668 times faster than normal
Parallel pool using the 'local' profile is shutting down.
done

ans =

    1.5668

Step 2: Set the Parallel Computing Toolbox Profile

In order to compile MATLAB code to a COM component and utilize the Parallel Computing Toolbox,
the mcruserdata must be set directly from MATLAB. There is no API available to access the
MCRUserdata as there is for C and C++ applications built with MATLAB Compiler.

To set the mcruserdata from MATLAB, create an init function in your COM class. This is a
separate MATLAB function that uses setmcruserdata to set the Parallel Computing Toolbox profile
once. You then call your other functions to utilize the Parallel Computing Toolbox functions.

Create the following init function:

function init_sample_pct
% Set the Parallel Profile:
if(isdeployed)
    [profile] = uigetfile('*.settings'); 
                          % let the USER select file
    setmcruserdata('ParallelProfile',[profile]);
end
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Step 3: Compile Your Function with the Deploytool or the Command Line

You can compile your function from the command line by entering the following:
mcc -B 'cexcel:exPctComp,exPctClass,1.0' init_sample_pct.m sample_pct.m

Alternately, you can use the deploytool as follows:

1 Follow the steps in “Create Excel Add-In from MATLAB” on page 2-5 to compile your application.

When the compilation finishes, a new folder (with the same name as the project) is created.

Project Name exPctComp
Class Name exPctClass
File to compile sample_pct.m and init_sample_pct.m

Note If you are using the GPU feature of Parallel Computing Toolbox, you must manually add the
PTX and CU files.

• If you are using the Library Compiler app, click Add files/directories on the Build tab.
• If you are using a compiler.build function, use the AdditionalFiles option.
• If you are using the mcc command, use the -a option.

2 To deploy the compiled application, copy the for_redistribution_files_only folder, which
contains the following, to your end users.

• exPctComp.dll
• VBA module (.bas file)
• MATLAB Runtime installer
• Cluster profile

Note The end-user's target machine must have access to the cluster.

Step 4: Modify the generated VBA Driver Application (the BAS File)

After registering the COM DLL on the deployment machine and importing the BAS file into Excel,
modify the generated BAS file code as needed.

Dim MCLUtil As Object
Dim bModuleInitialized As Boolean
Dim exPctClass As Object
 
Private Sub InitModule()
  If Not bModuleInitialized Then
    On Error GoTo Handle_Error
    If MCLUtil Is Nothing Then
      Set MCLUtil = CreateObject("MWComUtil.MWUtil7.10")
    End If
    Call MCLUtil.MWInitApplication(Application)
    bModuleInitialized = True
    Exit Sub
Handle_Error:
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    bModuleInitialized = False
  End If
End Sub
 
Function init_sample_pct() As Variant
 
  On Error GoTo Handle_Error
  Call InitModule
  If exPctClass Is Nothing Then
    Set exPctClass = CreateObject("exPctComp.exPctClass.1_0")
  End If
  Call exPctClass.init_sample_pct
  init_sample_pct = Empty
 
  Exit Function
Handle_Error:
  init_sample_pct = "Error in " & 
                         Err.Source & ": " & Err.Description
End Function
 
 
Function sample_pct(Optional pelle As Variant) As Variant
  Dim speedup As Variant
 
  On Error GoTo Handle_Error
  Call InitModule
  If exPctClass Is Nothing Then
    Set exPctClass = CreateObject("exPctComp.exPctClass.1_0")
  End If
  Call exPctClass.sample_pct(1, speedup, pelle)
  sample_pct = speedup
 
  Exit Function
Handle_Error:
  sample_pct = "Error in " & Err.Source 
                         & ": " & Err.Description
End Function

The output is as follows:
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MATLAB Runtime Component Cache and Deployable Archive
Embedding

Deployable archive data is automatically embedded directly in MATLAB Compiler components by
default and extracted to a temporary folder.

Automatic embedding enables usage of MATLAB Runtime Component Cache features through
environment variables.

These variables allow you to specify the following:

• Define the default location where you want the deployable archive to be automatically extracted
• Add diagnostic error printing options that can be used when automatically extracting the

deployable, for troubleshooting purposes
• Tuning the MATLAB Runtime component cache size for performance reasons.

Use the following environment variables to change these settings.

Environment Variable Purpose Notes
MCR_CACHE_ROOT When set to the location of where

you want the deployable archive to
be extracted, this variable overrides
the default per-user component
cache location. This is true for
embedded .ctf files only.

On macOS, this variable is ignored
in MATLAB R2020a and later. The
app bundle contains the files
necessary for runtime.

MCR_CACHE_SIZE When set, this variable overrides
the default component cache size.

The initial limit for this variable is
32M (megabytes). This may,
however, be changed after you have
set the variable the first time. Edit
the file .max_size, which resides
in the file designated by running the
mcrcachedir command, with the
desired cache size limit.

You can override this automatic embedding and extraction behavior by compiling with the -C option.
See “Overriding Default Behavior” on page 7-9 for details.

Note If you run mcc specifying conflicting wrapper and target types, the deployable archive will not
be embedded into the generated component. For example, if you run:

mcc -W lib:myLib -T link:exe test.m test.c

the generated test.exe will not have the deployable archive embedded in it, as if you had specified
a -C option to the command line.

Caution Do not extract the files within the.ctf file and place them individually under version
control. Since the .ctf file contains interdependent MATLAB functions and data, the files within it
must be accessed only by accessing the .ctf file. For best results, place the entire .ctf file under
version control.
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Overriding Default Behavior
To extract the deployable archive in a manner prior to R2008b, alongside the compiled COM
component, compile using the mcc -c option.

You can also implement this override by adding the -c flag in the Settings section of the compiler
app.

If you are using a compiler.build function, disable the EmbedArchive option.

You might want to use this option to troubleshoot problems with the deployable archive, for example,
as the log and diagnostic messages are much more visible.

For More Information
For more information about the deployable archive, see “Deployable Archive”.
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MATLAB Runtime Options for Excel Add-Ins

What MATLAB Runtime Options are Supported by MATLAB Compiler?
• -logfile — Creates a named log file.

How Do I Specify MATLAB Runtime Options?
If You Compiled the Add-In in MATLAB or used mcc

If you are building your add-in using the MATLAB Library Compiler, select Create log file under
Additional Runtime Settings.

If you are building your add-in using mcc, simply specify -logfile with the mcc -R command

If You Created a Function From Scratch Using the Function Wizard

If you created a function from scratch using the Function Wizard, and want to specify MATLAB
Runtime options, you have to manually modify the .bas file code.

You do this by invoking the following MWUtil API calls, detailed with examples in “Class MWUtil” on
page 9-3:

• Sub MWInitApplicationWithMCROptions(pApp As Object, [mcrOptionList]) on page
9-4

• Function IsMCRJVMEnabled() As Boolean on page 9-5
• Function IsMCRInitialized() As Boolean on page 9-5
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For More Information
For more information about... See...
Functions available through MATLAB Compiler Function Reference pages in MATLAB Compiler

documentation
Utility functions you can use to customize COM
components created with MATLAB Compiler

“Reference Utility Classes” on page 9-2
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compiler.build.excelAddIn
Create Microsoft Excel add-in

Syntax
compiler.build.excelAddIn(FunctionFiles)
compiler.build.excelAddIn(FunctionFiles,Name,Value)
compiler.build.excelAddIn(opts)
results = compiler.build.excelAddIn( ___ )

Description

Caution This function is only supported on Windows operating systems.

compiler.build.excelAddIn(FunctionFiles) creates an Excel add-in using MATLAB functions
specified by FunctionFiles. Before creating Excel add-ins, install a supported compiler.

compiler.build.excelAddIn(FunctionFiles,Name,Value) creates an Excel add-in with
options specified using one or more name-value arguments. Options include the add-in name, the
output directory, and whether to generate a Microsoft Visual Basic file.

compiler.build.excelAddIn(opts) creates an Excel add-in with options specified using a
compiler.build.excelAddInOptions object opts. You cannot specify any other options using
name-value arguments.

results = compiler.build.excelAddIn( ___ ) returns build information as a
compiler.build.Results object using any of the input argument combinations in previous
syntaxes. The build information consists of the build type, paths to the compiled files, and build
options.

Examples

Create Excel Add-In

Create an Excel add-in on a Windows system using a function file that generates a magic square.

Ensure that you have the following installed:

• The Windows 10 SDK kit. For details, see Windows 10 SDK.
• MinGW-w64. To install it from the MathWorks File Exchange, see MATLAB Support for MinGW-

w64 C/C++ Compiler.

Use mbuild -setup -client mbuild_com to ensure that MATLAB is able to create Excel add-
ins.

In MATLAB, locate the MATLAB function that you want to deploy as an Excel add-in. For this
example, use the file magicsquare.m located in matlabroot\extern\examples\compiler.
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appFile = fullfile(matlabroot,'extern','examples','compiler','magicsquare.m');

Build an Excel add-in using the compiler.build.excelAddIn command.
compiler.build.excelAddIn(appFile);

The function generates the following files within a folder named magicsquareexcelAddIn in your
current working directory:

• dlldata.c
• GettingStarted.html
• includedSupportPackages.txt
• magicsquare.def
• magicsquare.bas (Only if you enable the 'GenerateVisualBasicFile' option)
• magicsquare.rc
• magicsquare.xla (Only if you enable the 'GenerateVisualBasicFile' option)
• magicsquare_1_0.dll
• magicsquare_dll.cpp
• magicsquare_idl.h
• magicsquare_idl.idl
• magicsquare_idl.tlb
• magicsquare_idl_i.c
• magicsquare_idl_p.c
• magicsquareClass_com.cpp
• magicsquareClass_com.hpp
• mccExcludedFiles.log
• mwcomtypes.h
• mwcomtypes_i.c
• mwcomtypes_p.c
• readme.txt
• requiredMCRProducts.txt
• unresolvedSymbols.txt

Customize Excel Add-In

Create an Excel add-in on a Windows system and customize it using name-value arguments.

For this example, use the file magicsquare.m located in matlabroot\extern\examples
\compiler.
appFile = fullfile(matlabroot,'extern','examples','compiler','magicsquare.m');

Build an Excel add-in using the compiler.build.excelAddIn command. Use name-value
arguments to specify the add-in name and version, generate a Microsoft Visual Basic file, and enable
verbose output.
compiler.build.excelAddIn(appFile,'AddInName','MyMagicSquare',...
    'AddInVersion','2.0',...
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    'GenerateVisualBasicFile','on',...
    'Verbose','on');

The function generates the following files within a folder named MyMagicSquareexcelAddIn in
your current working directory:

• dlldata.c
• GettingStarted.html
• includedSupportPackages.txt
• magicsquareClass_com.cpp
• magicsquareClass_com.hpp
• mccExcludedFiles.log
• mwcomtypes.h
• mwcomtypes_i.c
• mwcomtypes_p.c
• MyMagicSquare.bas
• MyMagicSquare.def
• MyMagicSquare.rc
• MyMagicSquare.xla
• MyMagicSquare_2_0.dll
• MyMagicSquare_dll.cpp
• MyMagicSquare_idl.h
• MyMagicSquare_idl.idl
• MyMagicSquare_idl.tlb
• MyMagicSquare_idl_i.c
• MyMagicSquare_idl_p.c
• readme.txt
• requiredMCRProducts.txt
• unresolvedSymbols.txt

Create Multiple Add-Ins Using Options Object

Create multiple Excel add-ins on a Windows system using a compiler.build.ExcelAddInOptions
object.

For this example, use the file magicsquare.m located in matlabroot\extern\examples
\compiler.
appFile = fullfile(matlabroot,'extern','examples','compiler','magicsquare.m');

Create an ExcelAddInOptions object using appFile. Use name-value arguments to specify a
common output directory, generate a Visual Basic file, and enable verbose output.
opts = compiler.build.excelAddInOptions(appFile,...
    'OutputDir','D:\Documents\MATLAB\work\ExcelAddInBatch',...
    'GenerateVisualBasicFile','on',...
    'Verbose','on')
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opts =

  ExcelAddInOptions with properties:

                  AddInName: 'magicsquare'
               AddInVersion: '1.0.0.0'
                  ClassName: 'magicsquareClass'
                 DebugBuild: off
               EmbedArchive: on
              FunctionFiles: {'C:\Program Files\MATLAB\R2022b\extern\examples\compiler\magicsquare.m'}
    GenerateVisualBasicFile: on
            AdditionalFiles: {}
        AutoDetectDataFiles: on
            SupportPackages: {'autodetect'}
                    Verbose: on
                  OutputDir: 'D:\Documents\MATLAB\work\ExcelAddInBatch'

Build the add-in using the ExcelAddInOptions object.
compiler.build.excelAddIn(opts);

To create a new add-in using the function file myMagic2.m with the same options, use dot notation to
modify the FunctionFiles argument of the existing ExcelAddInOptions object before running
the build function again.
opts.FunctionFiles = 'myMagic2.m';
compiler.build.excelAddIn(opts);

By modifying the FunctionFiles argument and recompiling, you can create multiple add-ins using
the same options object.

Get Build Information from Excel Add-In

Create an Excel add-in and save information about the build type, generated files, included support
packages, and build options to a compiler.build.Results object.

Compile using the file magicsquare.m located in matlabroot\extern\examples\compiler.
results = compiler.build.excelAddIn('magicsquare.m')

results = 

  Results with properties:

              BuildType: 'excelAddIn'
                  Files: {2×1 cell}
IncludedSupportPackages: {}
                Options: [1×1 compiler.build.ExcelAddInOptions]

The Files property contains the paths to the following compiled files:

• magicsquare_1_0.dll
• GettingStarted.html
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Note The files magicsquare.bas and magicsquare.xla are included in Files only if you enable
the 'GenerateVisualBasicFile' option in the build command.

Input Arguments
FunctionFiles — Files implementing MATLAB functions
character vector | string scalar | cell array of character vectors | string array

Files implementing MATLAB functions, specified as a character vector, a string scalar, a string array,
or a cell array of character vectors. File paths can be relative to the current working directory or
absolute. Files must have a .m extension.
Example: ["myfunc1.m","myfunc2.m"]
Data Types: char | string | cell

opts — Excel add-in build options
compiler.build.ExcelAddInOptions object

Excel add-in build options, specified as a compiler.build.ExcelAddInOptions object.

Name-Value Pair Arguments

Specify optional pairs of arguments as Name1=Value1,...,NameN=ValueN, where Name is the
argument name and Value is the corresponding value. Name-value arguments must appear after
other arguments, but the order of the pairs does not matter.

Before R2021a, use commas to separate each name and value, and enclose Name in quotes.
Example: 'Verbose','on'

AddInName — Name of Excel add-in
character vector | string scalar

Name of the Excel add-in, specified as a character vector or string scalar. The default name of the
generated add-in is the first entry of the FunctionFiles argument. The name must begin with a
letter and contain only alphabetic characters and underscores.
Example: 'AddInName','myAddIn'
Data Types: char | string

AddInVersion — Add-in version
'1.0.0.0' (default) | character vector | string scalar

Add-in version, specified as a character vector or a string scalar.
Example: 'AddInVersion','4.0'
Data Types: char | string

AdditionalFiles — Additional files
character vector | string scalar | cell array of character vectors | string array

Additional files and folders to include in the Excel add-in, specified as a character vector, a string
scalar, a string array, or a cell array of character vectors. Paths can be relative to the current working
directory or absolute.
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Example: 'AdditionalFiles',["myvars.mat","data.txt"]
Data Types: char | string | cell

AutoDetectDataFiles — Flag to automatically include data files
'on' (default) | on/off logical value

Flag to automatically include data files, specified as 'on' or 'off', or as numeric or logical 1 (true)
or 0 (false). A value of 'on' is equivalent to true, and 'off' is equivalent to false. Thus, you can
use the value of this property as a logical value. The value is stored as an on/off logical value of type
matlab.lang.OnOffSwitchState.

• If you set this property to 'on', then data files that you provide as inputs to certain functions
(such as load and fopen) are automatically included in the add-in.

• If you set this property to 'off', then you must add data files to the add-in using the
AdditionalFiles property.

Example: 'AutoDetectDataFiles','Off'
Data Types: logical

ClassName — Name of class
character vector | string scalar

Name of the class, specified as a character vector or a string scalar. Class names must match Excel
add-in class name requirements.

The default value is the name of the first file listed in the FunctionFiles argument appended with
Class.
Example: 'ClassName','magicsquareClass'
Data Types: char | string

DebugBuild — Flag to enable debug symbols
'on' (default) | on/off logical value

Flag to enable debug symbols, specified as 'on' or 'off', or as numeric or logical 1 (true) or 0
(false). A value of 'on' is equivalent to true, and 'off' is equivalent to false. Thus, you can use
the value of this property as a logical value. The value is stored as an on/off logical value of type
matlab.lang.OnOffSwitchState.

• If you set this property to 'on', then the add-in is compiled with debug symbols.
• If you set this property to 'off', then the add-in is not compiled with debug symbols.

Example: 'DebugSymbols','On'
Data Types: logical

EmbedArchive — Flag to embed deployable archive
'on' (default) | on/off logical value

Flag to embed the deployable archive, specified as 'on' or 'off', or as numeric or logical 1 (true)
or 0 (false). A value of 'on' is equivalent to true, and 'off' is equivalent to false. Thus, you can
use the value of this property as a logical value. The value is stored as an on/off logical value of type
matlab.lang.OnOffSwitchState.
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• If you set this property to 'on', then the function embeds the deployable archive in the Excel add-
in.

• If you set this property to 'off', then the function generates the deployable archive as a separate
file.

Example: 'EmbedArchive','Off'
Data Types: logical

GenerateVisualBasicFile — Flag to generate Visual Basic file
'off' (default) | on/off logical value

Flag to generate a Visual Basic file (.bas) and an Excel add-in file (.xla), specified as 'on' or
'off', or as numeric or logical 1 (true) or 0 (false). A value of 'on' is equivalent to true, and
'off' is equivalent to false. Thus, you can use the value of this property as a logical value. The
value is stored as an on/off logical value of type matlab.lang.OnOffSwitchState.

• If you set this property to 'on', then the function generates an Excel add-in XLA file and a Visual
Basic BAS file containing the Microsoft Excel Formula Function interface to the add-in.

• If you set this property to 'off', then the function does not generate a Visual Basic file or an
Excel add-in file.

Note To generate the Excel add-in file (.xla), you must enable "Trust access to the VBA project
object model" in your Excel settings.

Example: 'GenerateVisualBasicFile','On'
Data Types: logical

OutputDir — Path to output directory
character vector | string scalar

Path to the output directory where the build files are saved, specified as a character vector or a string
scalar. The path can be relative to the current working directory or absolute.

The default name of the build folder is the add-in name appended with excelAddIn.
Example: 'OutputDir','D:\Documents\MATLAB\work\mymagicexcelAddIn'
Data Types: char | string

SupportPackages — Support packages
'autodetect' (default) | 'none' | string scalar | cell array of character vectors | string array

Support packages to include, specified as one of the following options:

• 'autodetect' (default) — The dependency analysis process detects and includes the required
support packages automatically.

• 'none' — No support packages are included. Using this option can cause runtime errors.
• A string scalar, character vector, or cell array of character vectors — Only the specified support

packages are included. To list installed support packages or those used by a specific file, see
compiler.codetools.deployableSupportPackages.
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Example: 'SupportPackages',{'Deep Learning Toolbox Converter for TensorFlow
Models','Deep Learning Toolbox Model for Places365-GoogLeNet Network'}

Data Types: char | string | cell

Verbose — Flag to control build verbosity
'off' (default) | on/off logical value

Flag to control build verbosity, specified as 'on' or 'off', or as numeric or logical 1 (true) or 0
(false). A value of 'on' is equivalent to true, and 'off' is equivalent to false. Thus, you can use
the value of this property as a logical value. The value is stored as an on/off logical value of type
matlab.lang.OnOffSwitchState.

• If you set this property to 'on', then the MATLAB command window displays progress
information indicating compiler output during the build process.

• If you set this property to 'off', then the command window does not display progress
information.

Example: 'Verbose','On'
Data Types: logical

Output Arguments
results — Build results
compiler.build.Results object

Build results, returned as a compiler.build.Results object. The Results object contains:

• Build type, which is 'excelAddIn'
• Paths to the following files:

• GettingStarted.html
• AddInName_AddInVersion.dll
• AddInName.bas (if you enable the 'GenerateVisualBasicFile' option)
• AddInName.xla (if you enable the 'GenerateVisualBasicFile' option)

• A list of included support packages
• Build options, specified as an ExcelAddInOptions object

Limitations
• This function is only supported on Windows operating systems.

Version History
Introduced in R2021a

See Also
compiler.build.ExcelAddInOptions | Library Compiler | mcc
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compiler.build.ExcelAddInOptions
Options for building Excel add-ins

Syntax
opts = compiler.build.ExcelAddInOptions(FunctionFiles)
opts = compiler.build.ExcelAddInOptions(FunctionFiles,Name,Value)

Description
opts = compiler.build.ExcelAddInOptions(FunctionFiles) creates an
ExcelAddInOptions object using the MATLAB functions specified by FunctionFiles. Use the
ExcelAddInOptions object as an input to the compiler.build.excelAddIn function.

opts = compiler.build.ExcelAddInOptions(FunctionFiles,Name,Value) creates an
ExcelAddInOptions object with options specified using one or more name-value arguments.
Options include the add-in name, additional files to include, and the output directory.

Examples

Create Excel Add-In Options Object

Create an ExcelAddInOptions object using file input.

For this example, use the file magicsquare.m located in matlabroot\extern\examples
\compiler.

appFile = fullfile(matlabroot,'extern','examples','compiler','magicsquare.m');
opts = compiler.build.ExcelAddInOptions(appFile)

opts = 

  ExcelAddInOptions with properties:

                  AddInName: 'magicsquare'
               AddInVersion: '1.0.0.0'
                  ClassName: 'magicsquareClass'
                 DebugBuild: off
               EmbedArchive: on
              FunctionFiles: {'C:\Program Files\MATLAB\R2022b\extern\examples\compiler\magicsquare.m'}
    GenerateVisualBasicFile: off
            AdditionalFiles: {}
        AutoDetectDataFiles: on
            SupportPackages: {'autodetect'}
                    Verbose: off
                  OutputDir: '.\magicsquareexcelAddIn'

You can modify the property values of an existing ExcelAddInOptions object using dot notation.
For example, enable verbose output.
opts.Verbose = 'on'
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opts = 

  ExcelAddInOptions with properties:

                  AddInName: 'magicsquare'
               AddInVersion: '1.0.0.0'
                  ClassName: 'magicsquareClass'
                 DebugBuild: off
               EmbedArchive: on
              FunctionFiles: {'C:\Program Files\MATLAB\R2022b\extern\examples\compiler\magicsquare.m'}
    GenerateVisualBasicFile: off
            AdditionalFiles: {}
        AutoDetectDataFiles: on
            SupportPackages: {'autodetect'}
                    Verbose: on
                  OutputDir: '.\magicsquareexcelAddIn'

Use the ExcelAddInOptions object as an input to the compiler.build.excelAddIn function to
build the Excel add-in.
buildResults = compiler.build.excelAddIn(opts);

Customize Excel Add-In Options Object

Create an ExcelAddInOptions object and customize it using name-value arguments.

For this example, use the file magicsquare.m located in matlabroot\extern\examples
\compiler. Use name-value arguments to specify the output directory, generate a Visual Basic file,
and enable verbose output.

appFile = fullfile(matlabroot,'extern','examples','compiler','magicsquare.m');
opts = compiler.build.ExcelAddInOptions(appFile,...
    'OutputDir','D:\Documents\MATLAB\work\MagicSquareAddIn',...
    'GenerateVisualBasicFile','On')

opts =

  ExcelAddInOptions with properties:

                  AddInName: 'magicsquare'
               AddInVersion: '1.0.0.0'
                  ClassName: 'magicsquareClass'
                 DebugBuild: off
               EmbedArchive: on
              FunctionFiles: {'C:\Program Files\MATLAB\R2022b\extern\examples\compiler\magicsquare.m'}
    GenerateVisualBasicFile: on
            AdditionalFiles: {}
        AutoDetectDataFiles: on
            SupportPackages: {'autodetect'}
                    Verbose: off
              OutputDir: 'D:\Documents\MATLAB\work\MagicSquareAddIn'

Use the ExcelAddInOptions object as an input to the compiler.build.excelAddIn function to
build the Excel add-in.
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buildResults = compiler.build.excelAddIn(opts);

Input Arguments
FunctionFiles — MATLAB function files
character vector | string scalar | cell array of character vectors | string array

List of files implementing MATLAB functions, specified as a character vector, a string scalar, a string
array, or a cell array of character vectors. Files must have a .m extension.
Example: {'myFunction1.m','myFunction2.m'}
Data Types: char | string | cell

Name-Value Pair Arguments

Specify optional pairs of arguments as Name1=Value1,...,NameN=ValueN, where Name is the
argument name and Value is the corresponding value. Name-value arguments must appear after
other arguments, but the order of the pairs does not matter.

Before R2021a, use commas to separate each name and value, and enclose Name in quotes.
Example: 'Verbose','on'

AddInName — Name of Excel add-in
character vector | string scalar

Name of the Excel add-in, specified as a character vector or string scalar. The default name of the
generated add-in is the first entry of the FunctionFiles argument. The name must begin with a
letter and contain only alphabetic characters and underscores.
Example: 'AddInName','myAddIn'
Data Types: char | string

AddInVersion — Add-in version
'1.0.0.0' (default) | character vector | string scalar

Add-in version, specified as a character vector or a string scalar.
Example: 'AddInVersion','4.0'
Data Types: char | string

AdditionalFiles — Additional files
character vector | string scalar | cell array of character vectors | string array

Additional files and folders to include in the Excel add-in, specified as a character vector, a string
scalar, a string array, or a cell array of character vectors. Paths can be relative to the current working
directory or absolute.
Example: 'AdditionalFiles',["myvars.mat","data.txt"]
Data Types: char | string | cell

AutoDetectDataFiles — Flag to automatically include data files
'on' (default) | on/off logical value

Flag to automatically include data files, specified as 'on' or 'off', or as numeric or logical 1 (true)
or 0 (false). A value of 'on' is equivalent to true, and 'off' is equivalent to false. Thus, you can
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use the value of this property as a logical value. The value is stored as an on/off logical value of type
matlab.lang.OnOffSwitchState.

• If you set this property to 'on', then data files that you provide as inputs to certain functions
(such as load and fopen) are automatically included in the add-in.

• If you set this property to 'off', then you must add data files to the add-in using the
AdditionalFiles property.

Example: 'AutoDetectDataFiles','Off'
Data Types: logical

ClassName — Name of class
character vector | string scalar

Name of the class, specified as a character vector or a string scalar. Class names must match Excel
add-in class name requirements.

The default value is the name of the first file listed in the FunctionFiles argument appended with
Class.
Example: 'ClassName','magicsquareClass'
Data Types: char | string

DebugBuild — Flag to enable debug symbols
'on' (default) | on/off logical value

Flag to enable debug symbols, specified as 'on' or 'off', or as numeric or logical 1 (true) or 0
(false). A value of 'on' is equivalent to true, and 'off' is equivalent to false. Thus, you can use
the value of this property as a logical value. The value is stored as an on/off logical value of type
matlab.lang.OnOffSwitchState.

• If you set this property to 'on', then the add-in is compiled with debug symbols.
• If you set this property to 'off', then the add-in is not compiled with debug symbols.

Example: 'DebugSymbols','On'
Data Types: logical

EmbedArchive — Flag to embed deployable archive
'on' (default) | on/off logical value

Flag to embed the deployable archive, specified as 'on' or 'off', or as numeric or logical 1 (true)
or 0 (false). A value of 'on' is equivalent to true, and 'off' is equivalent to false. Thus, you can
use the value of this property as a logical value. The value is stored as an on/off logical value of type
matlab.lang.OnOffSwitchState.

• If you set this property to 'on', then the function embeds the deployable archive in the Excel add-
in.

• If you set this property to 'off', then the function generates the deployable archive as a separate
file.

Example: 'EmbedArchive','Off'
Data Types: logical
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GenerateVisualBasicFile — Flag to generate Visual Basic file
'off' (default) | on/off logical value

Flag to generate a Visual Basic file (.bas) and an Excel add-in file (.xla), specified as 'on' or
'off', or as numeric or logical 1 (true) or 0 (false). A value of 'on' is equivalent to true, and
'off' is equivalent to false. Thus, you can use the value of this property as a logical value. The
value is stored as an on/off logical value of type matlab.lang.OnOffSwitchState.

• If you set this property to 'on', then the function generates an Excel add-in XLA file and a Visual
Basic BAS file containing the Microsoft Excel Formula Function interface to the add-in.

• If you set this property to 'off', then the function does not generate a Visual Basic file or an
Excel add-in file.

Note To generate the Excel add-in file (.xla), you must enable "Trust access to the VBA project
object model" in your Excel settings.

Example: 'GenerateVisualBasicFile','On'
Data Types: logical

OutputDir — Path to output directory
character vector | string scalar

Path to the output directory where the build files are saved, specified as a character vector or a string
scalar. The path can be relative to the current working directory or absolute.

The default name of the build folder is the add-in name appended with excelAddIn.
Example: 'OutputDir','D:\Documents\MATLAB\work\mymagicexcelAddIn'
Data Types: char | string

SupportPackages — Support packages
'autodetect' (default) | 'none' | string scalar | cell array of character vectors | string array

Support packages to include, specified as one of the following options:

• 'autodetect' (default) — The dependency analysis process detects and includes the required
support packages automatically.

• 'none' — No support packages are included. Using this option can cause runtime errors.
• A string scalar, character vector, or cell array of character vectors — Only the specified support

packages are included. To list installed support packages or those used by a specific file, see
compiler.codetools.deployableSupportPackages.

Example: 'SupportPackages',{'Deep Learning Toolbox Converter for TensorFlow
Models','Deep Learning Toolbox Model for Places365-GoogLeNet Network'}

Data Types: char | string | cell

Verbose — Flag to control build verbosity
'off' (default) | on/off logical value

Flag to control build verbosity, specified as 'on' or 'off', or as numeric or logical 1 (true) or 0
(false). A value of 'on' is equivalent to true, and 'off' is equivalent to false. Thus, you can use
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the value of this property as a logical value. The value is stored as an on/off logical value of type
matlab.lang.OnOffSwitchState.

• If you set this property to 'on', then the MATLAB command window displays progress
information indicating compiler output during the build process.

• If you set this property to 'off', then the command window does not display progress
information.

Example: 'Verbose','On'
Data Types: logical

Output Arguments
opts — Excel add-in build options
ExcelAddInOptions object

Excel add-in build options, returned as an ExcelAddInOptions object.

Version History
Introduced in R2021a

See Also
compiler.build.excelAddIn | mcc
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componentinfo
Query system registry about component created with MATLAB Compiler

Syntax
info = componentinfo
info = componentinfo(component_name)
info = componentinfo(component_name, major_revision_number)
info = componentinfo(component_name, major_revision_number,
minor_revision_number)

Arguments
component_name MATLAB character vector or string scalar providing the

name of a MATLAB Compiler component. Names are
case sensitive. If this argument is not supplied, the
function returns information on all installed
components.

major_revision_number Component major revision number. If this argument is
not supplied, the function returns information on all
major revisions.

minor_revision_number Component minor revision number. Default value is 0.

Description
info = componentinfo returns information for all components installed on the system.

info = componentinfo(component_name) returns information for all revisions of
component_name.

info = componentinfo(component_name, major_revision_number) returns information for
the most recent minor revision corresponding to major_revision_number of component_name.

info = componentinfo(component_name, major_revision_number,
minor_revision_number) returns information for the specific major and minor version of
component_name.

The return value is an array of structures representing all the registry and type information needed
to load and use the component.

When you supply a component name, major_revision_number and minor_revision_number are
interpreted as shown below.

Value Information Returned
> 0 Information on a specific major and minor revision
0 Information on the most recent revision.

When omitted, minor_revision_number is assumed to be equal to 0.
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Value Information Returned
< 0 Information on all versions

Note Although properties and events may appear in the output for componentinfo, they are not
supported by MATLAB Compiler SDK.

Registry Information
The information about a component has the fields shown in the following table.

Registry Information Returned by componentinfo

Field Description
Name Component name.
TypeLib Component type library.
LIBID Component type library GUID.
MajorRev Major version number.
MinorRev Minor version number.
FileName Type library file name and path. Since all the MATLAB Compiler

components have the type library bound into the DLL, this file name is the
same as the DLL name and path.

Interfaces An array of structures defining all interface definitions in the type library.
Each structure contains two fields:

• Name - Interface name.
• IID - Interface GUID.
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Registry Information Returned by componentinfo (Continued)

CoClasses An array of structures defining all COM classes in the component.
Each structure contains these fields:

• Name - Class name.
• CLSID - GUID of the class.
• ProgID - Version-dependent program ID.
• VerIndProgID - Version-independent program ID.
• InprocServer32 - Full name and path to component DLL.
• Methods - A structure containing function prototypes of all

class methods defined for this interface. This structure contains
four fields:

• IDL - An array of Interface Description Language function
prototypes.

• M - An array of MATLAB function prototypes.
• C - An array of C-language function prototypes.
• VB - An array of VBA function prototypes.

• Properties - A cell array containing the names of all class
properties.

• Events - A structure containing function prototypes of all events
defined for this class. This structure contains four fields:

• IDL - An array of Interface Description Language function
prototypes.

• M - An array of MATLAB function prototypes.
• C - An array of C-language function prototypes.
• VB - An array of VBA function prototypes.

Examples
Function Call Returns
Info = componentinfo Information for all installed components.
Info = componentinfo('mycomponent') Information for all revisions of

mycomponent.
Info = componentinfo('mycomponent',1,0) Information for revision 1.0 of

mycomponent.

Version History
Introduced in R2015a
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deploytool
Open a list of application deployment apps

Syntax
deploytool
deploytool project_name

Description
deploytool opens a list of application deployment apps.

deploytool project_name opens the appropriate deployment app with the project preloaded.

Examples

Open a List of Application Deployment Apps

Open the list of apps.

deploytool

Input Arguments
project_name — name of the project to be opened
character array or string

Name of the project to be opened by the appropriate deployment app, specified as a character array
or string. The project must be on the current path.

Version History
Introduced in R2006b

-build and -package options will be removed
Warns starting in R2020a

The -build and -package options will be removed. To build applications, use one of the
compiler.build family of functions or the mcc command; and to package and create an installer,
use the compiler.package.installer function.
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libraryCompiler
Open the Library Compiler app

Syntax
libraryCompiler
libraryCompiler project_name

Description
libraryCompiler opens the Library Compiler app for the creation of a new compiler project

libraryCompiler project_name opens the Library Compiler app with the project preloaded.

Examples

Create a New Project

Open the Library Compiler app to create a new project.

libraryCompiler

Input Arguments
project_name — name of the project to be compiled
character array or string

Specify the name of a previously saved project. The project must be on the current path.

Version History
Introduced in R2013b

-build and -package options will be removed
Warns starting in R2020a

The -build and -package options will be removed. To build applications, use one of the
compiler.build family of functions or the mcc command; and to package and create an installer,
use the compiler.package.installer function.

8 Functions

8-20



mcc
Compile MATLAB functions for deployment

Syntax
mcc

mcc options mfilename1 mfilename2 ... mfilenameN
mcc('options','mfilename')

mcc -m options mfilename
mcc -e options mfilename

mcc -W 'excel:addin_name,className,version=version_number' options mfilename1
mfilename2 ... mfilenameN

mcc -H -W hadoop:archiveName,CONFIG:configFile mfilename

mcc -m options mfilename

Description
Other mcc Topics

This topic describes mcc options for use with MATLAB Compiler. For information on compiling:

• C/C++ shared libraries, .NET assemblies, Java packages, or Python packages, see mcc
• MATLAB Production Server™ deployable archives or Excel add-ins for MATLAB Production

Server, see mcc

General Usage

mcc options mfilename1 mfilename2 ... mfilenameN compiles the functions as specified by
the options. The options used depend on the intended results of the compilation.

mcc('options','mfilename') compiles the function as specified by the options. Specify
filenames, options, and option parameters in single quotes.

Standalone Application

mcc -m options mfilename compiles the function into a standalone application.

This syntax is equivalent to mcc -W main -T link:exe.

mcc -e options mfilename compiles the function into a standalone application that does not
open a Windows command prompt on execution. The -e option works only on Windows operating
systems.

This syntax is equivalent to -W WinMain -T link:exe.
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Excel Add-In

mcc -W 'excel:addin_name,className,version=version_number' options mfilename1
mfilename2 ... mfilenameN creates a Microsoft Excel add-in from the specified files.

• addin_name — Specifies the name of the add-in.
• className — Specifies the name of the class to be created. If you do not specify the class name,

mcc uses the addin_name as the default. If specified, className needs to be different from
mfilename.

• version_number — Specifies the version number of the add-in file as major.minor.bug.build
in the file system. You are not required to specify a version number. If you do not specify a version
number, mcc sets the version number to 1.0.0.0 by default.

• major — Specifies the major version number. If you do not specify a number, mcc sets major
to 0.

• minor — Specifies the minor version number. If you do not specify a number, mcc sets minor
to 0.

• bug— Specifies the bug fix maintenance release number. If you do not specify a number, mcc
sets bug to 0.

• build— Specifies the build number. If you do not specify a number, mcc sets build to 0.

Note Excel add-ins can be created only in MATLAB running on Windows.

Note Remove the single quotes around 'excel:addin_name,className,version' when
executing the mcc command from a DOS prompt.

MapReduce Applications on Hadoop

mcc -H -W hadoop:archiveName,CONFIG:configFile mfilename generates a deployable
archive from mfilename that can be run as a job by Hadoop®.

• archiveName — Specifies the name of the generated archive.
• configFile — Specifies the path to the configuration file for creating a deployable archive. For

more information, see “Configuration File for Creating Deployable Archive Using the mcc
Command”.

Tip You can issue the mcc command either at the MATLAB command prompt or the Windows or
Linux system command-line.

Simulink Simulations (Requires Simulink Compiler)

mcc -m options mfilename compiles a MATLAB application containing a Simulink® simulation
into a standalone application. For more information, see “Create and Deploy a Script with Simulink
Compiler” (Simulink Compiler).
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Examples
Create a standalone application

mcc -m magic.m

Create a standalone application that does not open the Command shell (Windows only)

mcc -e magic.m

Create a standalone application with a system-level file version number (Windows only)

Create a standalone application in Windows with version number 3.4.1.5.

mcc -W 'main:mymagic,version=3.4.1.5' mymagic.m

Create a standalone application and include MATLAB preferences

mcc -m helloWorld.m -a C:\Users\someuser\AppData\Roaming\MathWorks\MATLAB\R2022b\matlab.mlsettings

Create an Excel add-in

mcc -W 'excel:myAddin,myClass,1.0' magic.m

Create an Excel add-in with a system-level file version number (Windows only)

Create an Excel add-in in Windows with version number 5.2.1.7.

mcc -W 'excel:myAddin,myClass,version=5.2.1.7' -b mymagic.m

Create a Standalone Application for a Simulink Simulation (Requires Simulink Compiler)

To create a standalone application for a Simulink simulation:

Create a Simulink model using Simulink. This example uses the model sldemo_suspn_3dof.

Create a MATLAB application that uses APIs from Simulink Compiler to simulate the model. For more
information, see “Deploy Simulations with Tunable Parameters” (Simulink Compiler).
function deployParameterTuning(outputFile, mbVariable)
 
    if ischar(mbVariable) || isstring(mbVariable)
        mbVariable = str2double(mbVariable);
    end
     
    if isnan(mbVariable) || ~isa(mbVariable, 'double') || ~isscalar(mbVariable)
        disp('mb must be a double scalar or a string or char that can be converted to a double scalar');
    end
     
    in = Simulink.SimulationInput('sldemo_suspn_3dof');   
    in = in.setVariable('Mb', mbVariable);
    in = simulink.compiler.configureForDeployment(in);
    out = sim(in);
     
    save(outputFile, 'out');
  
end

Use mcc to create a standalone application from the MATLAB application.
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mcc -m deployParameterTuning.m

Input Arguments
mfilename — File to be compiled
file name

File to be compiled, specified as a character vector or string scalar.

mfilename1 mfilename2 ... mfilenameN — Files to be compiled
list of file names

One or more files to be compiled, specified as a space-separated list of file names. The first file is
used as the entry point for the compiled artifact.

options — Options for customizing the output
-a | -b | -B | -c | -C | -d | -f | -g | -G | -I | -j | -k | -K | -m | -M | -n | -N | -o | -p | -r | -R | -s | -S | -T | -u | -U | -
v | -w | -W | -X | -Y | -Z

Options for customizing the output, specified as a list of character vectors or string scalars.

• -a

Add files to the deployable archive using -a filepath to specify the files to be added. Multiple -
a options are permitted.

Also, add MATLAB preferences to a deployed application using -a path\to
\mymatlab.mlsettings to specify the preferences to be added.

If a file name is specified with -a, the compiler looks for these files on the MATLAB path, so
specifying the full path name is optional. These files are not passed to mbuild, so you can include
files such as data files. For more details, see “Access Files in Packaged Applications”.

If a folder name is specified with the -a option, the entire contents of that folder are added
recursively to the deployable archive. For example,

mcc -m hello.m -a ./testdir 

specifies that all files in testdir, as well as all files in its subfolders, are added to the deployable
archive. The folder subtree in testdir is preserved in the deployable archive.

If the filename includes a wildcard pattern, only the files in the folder that match the pattern are
added to the deployable archive and subfolders of the given path are not processed recursively.
For example,

mcc -m hello.m -a ./testdir/*

specifies that all files in ./testdir are added to the deployable archive and subfolders under ./
testdir are not processed recursively.

mcc -m hello.m -a ./testdir/*.m

specifies that all files with the extension .m under ./testdir are added to the deployable archive
and subfolders of ./testdir are not processed recursively.
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Note * is the only supported wildcard.

When you add files to the archive using -a that do not appear on the MATLAB path at the time of
compilation, a path entry is added to the application's run-time path so that they appear on the
path when the deployed code executes.

When you use the -a option to specify a full path to a resource, the basic path is preserved, with
some modifications, but relative to a subdirectory of the runtime cache directory, not to the user's
local folder. The cache directory is created from the deployable archive the first time the
application is executed. You can use the isdeployed function to determine whether the
application is being run in deployed mode, and adjust the path accordingly. The -a option also
creates a .auth file for authorization purposes.

Caution If you use the -a flag to include a file that is not on the MATLAB path, the folder
containing the file is added to the MATLAB dependency analysis path. As a result, other files from
that folder might be included in the compiled application.

Note If you use the -a flag to include custom Java classes, standalone applications work without
any need to change the classpath as long as the Java class is not a member of a package. The
same applies for JAR files. However, if the class being added is a member of a package, the
MATLAB code needs to make an appropriate call to javaaddpath to update the classpath with
the parent folder of the package.

• -A

Append supported platforms to those detected automatically by the compiler. Use

-A arch

to add the platform designated by arch to the list of compatible platforms. Valid platforms are
win64, maci64, glnxa64, and all. The -A option only applies to Python, C/C++ using the
MATLAB data array API, and Java targets.

Running the component on an incompatible platform will result in an unsupported platform error
message and list compatible platforms.

• -b

Generate a Visual Basic file (.bas) containing the Microsoft Excel Formula Function interface to
the COM object generated by MATLAB Compiler. When imported into the workbook Visual Basic
code, this code allows the MATLAB function to be seen as a cell formula function.

• -B

Replace the file on the mcc command line with the contents of the specified file. Use

-B filename[:<a1>,<a2>,...,<an>]

The bundle filename should contain only mcc command-line options and corresponding
arguments and/or other file names. The file might contain other -B options. A bundle can include
replacement parameters for compiler options that accept names and version numbers. See “Using
Bundles to Build MATLAB Code” (MATLAB Compiler SDK).

• -c
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When used in conjunction with the -l option, suppresses compiling and linking of the generated C
wrapper code. The -c option cannot be used independently of the -l option.

• -C

Do not embed the deployable archive in binaries.

Note The -C flag is ignored for Java libraries.
• -d

Place output in a specified folder. Use

-d outFolder

to direct the generated files to outFolder. The specified folder must already exist.
• -e

Use -e in place of the -m option to generate a standalone Windows application that does not open
a Windows command prompt on execution. -e is equivalent to -W WinMain -T link:exe.

This option works only on Windows operating systems.
• -f

Override the default options file with the specified options file. It specifically applies to the C/C++
shared libraries, COM, and Excel targets. Use

-f filename

to specify filename as the options file when calling mbuild. This option lets you use different
ANSI compilers for different invocations of the compiler. This option is a direct pass-through to
mbuild.

• -g, -G

Include debugging symbol information for the C/C++ code generated by MATLAB Compiler SDK.
It also causes mbuild to pass appropriate debugging flags to the system C/C++ compiler. The
debug option lets you backtrace up to the point where you can identify if the failure occurred in
the initialization of MATLAB Runtime, the function call, or the termination routine. This option
does not let you debug your MATLAB files with a C/C++ debugger.

• -h

Specify a custom help text file. This option applies to standalone applications, C/C++ shared
libraries, COM, and Excel targets. Use

-f filename

to include filename as the custom help text file. Display help file contents by calling the
application at the command line with the -? or /? argument.

• -I

Add a new folder path to the list of included folders. Each -I option appends the folder to the end
of the list of paths to search. For example,

-I <directory1> -I <directory2>
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sets up the search path so that directory1 is searched first for MATLAB files, followed by
directory2. This option is important for standalone compilation where the MATLAB path is not
available.

If used in conjunction with the -N option, the -I option adds the folder to the compilation path in
the same position where it appeared in the MATLAB path rather than at the head of the path.

• -j

Automatically convert all .m files to P-files before packaging. The -j option generates a P-code file
with a .p extension for each .m file included in the mcc command.

P-code files are an obfuscated, execute-only form of MATLAB code. For more details, see pcode.
• -k

Specify an AES encryption key and a MEX-file loader interface to retrieve the decryption key at
runtime.

Use

-k "file=<key_file_path>;loader=<mex_file_path>"

to specify paths to the key file and MEX-file.

The key file must be in one of the following supported formats:

• Binary 256-bit AES key, with a 32 byte file size
• Hex encoded AES key, with a 64 character file size

The loader MEX-file must be an interface with the following arguments:

• prhs[0] — Input, char array specified as the static value 'getKey'
• prhs[1] — Input, char array specified as the CTF component UUID
• plhs[0] — Output, 32 byte UINT8 numeric array or 64 byte HEX encoded char array

If you do not specify any arguments after -k, mcc generates a 256-bit AES key and a loader MEX-
file that can be used for demonstration purposes.

• -K

Direct mcc to not delete output files if the compilation ends prematurely due to error.

The default behavior of mcc is to dispose of any partial output if the command fails to execute
successfully.

• -l

Generate a function library. -l is equivalent to -W lib -T link:lib. You cannot use this option
in a deploytool app.

• -m

Generate a standalone application. -m is equivalent to -W main -T link:exe. You cannot use
this option in a deploytool app.

• -M

Define compile-time options. Use
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-M string

to pass string directly to mbuild. This option provides a useful mechanism for defining compile-
time options, for example, -M "-Dmacro=value".

Note Multiple -M options do not accumulate; only the rightmost -M option is used.

To pass options such as /bigobj, delineate the string according to your platform.

Platform Syntax
MATLAB -M 'COMPFLAGS=$COMPFLAGS /bigobj'

Windows command prompt -M COMPFLAGS="$COMPFLAGS /bigobj"

Linux and macOS command line -M CFLAGS='$CFLAGS /bigobj'

• -n

The -n option automatically identifies numeric command line inputs and treats them as MATLAB
doubles.

• -N

Passing -N clears the path of all folders except the following core folders (this list is subject to
change over time):

• matlabroot\toolbox\matlab
• matlabroot\toolbox\local
• matlabroot\toolbox\compiler
• matlabroot\toolbox\shared\bigdata

Passing -N also retains all subfolders in this list that appear on the MATLAB path at compile time.
Including -N on the command line lets you replace folders from the original path, while retaining
the relative ordering of the included folders. All subfolders of the included folders that appear on
the original path are also included. In addition, the -N option retains all folders that you included
on the path that are not under matlabroot\toolbox.

When using the –N option, use the –I option to force inclusion of a folder, which is placed at the
head of the compilation path. Use the –p option to conditionally include folders and their
subfolders; if they are present in the MATLAB path, they appear in the compilation path in the
same order.

• -o

Specify the name of the final executable (standalone applications only). Use

-o outputfile

to name the final executable output of MATLAB Compiler. A suitable platform-dependent
extension is added to the specified name (for example, .exe for Windows standalone
applications).

• -p
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Use in conjunction with the option -N to add specific folders and subfolders under matlabroot
\toolbox to the compilation MATLAB path. The files are added in the same order in which they
appear in the MATLAB path. Use the syntax

-N -p directory

where directory is the folder to be included. If directory is not an absolute path, it is
assumed to be under the current working folder.

• If a folder is included with -p that is on the original MATLAB path, the folder and all its
subfolders that appear on the original path are added to the compilation path in the same
order.

• If a folder is included with -p that is not on the original MATLAB path, that folder is ignored.
(You can use -I to force its inclusion.)

• -r

Embed resource icon in binary. The syntax is as follows:

-r 'path/to/my_icon.ico'

• -R

Provide MATLAB Runtime options that are passed to the application at initialization time.

Note This option is relevant only when building standalone applications or Excel add-ins using
MATLAB Compiler. If you specify the -R option for libraries created from MATLAB Compiler SDK,
mcc still compiles and generates the results, but the -R option doesn't apply to these libraries and
does not do anything.

The syntax is as follows:

-R option

Option Description Target
'-
logfile,
filename
'

Specify a log file name. The file is created in
the application folder at runtime and contains
information about MATLAB Runtime
initialization and all text piped to the command
window. Option must be in single quotes. Use
double quotes when executing the command
from a Windows Command Prompt.

MATLAB Compiler

-
nodispla
y

Suppress the MATLAB nodisplay run-time
warning. On Linux, open MATLAB Runtime
without display functionality.

MATLAB Compiler

-nojvm Do not use the Java Virtual Machine (JVM). MATLAB Compiler
'-
startmsg
,message
'

Customizable user message displayed at
initialization time. For more details, see
“Display MATLAB Runtime Initialization
Messages”.

MATLAB Compiler Standalone
Applications
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Option Description Target
'-
complete
msg,mess
age'

Customizable user message displayed when
initialization is complete. For more details, see
“Display MATLAB Runtime Initialization
Messages”.

MATLAB Compiler Standalone
Applications

-
singleCo
mpThread

Limit MATLAB to a single computational
thread.

MATLAB Compiler

-
software
opengl

Use Mesa Software OpenGL® for rendering. MATLAB Compiler

Caution When running on macOS, if you use -nodisplay as one of the options included in
mclInitializeApplication, then the call to mclInitializeApplication must occur before
calling mclRunMain.

• -s

Obfuscate folder structures and file names in the deployable archive (.ctf file) from the end user.
Optionally encrypt additional file types.

The -s option directs mcc to place user code and data contained in .m, .p, v7.3 .mat, and MEX
files into a user package within the CTF. During runtime, MATLAB code and data is decrypted and
loaded directly from the user package rather than extracted to the file system. MEX files are
temporarily extracted from the user package before being loaded.

To manually include additional file types in the user package, add each file type in a separate
extension tag to the file matlabroot/toolbox/compiler/
advanced_package_supported_files.xml.

The following is not supported:

• ver function
• Out-of-process MATLAB Runtime ( C++ shared library for MATLAB Data Array)
• Out-of-process MEX file execution (mexhost, feval, matlab.mex.MexHost)

• -S

Create a single MATLAB Runtime instance that is shared across all class instances.

The standard behavior for the MATLAB Runtime is that every instance of a class gets its own
MATLAB Runtime context. The context includes a global MATLAB workspace for variables, such
as the path, and a base workspace for each function in the class. If multiple instances of a class
are created, each instance gets an independent context. This ensures that changes made to the
global or base workspace in one instance of the class does not affect other instances of the same
class.

In a singleton MATLAB Runtime, all instances of a class share the context. If multiple instances of
a class are created, they use the context created by the first instance which saves startup time and
some resources. However, any changes made to the global workspace or the base workspace by
one instance impacts all class instances. For example, if instance1 creates a global variable A in
a singleton MATLAB Runtime, then instance2 can use variable A.
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Singleton MATLAB Runtime is only supported by the following products on these specific targets:

Target supported by Singleton MATLAB Runtime Create a Singleton MATLAB Runtime by....
Excel add-in Default behavior for target is singleton MATLAB

Runtime. You do not need to perform other steps.
.NET assembly Default behavior for target is singleton MATLAB

Runtime. You do not need to perform other steps.
COM component • Using the Library Compiler app, click Settings

and add -S to the Additional parameters
passed to MCC field.

• Using mcc, pass the -S flag.

Java package

• -T

Specify the output target phase and type. If not specified, mcc uses the default type for the target
specified by the -W option.

Use the syntax -T target to define the output type.

Target Description
compile:exe Generate a C/C++ wrapper file, and compile

C/C++ files to an object form suitable for
linking into a standalone application.

compile:lib Generate a C/C++ wrapper file, and compile
C/C++ files to an object form suitable for
linking into a shared library or DLL.

link:exe Same as compile:exe and also link object
files into a standalone application.

link:lib Same as compile:lib and also link object
files into a shared library or DLL.

• -u

Register COM component for the current user only on the development machine. The argument
applies only to the generic COM component and Microsoft Excel add-in targets.

• -U

Build deployable archive (.ctf file) for MATLAB Production Server.
• -v

Display verbose output. Output displays the compilation steps, including:

• MATLAB Compiler version number
• Source file names as they are processed
• Names of the generated output files as they are created
• Invocation of mbuild

The -v option passes the -v option to mbuild and displays information about mbuild.
• -w
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Display warning messages. Use the syntax

-w option [:<msg>]

to control the display of warnings.

Syntax Description
-w list List the compile-time warnings that have abbreviated

identifiers, together with their status.
-w enable Enable all compile-time warnings.
-w disable[:<string>] Disable specific compile-time warnings associated with

<string>. Omit the optional <string> to apply the
disable action to all compile-time warnings.

-w enable[:<string>] Enable specific compile-time warnings associated with
<string>. Omit the optional <string> to apply the
enable action to all compile-time warnings.

-w error[:<string>] Treat specific compile-time and runtime warnings
associated with <string> as an error. Omit the optional
<string> to apply the error action to all compile-time
and runtime warnings.

-w off[:<string>] Turn off warnings for specific error messages defined by
<string>. Omit the optional <string> to apply the off
action to all runtime warnings.

-w on[:<string>] Turn on runtime warnings associated with <string>.
Omit the optional <string> to apply the on action to all
runtime warnings. This option is enabled by default.

You can also turn warnings on or off in your MATLAB code.

For example, to turn off warnings for deployed applications (specified using isdeployed) in
startup.m, you write:

if isdeployed
    warning off
end

To turn on warnings for deployed applications, you write:

if isdeployed
    warning on
end

You can also specify multiple -w options.

For example, if you want to disable all warnings except repeated_file, you write:

-w disable -w enable:repeated_file

When you specify multiple -w options, they are processed from left to right.
• -W

Control the generation of function wrappers. Use the syntax
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-W type 

to control the generation of function wrappers for a collection of MATLAB files generated by the
compiler. You provide a list of functions, and the compiler generates the wrapper functions and
any appropriate global variable definitions.

Target Syntax

Note Replace single quotes with double when executing the command from a Windows Command
Prompt.

• -X

Use -X to ignore data files read by common MATLAB file I/O functions during dependency
analysis. For more information, see “Dependency Analysis Using MATLAB Compiler”. For
examples on how to use the -X option, see %#exclude.

• -Y

Use

 -Y license.lic

to override the default license file with the specified argument.

Note The -Y flag works only with the command-line mode.

>>!mcc -m foo.m -Y license.lic

• -Z

Use

-Z option

to specify the method of adding support packages to the deployable archive.

Syntax Description
-Z 'autodetect' The dependency analysis process detects and

includes the required support packages
automatically. This is the default behavior of
mcc.

-Z 'none' No support packages are included. Using this
option can cause runtime errors.

-Z packagename Only the specified support package is
included. To specify multiple support
packages, use multiple -Z inputs.

Note To list installed support packages or those used by a specific file, see
compiler.codetools.deployableSupportPackages.
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Tips
• On Windows, you can generate a system-level file version number for your target file by appending

version=version_number to the target generating mcc syntax. For an example, see “Create a
standalone application with a system-level file version number (Windows only)”.

version_number — Specifies the version of the target file as major.minor.bug.build in the
file system. You are not required to specify a version number. If you do not specify a version
number, mcc sets the version number, by default, to 1.0.0.0.

• major — Specifies the major version number. If you do not specify a version number, mcc sets
major to 1.

• minor — Specifies the minor version number. If you do not specify a version number, mcc sets
minor to 0.

• bug — Specifies the bug fix maintenance release number. If you do not specify a version
number, mcc sets bug to 0.

• build — Specifies build number. If you do not specify a version number, mcc sets build to 0.

This functionality is supported for standalone applications and Excel add-ins in MATLAB Compiler.
For supported targets in MATLAB Compiler SDK, see the Tips section in mcc.

Version History
Introduced before R2006a

See Also
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Utility Library for Microsoft COM
Components

• “Reference Utility Classes” on page 9-2
• “Class MWUtil” on page 9-3
• “Class MWFlags” on page 9-10
• “Class MWStruct” on page 9-15
• “Class MWField” on page 9-20
• “Class MWComplex” on page 9-21
• “Class MWSparse” on page 9-23
• “Class MWArg” on page 9-26
• “Enum mwArrayFormat” on page 9-27
• “Enum mwDataType” on page 9-28
• “Enum mwDateFormat” on page 9-29
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Reference Utility Classes
This section describes the MWComUtil library. This library is freely distributable and includes several
functions used in array processing, as well as type definitions used in data conversion. This library is
contained in the file matlabroot\bin\win64\mwcomutil.dll. You must register it on each
machine that uses Microsoft COM components created by MATLAB Compiler or MATLAB Compiler
SDK.

For instructions on registering the MWComUtil library at the command prompt, see “Register
MATLAB Utility Libraries” on page 2-12.

The MWComUtil library includes seven classes and three enumerated types. Before using these types,
you must make explicit references to the MWComUtil type libraries in the Microsoft Visual Basic IDE.

See Also

Related Examples
• “Class MWUtil” on page 9-3
• “Class MWFlags” on page 9-10
• “Class MWStruct” on page 9-15
• “Class MWField” on page 9-20
• “Class MWComplex” on page 9-21
• “Class MWSparse” on page 9-23
• “Class MWArg” on page 9-26
• “Enum mwArrayFormat” on page 9-27
• “Enum mwDataType” on page 9-28
• “Enum mwDateFormat” on page 9-29
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Class MWUtil
The MWUtil class contains a set of static utility methods used in array processing and application
initialization. This class is implemented internally as a singleton (only one global instance of this class
per instance of Microsoft Excel). It is most efficient to declare one variable of this type in global scope
within each module that uses it. The methods of MWUtil are listed below.

The function prototypes use Visual Basic syntax.

Sub MWInitApplication(pApp As Object)
Initializes the library with the current instance of Microsoft Excel.

Parameters

Argument Type Description
pApp Object A valid reference to the current

Excel application

Return Value

None.

Remarks

This function must be called once for each session of Excel that uses COM components created by
MATLAB Compiler. An error is generated if a method call is made to a member class of any MATLAB
Compiler SDK COM component, and the library has not been initialized.

Example

This Visual Basic sample initializes the MWComUtil library with the current instance of Excel. A
global variable of type Object named MCLUtil holds an instance of the MWUtil class, and another
global variable of type Boolean named bModuleInitialized stores the status of the initialization
process. The private subroutine InitModule() creates an instance of the MWComUtil class and calls
the MWInitApplication method with an argument of Application. Once this function succeeds,
all subsequent calls exit without recreating the object.

Dim MCLUtil As Object
Dim bModuleInitialized As Boolean

Private Sub InitModule()
    If Not bModuleInitialized Then
        On Error GoTo Handle_Error
        If MCLUtil Is Nothing Then
            Set MCLUtil = CreateObject("MWComUtil.MWUtil")
        End If
        Call MCLUtil.MWInitApplication(Application)
        bModuleInitialized = True
        Exit Sub
Handle_Error:
        bModuleInitialized = False
    End If
End Sub
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Note If you are developing concurrently with multiple versions of MATLAB and MWComUtil.dll, for
example, using the following syntax requires you to recompile your COM modules every time you
upgrade.

Set MCLUtil = CreateObject("MWComUtil.MWUtil")

To avoid this, make your call to the MWUtil module version-specific, where x.x is the specific version
number.

Set MCLUtil = CreateObject("MWComUtil.MWUtilx.x")

Sub MWInitApplicationWithMCROptions(pApp As Object,
[mcrOptionList])
Start MATLAB Runtime with MATLAB Runtime options. Similar to mclInitializeApplication
(MATLAB Compiler SDK).

Parameters

Argument Type Description
pApp Object A valid reference only when

called from an Excel application

Non Excel COM clients pass in
Empty.

Return Value

None.

Remarks

Call this function to pass in MATLAB Runtime options (nojvm, logfile, etc.). Call this function once
per process.

Example

This Visual Basic sample initializes the MWComUtil library with the current instance of Excel. A
global variable of type Object named MCLUtil holds an instance of the MWUtil class, and another
global variable of type Boolean named bModuleInitialized stores the status of the initialization
process. The private subroutine InitModule() creates an instance of the MWComUtil class and calls
the MWInitApplicationWithMCROptions method with an argument of Application and a string
array that contains the options. Once this function succeeds, all subsequent calls exit without
recreating the object. When this function successfully executes, the MATLAB Runtime starts up with
no JVM™ and a logfile named logfile.txt.

Dim MCLUtil As Object
Dim bModuleInitialized As Boolean

Private Sub InitModule()
    If Not bModuleInitialized Then
        On Error GoTo Handle_Error
        If MCLUtil Is Nothing Then
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            Set MCLUtil = CreateObject("MWComUtil.MWUtil")
        End If
             Dim mcrOptions(1 To 3) as String
             mcrOptions(1) = "-nojvm"
             mcrOptions(2) = "-logfile"
             mcrOptions(3) = "logfile.txt"
        Call MCLUtil.MWInitApplicationWithMCROptions(Application, mcrOptions)
        bModuleInitialized = True
        Exit Sub
Handle_Error:
        bModuleInitialized = False
    End If
End Sub

Note If you are not using Excel, pass in Nothing instead of Application to
MWInitApplicationWithMCROptions.

Function IsMCRJVMEnabled() As Boolean
Returns true if MATLAB Runtime is launched with JVM; otherwise returns false.

Parameters

None.

Return Value

Boolean

Function IsMCRInitialized() As Boolean
Returns true if MATLAB Runtime is initialized; otherwise returns false

Parameters

None.

Return Value

Boolean

Sub MWPack(pVarArg, [Var0], [Var1], ... ,[Var31])
Packs a variable length list of Variant arguments into a single Variant array. This function is
typically used for creating a varargin cell from a list of separate inputs. Each input in the list is only
added to the array if it is not empty or missing. (In Visual Basic, a missing parameter is denoted by a
Variant type of vbError with a value of &H80020004.)

Parameters

Argument Type Description
pVarArg Variant Receives the resulting array
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Argument Type Description
[Var0], [Var1], ... Variant Optional list of Variants to

pack into the array. From 0 to
32 arguments can be passed.

Return Value

None.

Remarks

This function always frees the contents of pVarArg before processing the list.

Example

This example uses MWPack in a formula function to produce a varargin cell to pass as an input
parameter to a method compiled from a MATLAB function with the following signature:

function y = mysum(varargin)
    y = sum([varargin{:}]);

The function returns the sum of the elements in varargin. Assume that this function is a method of a
class named myclass that is included in a component named mycomponent with a version of 1.0.
The Visual Basic function allows up to 10 inputs, and returns the result y. If an error occurs, the
function returns the error message. This function assumes that MWInitApplication has been
previously called.

Function mysum(Optional V0 As Variant, _
               Optional V1 As Variant, _
               Optional V2 As Variant, _
               Optional V3 As Variant, _
               Optional V4 As Variant, _
               Optional V5 As Variant, _
               Optional V6 As Variant, _
               Optional V7 As Variant, _
               Optional V8 As Variant, _
               Optional V9 As Variant) As Variant
Dim y As Variant
Dim varargin As Variant
Dim aClass As Object
Dim aUtil As Object
    
    On Error Goto Handle_Error
    Set aClass = CreateObject("mycomponent.myclass.1_0")
    Set aUtil = CreateObject("MWComUtil.MWUtil")
    Call aUtil.MWPack(varargin,V0,V1,V2,V3,V4,V5,V6,V7,V8,V9)
    Call aClass.mysum(1, y, varargin)
    mysum = y
    Exit Function
Handle_Error:
    mysum = Err.Description
End Function
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Sub MWUnpack(VarArg, [nStartAt As Long], [bAutoResize As Boolean
= False], [pVar0], [pVar1], ..., [pVar31])
Unpacks an array of Variants into individual Variant arguments. This function provides the
reverse functionality of MWPack and is typically used to process a varargout cell into individual
Variants.

Parameters

Argument Type Description
VarArg Variant Input array of Variants to be

processed
nStartAt Long Optional starting index (zero-

based) in the array to begin
processing. Default = 0.

bAutoResize Boolean Optional auto-resize flag. If this
flag is True, any Excel range
output arguments are resized to
fit the dimensions of the
Variant to be copied. The
resizing process is applied
relative to the upper left corner
of the supplied range. Default =
False.

[pVar0],[pVar1], ... Variant Optional list of Variants to
receive the array items
contained in VarArg. From 0 to
32 arguments can be passed.

Return Value

None.

Remarks

This function can process a Variant array in one single call or through multiple calls using the
nStartAt parameter.

Example

This example uses MWUnpack to process a varargout cell into several Excel ranges, while auto-
resizing each range. The varargout parameter is supplied from a method that has been compiled
from the MATLAB function.

function varargout = randvectors
    for i=1:nargout
        varargout{i} = rand(i,1);
    end

This function produces a sequence of nargout random column vectors, with the length of the ith
vector equal to i. Assume that this function is included in a class named myclass that is included in a
component named mycomponent with a version of 1.0. The Visual Basic subroutine takes no
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arguments and places the results into Excel columns starting at A1, B1, C1, and D1. If an error
occurs, a message box displays the error text. This function assumes that MWInitApplication has
been previously called.

Sub GenVectors()
    Dim aClass As Object
    Dim aUtil As Object
    Dim v As Variant
    Dim R1 As Range
    Dim R2 As Range
    Dim R3 As Range
    Dim R4 As Range
    
    On Error GoTo Handle_Error
    Set aClass = CreateObject("mycomponent.myclass.1_0")
    Set aUtil = CreateObject("MWComUtil.MWUtil")
    Set R1 = Range("A1")
    Set R2 = Range("B1")
    Set R3 = Range("C1")
    Set R4 = Range("D1")
    Call aClass.randvectors(4, v)
    Call aUtil.MWUnpack(v,0,True,R1,R2,R3,R4)
    Exit Sub
Handle_Error:
    MsgBox (Err.Description)
End Sub

Sub MWDate2VariantDate(pVar)
Converts output dates from MATLAB to Variant dates.

Parameters

Argument Type Description
pVar Variant Variant to be converted

Return Value

None.

Remarks

MATLAB handles dates as double-precision floating-point numbers with 0.0 representing 0/0/00
00:00:00. By default, numeric dates that are output parameters from compiled MATLAB functions are
passed as Doubles that need to be decremented by the COM date bias as well as coerced to COM
dates. The MWDate2VariantDate method performs this transformation and additionally converts
dates in character vector form to COM date types.

Example

This example uses MWDate2VariantDate to process numeric dates returned from a method
compiled from the following MATLAB function.

function x = getdates(n, inc)
    y = now;
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    for i=1:n
        x(i,1) = y + (i-1)*inc;
    end

This function produces an n-length column vector of numeric values representing dates starting from
the current date and time with each element incremented by inc days. Assume that this function is
included in a class named myclass that is included in a component named mycomponent with a
version of 1.0. The subroutine takes an Excel range and a Double as inputs and places the generated
dates into the supplied range. If an error occurs, a message box displays the error text. This function
assumes that MWInitApplication has been previously called.

Sub GenDates(R As Range, inc As Double)
    Dim aClass As Object
    Dim aUtil As Object
    
    On Error GoTo Handle_Error
    Set aClass = CreateObject("mycomponent.myclass.1_0")
    Set aUtil = CreateObject("MWComUtil.MWUtil")
    Call aClass.getdates(1, R, R.Rows.Count, inc)
    Call aUtil.MWDate2VariantDate(R)
    Exit Sub
Handle_Error:
    MsgBox (Err.Description)
End Sub
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Class MWFlags
The MWFlags class contains a set of array formatting and data conversion flags. For more information
on conversion between MATLAB and COM Automation types, see “Rules for Data Conversion
Between .NET and MATLAB” (MATLAB Compiler SDK). All MATLAB Compiler SDK COM components
contain a reference to an MWFlags object that can modify data conversion rules at the object level.
This class contains these properties and method:

Property ArrayFormatFlags As MWArrayFormatFlags
The ArrayFormatFlags property controls array formatting (as a matrix or a cell array) and the
application of these rules to nested arrays. The MWArrayFormatFlags class is a noncreatable class
accessed through an MWFlags class instance. This class contains six properties:

• “Property InputArrayFormat As mwArrayFormat” on page 9-10
• “Property InputArrayIndFlag As Long” on page 9-10
• “Property OutputArrayFormat As mwArrayFormat” on page 9-11
• “Property OutputArrayIndFlag As Long” on page 9-11
• “Property AutoResizeOutput As Boolean” on page 9-11
• “Property TransposeOutput As Boolean” on page 9-11

Property InputArrayFormat As mwArrayFormat

This property of type mwArrayFormat controls the formatting of arrays passed as input parameters
to MATLAB Compiler SDK class methods. The default value is mwArrayFormatMatrix. The
behaviors indicated by this flag are listed in the next table.

Array Formatting Rules for Input Arrays
Value Behavior
mwArrayFormatAsIs Converts arrays according to the default

conversion rules listed in “Rules for Data
Conversion Between .NET and MATLAB”
(MATLAB Compiler SDK).

mwArrayFormatCell Coerces all arrays into cell arrays. Input scalar or
numeric array arguments are converted to cell
arrays with each cell containing a scalar value for
the respective index.

mwArrayFormatMatrix Coerces all arrays into matrices. When an input
argument is encountered that is an array of
Variants (the default behavior is to convert it to
a cell array), the data converter converts this
array to a matrix if each Variant is single
valued, and all elements are homogeneous and of
a numeric type. If this conversion is not possible,
creates a cell array.

Property InputArrayIndFlag As Long

This property governs the level at which to apply the rule set by the InputArrayFormat property
for nested arrays (an array of Variants is passed and each element of the array is an array itself). It
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is not necessary to modify this flag for varargin parameters. The data conversion code
automatically increments the value of this flag by 1 for varargin cells, thus applying the
InputArrayFormat flag to each cell of a varargin parameter. The default value is 0.

Property OutputArrayFormat As mwArrayFormat

This property of type mwArrayFormat controls the formatting of arrays passed as output parameters
to class methods. The default value is mwArrayFormatAsIs. The behaviors indicated by this flag are
listed in the next table.

Array Formatting Rules for Output Arrays

Value Behavior
mwArrayFormatAsIs Converts arrays according to the default

conversion rules listed in “Rules for Data
Conversion Between .NET and MATLAB”
(MATLAB Compiler SDK).

mwArrayFormatMatrix Coerces all arrays into matrices. When an output
cell array argument is encountered (the default
behavior converts it to an array of Variants),
the data converter converts this array to a
Variant that contains a simple numeric array if
each cell is single valued, and all elements are
homogeneous and of a numeric type. If this
conversion is not possible, an array of Variants
is created.

mwArrayFormatCell Coerces all output arrays into arrays of
Variants. Output scalar or numeric array
arguments are converted to arrays of Variants,
each Variant containing a scalar value for the
respective index.

Property OutputArrayIndFlag As Long

This property is similar to the InputArrayIndFalg property, as it governs the level at which to
apply the rule set by the OutputArrayFormat property for nested arrays. As with the input case,
this flag is automatically incremented by 1 for a varargout parameter. The default value of this flag
is 0.

Property AutoResizeOutput As Boolean

This flag applies to Excel ranges only. When the target output from a method call is a range of cells in
an Excel worksheet, and the output array size and shape is not known at the time of the call, setting
this flag to True instructs the data conversion code to resize each Excel range to fit the output array.
Resizing is applied relative to the upper left corner of each supplied range. The default value for this
flag is False.

Property TransposeOutput As Boolean

Setting this flag to True transposes the output arguments. This flag is useful when processing an
output parameter from a method call on a COM component, where the MATLAB function returns
outputs as row vectors, and you desire to place the data into columns. The default value for this flag
is False.
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Property DataConversionFlags As MWDataConversionFlags
The DataConversionFlags property controls how input variables are processed when type
coercion is needed. The MWDataConversionFlags class is a noncreatable class accessed through an
MWFlags class instance. This class contains these properties:

• “Property CoerceNumericToType As mwDataType” on page 9-12
• “PropertyDateBias As Long” on page 9-12
• “Property InputDateFormat As mwDateFormat” on page 9-13
• “PropertyOutputAsDate As Boolean” on page 9-13
• “ReplaceMissing As mwReplaceMissingData” on page 9-13

Property CoerceNumericToType As mwDataType

This property converts all numeric input arguments to one specific MATLAB type. This flag is useful is
when variables maintained within the Visual Basic code are different types, e.g., Long, Integer, etc.,
and all variables passed to the compiled MATLAB code must be doubles. The default value for this
property is mwTypeDefault, which uses the default rules in “Rules for Data Conversion
Between .NET and MATLAB” (MATLAB Compiler SDK).

PropertyDateBias As Long

This property sets the date bias for performing COM to MATLAB numeric date conversions. The
default value of this property is 693960, representing the difference between the COM Date type and
MATLAB numeric dates. This flag allows existing MATLAB code that already performs the increment
of numeric dates by 693960 to be used unchanged with COM components. To process dates with such
code, set this property to 0.

This example uses data conversion flags to reshape the output from a method compiled from a
MATLAB function that produces an output vector of unknown length.

function p = myprimes(n)
if length(n)~=1, error('N must be a scalar'); end
if n < 2, p = zeros(1,0); return, end
p = 1:2:n;
q = length(p);
p(1) = 2;
for k = 3:2:sqrt(n)
    if p((k+1)/2)
        p(((k*k+1)/2):k:q) = 0;
    end
end
p = (p(p>0));

This function produces a row vector of all the prime numbers between 0 and n. Assume that this
function is included in a class named myclass that is included in a component named mycomponent
with a version of 1.0. The subroutine takes an Excel range and a Double as inputs, and places the
generated prime numbers into the supplied range. The MATLAB function produces a row vector,
although you want the output in column format. It also produces an unknown number of outputs, and
you do not want to truncate any output. To handle these issues, set the TransposeOutput flag and
the AutoResizeOutput flag to True. In previous examples, the Visual Basic CreateObject
function creates the necessary classes. This example uses an explicit type declaration for the aClass
variable. As with previous examples, this function assumes that MWInitApplication has been
previously called.
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Sub GenPrimes(R As Range, n As Double)
    Dim aClass As mycomponent.myclass
    
    On Error GoTo Handle_Error
    Set aClass = New mycomponent.myclass
    aClass.MWFlags.ArrayFormatFlags.AutoResizeOutput = True
    aClass.MWFlags.ArrayFormatFlags.TransposeOutput = True
    Call aClass.myprimes(1, R, n)
    Exit Sub
Handle_Error:
    MsgBox (Err.Description)
End Sub

Property InputDateFormat As mwDateFormat

This property converts dates passed as input parameters to method calls on MATLAB Compiler SDK
classes. The default value is mwDateFormatNumeric. The behaviors indicated by this flag are shown
in the following table.

Conversion Rules for Input Dates

Value Behavior
mwDateFormatNumeric Convert dates to numeric values as indicated by

the rule listed in “Rules for Data Conversion
Between .NET and MATLAB” (MATLAB Compiler
SDK).

mwDateFormatString Convert input dates to strings.

PropertyOutputAsDate As Boolean

This property processes an output argument as a date. By default, numeric dates that are output
parameters from compiled MATLAB functions are passed as Doubles that need to be decremented by
the COM date bias (693960) as well as coerced to COM dates. Set this flag to True to convert all
output values of type Double.

ReplaceMissing As mwReplaceMissingData

This property is an enumeration and can have two possible values: mwReplaceNaN and
mwReplaceZero.

To treat empty cells referenced by input parameters as zeros, set the value to mwReplaceZero. To
treat empty cells referenced by input parameters as NaNs (Not a Number), set the value to
mwReplaceNaN.

By default, the value is mwReplaceZero.

Sub Clone(ppFlags As MWFlags)
Creates a copy of an MWFlags object.
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Parameters

Argument Type Description
ppFlags MWFlags Reference to an uninitialized

MWFlags object that receives
the copy

Return Value

None

Remarks

Clone allocates a new MWFlags object and creates a deep copy of the object's contents. Call this
function when a separate object is required instead of a shared copy of an existing object reference.
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Class MWStruct
The MWStruct class passes or receives a Struct type to or from a compiled class method. This class
contains seven properties/methods:

Sub Initialize([varDims], [varFieldNames])
This method allocates a structure array with a specified number and size of dimensions and a
specified list of field names.

Parameters

Argument Type Description
varDims Variant Optional array of dimensions
varFieldNames Variant Optional array of field names

Return Value

None.

Remarks

When created, an MWStruct object has a dimensionality of 1-by-1 and no fields. The Initialize
method dimensions the array and adds a set of named fields to each element. Each time you call
Initialize on the same object, it is redimensioned. If you do not supply the varDims argument,
the existing number and size of the array's dimensions unchanged. If you do not supply the
varFieldNames argument, the existing list of fields is not changed. Calling Initialize with no
arguments leaves the array unchanged.

Example

The following Visual Basic code illustrates use of the Initialize method to dimension struct arrays.

Sub foo ()
    Dim x As MWStruct
    Dim y As MWStruct

    On Error Goto Handle_Error
    'Create 1X1 struct arrays with no fields for x, and y
    Set x = new MWStruct
    Set y = new MWStruct

    'Initialize x to be 2X2 with fields "red", "green", 
    '                                          and "blue"
    Call x.Initialize(Array(2,2), Array("red", "green", "blue"))
    'Initialize y to be 1X5 with fields "name" and "age"
    Call y.Initialize(5, Array("name", "age"))

    'Re-dimension x to be 3X3 with the same field names
    Call x.Initialize(Array(3,3))

    'Add a new field to y
    Call y.Initialize(, Array("name", "age", "salary"))
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    Exit Sub
Handle_Error:
    MsgBox(Err.Description)
End Sub

Property Item([i0], [i1], ..., [i31]) As MWField
The Item property is the default property of the MWStruct class. This property is used to set/get the
value of a field at a particular index in the structure array.

Parameters

Argument Type Description
i0,i1, ..., i31 Variant Optional index arguments.

Between 0 and 32 index
arguments can be entered. To
reference an element of the
array, specify all indexes as well
as the field name.

Remarks

When accessing a named field through this property, you must supply all dimensions of the requested
field as well as the field name. This property always returns a single field value, and generates a bad
index error if you provide an invalid or incomplete index list. Index arguments have four basic
formats:

• Field name only

This format may be used only in the case of a 1-by-1 structure array and returns the named field's
value. For example:

x("red") = 0.2
x("green") = 0.4
x("blue") = 0.6

In this example, the name of the Item property was neglected. This is possible because the Item
property is the default property of the MWStruct class. In this case, the two statements are
equivalent:

x.Item("red") = 0.2
x("red") = 0.2

• Single index and field name

This format accesses array elements through a single subscripting notation. A single numeric index n
followed by the field name returns the named field on the nth array element, navigating the array
linearly in column-major order. For example, consider a 2-by-2 array of structures with fields "red",
"green" , and "blue" stored in a variable x. These two statements are equivalent:

y = x(2, "red")
y = x(2, 1, "red")

• All indices and field name
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This format accesses an array element of an multidimensional array by specifying n indices. These
statements access all four of the elements of the array in the previous example:

For I From 1 To 2
       For J From 1 To 2
              r(I, J) = x(I, J, "red")
              g(I, J) = x(I, J, "green")
              b(I, J) = x(I, J, "blue")
       Next
Next

• Array of indices and field name

This format accesses an array element by passing an array of indices and a field name. The next
example rewrites the previous example using an index array:

Dim Index(1 To 2) As Integer

For I From 1 To 2
       Index(1) = I
       For J From 1 To 2
              Index(2) = J
              r(I, J) = x(Index, "red")
              g(I, J) = x(Index, "green")
              b(I, J) = x(Index, "blue")
       Next
Next

With these four formats, the Item property provides a very flexible indexing mechanism for structure
arrays.

• You can combine the last two indexing formats. Several index arguments supplied in either scalar
or array format are concatenated to form one index set. The combining stops when the number of
dimensions has been reached. For example:

Dim Index1(1 To 2) As Integer
Dim Index2(1 To 2) As Integer

Index1(1) = 1
Index1(2) = 1
Index2(1) = 3
Index2(2) = 2
x(Index1, Index2, 2, "red") = 0.5

The last statement resolves to

x(1, 1, 3, 2, 2, "red") = 0.5

• The field name must be the last index in the list. The following statement produces an error:

y = x("blue", 1, 2)

• Field names are case sensitive.

Property NumberOfFields As Long
The read-only NumberOfFields property returns the number of fields in the structure array.
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Property NumberOfDims As Long
The read-only NumberOfDims property returns the number of dimensions in the struct array.

Property Dims As Variant
The read-only Dims property returns an array of length NumberOfDims that contains the size of each
dimension of the struct array.

Property FieldNames As Variant
The read-only FieldNames property returns an array of length NumberOfFields that contains the
field names of the elements of the structure array.

Example

The next Visual Basic code sample illustrates how to access a two-dimensional structure array's fields
when the field names and dimension sizes are not known in advance.

Sub foo ()
      Dim x As MWStruct
      Dim Dims as Variant
      Dim FieldNames As Variant
    

      On Error Goto Handle_Error
      '
      '... Call a method that returns an MWStruct in x
      '
      Dims = x.Dims
      FieldNames = x.FieldNames
      For I From 1 To Dims(1)
            For J From 1 To Dims(2)
                  For K From 1 To x.NumberOfFields
                        y = x(I,J,FieldNames(K))
                        ' ... Do something with y
                  Next
            Next
      Next
Exit Sub
Handle_Error:
      MsgBox(Err.Description)
End Sub

Sub Clone(ppStruct As MWStruct)
Creates a copy of an MWStruct object.
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Parameters

Argument Type Description
ppStruct MWStruct Reference to an uninitialized

MWStruct object to receive the
copy

Return Value

None

Remarks

Clone allocates a new MWStruct object and creates a deep copy of the object's contents. Call this
function when a separate object is required instead of a shared copy of an existing object reference.

Example

The following Visual Basic example illustrates the difference between assignment and Clone for
MWStruct objects.

Sub foo ()
    Dim x1 As MWStruct
    Dim x2 As MWStruct
    Dim x3 As MWStruct

    On Error Goto Handle_Error
    Set x1 = new MWStruct
    x1("name") = "John Smith"
    x1("age") = 35
    
   'Set reference of x1 to x2
    Set x2 = x1 
   'Create new object for x3 and copy contents of x1 into it
    Call x1.Clone(x3) 
   'x2's "age" field is 
   'also modified 'x3's "age" field unchanged
    x1("age") = 50 
        .
        .
        .
    Exit Sub
Handle_Error:
    MsgBox(Err.Description)
End Sub
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Class MWField
The MWField class holds a single field reference in an MWStruct object. This class is not creatable
and contains four properties/methods:

Property Name As String
The name of the field (read only).

Property Value As Variant
Stores the field's value (read/write). The Value property is the default property of the MWField class.
The value of a field can be any type that is coercible to a Variant, as well as object types.

Property MWFlags As MWFlags
Stores a reference to an MWFlags object. This property sets or gets the array formatting and data
conversion flags for a particular field. Each field in a structure has its own MWFlags property. This
property overrides the value of any flags set on the object whose methods are called.

Sub Clone(ppField As MWField)
Creates a copy of an MWField object.

Parameters

Argument Type Description
ppField MWField Reference to an uninitialized

MWField object to receive the
copy

Return Value

None.

Remarks

Clone allocates a new MWField object and creates a deep copy of the object's contents. Call this
function when a separate object is required instead of a shared copy of an existing object reference.
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Class MWComplex
The MWComplex class passes or receives a complex numeric array into or from a compiled class
method. This class contains four properties/methods:

Property Real As Variant
Stores the real part of a complex array (read/write). The Real property is the default property of the
MWComplex class. The value of this property can be any type coercible to a Variant, as well as
object types, with the restriction that the underlying array must resolve to a numeric matrix (no cell
data allowed). Valid Visual Basic numeric types for complex arrays include Byte, Integer, Long,
Single, Double, Currency, and Variant/vbDecimal.

Property Imag As Variant
Stores the imaginary part of a complex array (read/write). The Imag property is optional and can be
Empty for a pure real array. If the Imag property is not empty and the size and type of the underlying
array do not match the size and type of the Real property's array, an error results when the object is
used in a method call.

Example

The following Visual Basic code creates a complex array with the following entries:

    x = [ 1+i 1+2i
          2+i 2+2i ]
Sub foo()
    Dim x As MWComplex
    Dim rval(1 To 2, 1 To 2) As Double
    Dim ival(1 To 2, 1 To 2) As Double

    On Error Goto Handle_Error
    For I = 1 To 2
        For J = 1 To 2
                rval(I,J) = I
                ival(I,J) = J
        Next
    Next
    Set x = new MWComplex
    x.Real = rval
    x.Imag = ival
        .
        .
        .
    Exit Sub
Handle_Error:
    MsgBox(Err.Description)
End Sub

Property MWFlags As MWFlags
Stores a reference to an MWFlags object. This property sets or gets the array formatting and data
conversion flags for a particular complex array. Each MWComplex object has its own MWFlags
property. This property overrides the value of any flags set on the object whose methods are called.
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Sub Clone(ppComplex As MWComplex)
Creates a copy of an MWComplex object.

Parameters

Argument Type Description
ppComplex MWComplex Reference to an uninitialized

MWComplex object to receive
the copy

Return Value

None

Remarks

Clone allocates a new MWComplex object and creates a deep copy of the object's contents. Call this
function when a separate object is required instead of a shared copy of an existing object reference.
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Class MWSparse
The MWSparse class passes or receives a two-dimensional sparse numeric array into or from a
compiled class method. This class has seven properties/methods:

Property NumRows As Long
Stores the row dimension for the array. The value of NumRows must be nonnegative. If the value is
zero, the row index is taken from the maximum of the values in the RowIndex array.

Property NumColumns As Long
Stores the column dimension for the array. The value of NumColumns must be nonnegative. If the
value is zero, the row index is taken from the maximum of the values in the ColumnIndex array.

Property RowIndex As Variant
Stores the array of row indices of the nonzero elements of the array. The value of this property can be
any type coercible to a Variant, as well as object types, with the restriction that the underlying
array must resolve to or be coercible to a numeric matrix of type Long. If the value of NumRows is
nonzero and any row index is greater than NumRows, a bad-index error occurs. An error also results if
the number of elements in the RowIndex array does not match the number of elements in the Array
property's underlying array.

Property ColumnIndex As Variant
Stores the array of column indices of the nonzero elements of the array. The value of this property
can be any type coercible to a Variant, as well as object types, with the restriction that the
underlying array must resolve to or be coercible to a numeric matrix of type Long. If the value of
NumColumns is nonzero and any column index is greater than NumColumns, a bad-index error occurs.
An error also results if the number of elements in the ColumnIndex array does not match the
number of elements in the Array property's underlying array.

Property Array As Variant
Stores the nonzero array values of the sparse array. The value of this property can be any type
coercible to a Variant, as well as object types, with the restriction that the underlying array must
resolve to or be coercible to a numeric matrix of type Double or Boolean.

Property MWFlags As MWFlags
Stores a reference to an MWFlags object. This property sets or gets the array formatting and data
conversion flags for a particular sparse array. Each MWSparse object has its own MWFlags property.
This property overrides the value of any flags set on the object whose methods are called.

Sub Clone(ppSparse As MWSparse)
Creates a copy of an MWSparse object.
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Parameters

Argument Type Description
ppSparse MWSparse Reference to an uninitialized

MWSparse object to receive the
copy

Return Value

None.

Remarks

Clone allocates a new MWSparse object and creates a deep copy of the object's contents. Call this
function when a separate object is required instead of a shared copy of an existing object reference.

Example

The following Visual Basic sample creates a 5-by-5 tridiagonal sparse array.

X = [ 2 -1  0   0   0
     -1  2 -1   0   0
      0 -1  2  -1   0
      0  0 -1   2  -1
      0  0  0  -1   2 ]

Sub foo()
    Dim x As MWSparse
    Dim rows(1 To 13) As Long
    Dim cols(1 To 13) As Long
    Dim vals(1 To 13) As Double
    Dim I As Long, K As Long

    On Error GoTo Handle_Error
    K = 1
    For I = 1 To 4
        rows(K) = I
        cols(K) = I + 1
        vals(K) = -1
        K = K + 1
        rows(K) = I
        cols(K) = I
        vals(K) = 2
        K = K + 1
        rows(K) = I + 1
        cols(K) = I
        vals(K) = -1
        K = K + 1
    Next
    rows(K) = 5
    cols(K) = 5
    vals(K) = 2
    Set x = New MWSparse
    x.NumRows = 5
    x.NumColumns = 5
    x.RowIndex = rows
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    x.ColumnIndex = cols
    x.Array = vals
        .
        .
        .
    Exit Sub
Handle_Error:
    MsgBox (Err.Description)
End Sub
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Class MWArg
The MWArg class passes a generic argument into a compiled class method. This class passes an
argument for which the data conversion flags are changed for that one argument. This class has three
properties/methods:

Property Value As Variant
The Value property stores the actual argument to pass. Any type that can be passed to a compiled
method is valid for this property.

Property MWFlags As MWFlags
Stores a reference to an MWFlags object. This property sets or gets the array formatting and data
conversion flags for a particular argument. Each MWArg object has its own MWFlags property. This
property overrides the value of any flags set on the object whose methods are called.

Sub Clone(ppArg As MWArg)
Creates a copy of an MWArg object.

Parameters

Argument Type Description
ppArg MWArg Reference to an uninitialized

MWArg object to receive the
copy

Return Value

None.

Remarks

Clone allocates a new MWArg object and creates a deep copy of the object's contents. Call this
function when a separate object is required instead of a shared copy of an existing object reference.
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Enum mwArrayFormat
The mwArrayFormat enumeration is a set of constants that denote an array formatting rule for data
conversion.

mwArrayFormat Values

Constant Numeric Value Description
mwArrayFormatAsIs 0 Do not reformat the array.
mwArrayFormatMatrix 1 Format the array as a matrix.
mwArrayFormatCell 2 Format the array as a cell array.
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Enum mwDataType
The mwDataType enumeration is a set of constants that denote a MATLAB numeric type.

mwDataType Values

Constant Numeric Value MATLAB Type
mwTypeDefault 0 Not applicable
mwTypeLogical 3 logical
mwTypeChar 4 char
mwTypeDouble 6 double
mwTypeSingle 7 single
mwTypeInt8 8 int8
mwTypeUint8 9 uint8
mwTypeInt16 10 int16
mwTypeUint16 11 uint16
mwTypeInt32 12 int32
mwTypeUint32 13 uint32
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Enum mwDateFormat
The mwDateFormat enumeration is a set of constants that denote a formatting rule for dates.

mwDateFormat Values

Constant Numeric Value Description
mwDateFormatNumeric 0 Format dates as numeric values
mwDateFormatString 1 Format dates as strings

 Enum mwDateFormat
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Library Compiler
Package MATLAB programs for deployment as shared libraries and components

Description
The Library Compiler app packages MATLAB functions to include MATLAB functionality in
applications written in other languages.

Open the Library Compiler App
• MATLAB Toolstrip: On the Apps tab, under Application Deployment, click the app icon.
• MATLAB command prompt: Enter libraryCompiler.
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Examples
• “Create Excel Add-In from MATLAB” on page 2-5
• “Create a C Shared Library with MATLAB Code” (MATLAB Compiler SDK)
• “Generate a C++ mwArray API Shared Library and Build a C++ Application” (MATLAB

Compiler SDK)
• “Generate a C++ MATLAB Data API Shared Library and Build a C++ Application” (MATLAB

Compiler SDK)
• “Generate .NET Assembly and Build .NET Application” (MATLAB Compiler SDK)
• “Create a Generic COM Component with MATLAB Code” (MATLAB Compiler SDK)
• “Generate Java Package and Build Java Application” (MATLAB Compiler SDK)
• “Generate a Python Package and Build a Python Application” (MATLAB Compiler SDK)

Parameters
type — type of library generated
C Shared Library | C++ Shared Library | Excel Add-in | Generic COM Component | Java Package
| .NET Assembly | Python Package

Type of library to generate.

exported functions — functions to package
list of character vectors

Functions to package as a list of character vectors.

packaging options — method for installing the MATLAB Runtime with the compiled library
MATLAB Runtime downloaded from web (default) | MATLAB Runtime included in package

You can decide whether or not to include the MATLAB Runtime fallback for MATLAB Runtime
installer in the generated application by selecting one of the two options in the Packaging Options
section. Including the MATLAB Runtime installer in the package significantly increases the size of the
package.

Runtime downloaded from web — Generates an installer that downloads the MATLAB Runtime and
installs it along with the deployed MATLAB application.

Runtime included in package — Generates an installer that includes the MATLAB Runtime installer.

The first time you select this option, you are prompted to download the MATLAB Runtime installer or
obtain a CD if you do not have internet access.

files required for your library to run — files that must be included with library
list of files

Files that must be included with library as a list of files.

files installed for your end user — optional files installed with library
list of files

Optional files installed with library as a list of files.
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Settings

Additional parameters passed to MCC — flags controlling the behavior of the compiler
character vector

Flags controlling the behavior of the compiler as a character vector.

testing files — folder where files for testing are stored
character vector

Folder where files for testing are stored as a character vector.

end user files — folder where files for building a custom installer are stored
character vector

Folder where files for building a custom installer are stored are stored as a character vector.

packaged installers — folder where generated installers are stored
character vector

Folder where generated installers are stored as a character vector.

Library Information

library name — name of the installed library
character vector

Name of the installed library as a character vector.

The default value is the name of the first function listed in the Exported Functions field of the app.

version — version of the generated library
character vector

Version of the generated library as a character vector.

splash screen — image displayed on installer
image

Image displayed on installer as an image.

author name — name of the library author
character vector

Name of the library author as a character vector.

e-mail — e-mail address used to contact library support
character vector

E-mail address used to contact library support as a character vector.

summary — brief description of library
character vector

Brief description of library as a character vector.
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description — detailed description of library
character vector

Detailed description of library as a character vector.

Additional Installer Options

default installation folder — folder where artifacts are installed
character vector

Folder where artifacts are installed as a character vector.

installation notes — notes about additional requirements for using artifacts
character vector

Notes about additional requirements for using artifacts as a character vector.

Programmatic Use
libraryCompiler

Version History
Introduced in R2013b

See Also
Topics
“Create Excel Add-In from MATLAB” on page 2-5
“Create a C Shared Library with MATLAB Code” (MATLAB Compiler SDK)
“Generate a C++ mwArray API Shared Library and Build a C++ Application” (MATLAB Compiler
SDK)
“Generate a C++ MATLAB Data API Shared Library and Build a C++ Application” (MATLAB
Compiler SDK)
“Generate .NET Assembly and Build .NET Application” (MATLAB Compiler SDK)
“Create a Generic COM Component with MATLAB Code” (MATLAB Compiler SDK)
“Generate Java Package and Build Java Application” (MATLAB Compiler SDK)
“Generate a Python Package and Build a Python Application” (MATLAB Compiler SDK)

 Library Compiler

10-5





Data Conversion

A



Data Conversion Rules
This topic describes the data conversion rules for the MATLAB Compiler components. These
components are dual interface Microsoft COM objects that support data types compatible with
Automation.

Note Automation (formerly called OLE Automation) is a technology that allows software packages to
expose their unique features to scripting tools and other applications. Automation uses the
Component Object Model (COM), but may be implemented independently from other OLE features,
such as in-place activation.

When a method is invoked on a MATLAB Compiler component, the input parameters are converted to
the MATLAB internal array format and passed to the compiled MATLAB function. When the function
exits, the output parameters are converted from the MATLAB internal array format to
COM Automation types.

The COM client passes all input and output arguments in the compiled MATLAB functions as type
VARIANT. The COM VARIANT type is a union of several simple data types. A type VARIANT variable
can store a variable of any of the simple types, as well as arrays of any of these values.

The Win32 application program interface (API) provides many functions for creating and
manipulating VARIANTs in C/C++, and Visual Basic provides native language support for this type.

Note This discussion of data refers to both VARIANT and Variant data types. VARIANT is the C++
name and Variant is the corresponding data type in Visual Basic.

See the Visual Studio® documentation for definitions and API support for COM VARIANTs. VARIANT
variables are self describing and store their type code as an internal field of the structure.

The following table lists the VARIANT type codes supported by MATLAB Compiler components.
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VARIANT Type Codes Supported

VARIANT Type Code
(C/C++)

C/C++ Type Variant Type
Code
(Visual Basic)

Visual
BasicType

Definition

VT_EMPTY — vbEmpty — Uninitialized VARIANT
VT_I1 char — — Signed one-byte

character
VT_UI1 unsigned char vbByte Byte Unsigned one-byte

character
VT_I2 short vbInteger Integer Signed two-byte integer
VT_UI2 unsigned short — — Unsigned two-byte

integer
VT_I4 long vbLong Long Signed four-byte integer
VT_UI4 unsigned long — — Unsigned four-byte

integer
VT_R4 float vbSingle Single IEEE® four-byte floating-

point value
VT_R8 double vbDouble Double IEEE eight-byte floating-

point value
VT_CY CY+ vbCurrency Currency Currency value (64-bit

integer, scaled by 10,000)
VT_BSTR BSTR+ vbString String String value
VT_ERROR SCODE+ vbError — An HRESULT (signed four-

byte integer representing
a COM error code)

VT_DATE DATE+ vbDate Date Eight-byte floating point
value representing date
and time

VT_INT int — — Signed integer;
equivalent to type int

VT_UINT unsigned int — — Unsigned integer;
equivalent to type
unsigned int

VT_DECIMAL DECIMAL+ vbDecimal — 96-bit (12-byte) unsigned
integer, scaled by a
variable power of 10

VT_BOOL VARIANT_BOOL+ vbBoolean Boolean Two-byte Boolean value
(0xFFFF = True; 0x0000
= False)

VT_DISPATCH IDispatch* vbObject Object IDispatch* pointer to
an object
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VARIANT Type Code
(C/C++)

C/C++ Type Variant Type
Code
(Visual Basic)

Visual
BasicType

Definition

VT_VARIANT VARIANT+ vbVariant Variant VARIANT (can only be
specified if combined
with VT_BYREF or
VT_ARRAY)

<anything>|VT_ARRAY — — — Bitwise combine
VT_ARRAY with any basic
type to declare as an
array

<anything>|VT_BYREF — — — Bitwise combine
VT_BYREF with any basic
type to declare as a
reference to a value

+ Denotes Windows-specific type. Not part of standard C/C++.

The following table lists the rules for converting from MATLAB to COM.
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MATLAB to COM VARIANT Conversion Rules

MATLAB Data Type VARIANT Type for Scalar
Data

VARIANT Type for Array
Data

Comments

cell A 1-by-1 cell array converts
to a single VARIANT with a
type conforming to the
conversion rule for the
MATLAB data type of the
cell contents.

A multidimensional cell
array converts to a
VARIANT of type
VT_VARIANT|VT_ARRAY
with the type of each array
member conforming to the
conversion rule for the
MATLAB data type of the
corresponding cell.

structure VT_DISPATCH VT_DISPATCH A MATLAB struct array is
converted to an MWStruct
object. (See “Class
MWStruct” (MATLAB
Compiler SDK)) This object
is passed as a
VT_DISPATCH type.

char A 1-by-1 char matrix
converts to a VARIANT of
type VT_BSTR with string
length = 1.

A 1-by-L char matrix is
assumed to represent a
character vector of length L
in MATLAB. This case
converts to a VARIANT of
type VT_BSTR with a string
length = L. char matrices
of more than one row, or of
a higher dimensionality
convert to a VARIANT of
type VT_BSTR|VT_ARRAY.
Each string in the converted
array is of length 1 and
corresponds to each
character in the original
matrix.

Arrays of character vectors
are not supported as char
matrices. To pass an array
of character vectors, use a
cell array of 1-by-L char
matrices.

sparse VT_DISPATCH VT_DISPATCH A MATLAB sparse array is
converted to an MWSparse
object. (See “Class
MWSparse” (MATLAB
Compiler SDK)) This object
is passed as a
VT_DISPATCH type.
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MATLAB Data Type VARIANT Type for Scalar
Data

VARIANT Type for Array
Data

Comments

double A real 1-by-1 double matrix
converts to a VARIANT of
type VT_R8. A complex 1-
by-1 double matrix converts
to a VARIANT of type
VT_DISPATCH.

A real multidimensional
double matrix converts to a
VARIANT of type VT_R8|
VT_ARRAY. A complex
multidimensional double
matrix converts to a
VARIANT of type
VT_DISPATCH.

Complex arrays are passed
to and from compiled
MATLAB functions using the
MWComplex class. (See
“Class MWComplex” on
page 9-21)

single A real 1-by-1 single matrix
converts to a VARIANT of
type VT_R4. A complex 1-
by-1 single matrix converts
to a VARIANT of type
VT_DISPATCH.

A real multidimensional
single matrix converts to a
VARIANT of type VT_R4|
VT_ARRAY. A complex
multidimensional single
matrix converts to a
VARIANT of type
VT_DISPATCH.

Complex arrays are passed
to and from compiled
MATLAB functions using the
MWComplex class. (See
“Class MWComplex” on
page 9-21)

int8 A real 1-by-1 int8 matrix
converts to a VARIANT of
type VT_I1. A complex 1-
by-1 int8 matrix converts
to a VARIANT of type
VT_DISPATCH.

A real multidimensional
int8 matrix converts to a
VARIANT of type VT_I1|
VT_ARRAY. A complex
multidimensional int8
matrix converts to a
VARIANT of type
VT_DISPATCH.

Complex arrays are passed
to and from compiled
MATLAB functions using the
MWComplex class. (See
“Class MWComplex” on
page 9-21)

uint8 A real 1-by-1 uint8 matrix
converts to a VARIANT of
type VT_UI1. A complex 1-
by-1 uint8 matrix converts
to a VARIANT of type
VT_DISPATCH.

A real multidimensional
uint8 matrix converts to a
VARIANT of type VT_UI1|
VT_ARRAY.A complex
multidimensional uint8
matrix converts to a
VARIANT of type
VT_DISPATCH.

Complex arrays are passed
to and from compiled
MATLAB functions using the
MWComplex class. (See
“Class MWComplex” on
page 9-21)

int16 A real 1-by-1 int16 matrix
converts to a VARIANT of
type VT_I2. A complex 1-
by-1 int16 matrix converts
to a VARIANT of type
VT_DISPATCH.

A real multidimensional
int16 matrix converts to a
VARIANT of type VT_I2|
VT_ARRAY. A complex
multidimensional int16
matrix converts to a
VARIANT of type
VT_DISPATCH.

Complex arrays are passed
to and from compiled
MATLAB functions using the
MWComplex class. (See
“Class MWComplex” on
page 9-21)
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MATLAB Data Type VARIANT Type for Scalar
Data

VARIANT Type for Array
Data

Comments

uint16 A real 1-by-1 uint16 matrix
converts to a VARIANT of
type VT_UI2. A complex 1-
by-1 uint16 matrix
converts to a VARIANT of
type VT_DISPATCH.

A real multidimensional
uint16 matrix converts to a
VARIANT of type VT_UI2|
VT_ARRAY. A complex
multidimensional uint16
matrix converts to a
VARIANT of type
VT_DISPATCH.

Complex arrays are passed
to and from compiled
MATLAB functions using the
MWComplex class. (See
“Class MWComplex” on
page 9-21)

int32 A 1-by-1 int32 matrix
converts to a VARIANT of
type VT_I4. A complex 1-
by-1 int32 matrix converts
to a VARIANT of type
VT_DISPATCH.

A multidimensional int32
matrix converts to a
VARIANT of type VT_I4|
VT_ARRAY. A complex
multidimensional int32
matrix converts to a
VARIANT of type
VT_DISPATCH.

Complex arrays are passed
to and from compiled
MATLAB functions using the
MWComplex class. (See
“Class MWComplex” on
page 9-21)

uint32 A 1-by-1 uint32 matrix
converts to a VARIANT of
type VT_UI4. A complex 1-
by-1 uint32 matrix
converts to a VARIANT of
type VT_DISPATCH.

A multidimensional uint32
matrix converts to a
VARIANT of type VT_UI4|
VT_ARRAY. A complex
multidimensional uint32
matrix converts to a
VARIANT of type
VT_DISPATCH.

Complex arrays are passed
to and from compiled
MATLAB functions using the
MWComplex class. (See
“Class MWComplex” on
page 9-21)

Function handle VT_EMPTY VT_EMPTY Not supported
Java class VT_EMPTY VT_EMPTY Not supported
User class VT_EMPTY VT_EMPTY Not supported
logical VT_Bool VT_Bool|VT_ARRAY  

The following table lists the rules for conversion from COM to MATLAB.
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COM VARIANT to MATLAB Conversion Rules

VARIANT Type MATLAB Data Type
(scalar or array data)

Comments

VT_EMPTY Not applicable Empty array created.
VT_I1 int8  
VT_UI1 uint8  
VT_I2 int16  
VT_UI2 uint16  
VT_I4 int32  
VT_UI4 uint32  
VT_R4 single  
VT_R8 double  
VT_CY double  
VT_BSTR char A VARIANT of type VT_BSTR converts to a 1-by-L

MATLAB char array, where L = the length of the
character vector to be converted. A VARIANT of
type VT_BSTR|VT_ARRAY converts to a MATLAB
cell array of 1-by-L char arrays.

VT_ERROR int32  
VT_DATE double 1. VARIANT dates are stored as doubles starting at

midnight Dec. 31, 1899. The MATLAB dates are
stored as doubles starting at 0/0/00 00:00:00.
Therefore, a VARIANT date of 0.0 maps to a
MATLAB numeric date of 693960.0. VARIANT
dates are converted to MATLAB double types and
incremented by 693960.0.
2. VARIANT dates can be optionally converted to
character vectors. See “Data Conversion Flags” on
page A-12 for more information on type coercion.

VT_INT int32  
VT_UINT uint32  
VT_DECIMAL double  
VT_BOOL logical  
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VARIANT Type MATLAB Data Type
(scalar or array data)

Comments

VT_DISPATCH (varies) IDispatch* pointers are treated within the
context of what they point to. Objects must be
supported types with known data extraction and
conversion rules, or expose a generic Value
property that points to a single VARIANT type.
Data extracted from an object is converted based
upon the rules for the particular VARIANT
obtained.

Currently, support exists for Excel Range objects
as well as the MATLAB Compiler types MWStruct,
MWComplex, MWSparse, and MWArg.

<anything>|VT_BYREF (varies) Pointers to any of the basic types are processed
according to the rules for what they point to. The
resulting MATLAB array contains a deep copy of
the values.

<anything>|VT_ARRAY (varies) Multidimensional VARIANT arrays convert to
multidimensional MATLAB arrays, each element
converted according to the rules for the basic
types. Multidimensional VARIANT arrays of type
VT_VARIANT|VT_ARRAY convert to
multidimensional cell arrays, each cell converted
according to the rules for that specific type.
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Array Formatting Flags
The MATLAB Compiler components have flags that control how array data is formatted in both
directions. Generally, you should develop client code that matches the intended inputs and outputs of
the MATLAB functions with the corresponding methods on the compiled COM objects, in accordance
with the rules listed in MATLAB to COM VARIANT Conversion Rules and COM VARIANT to MATLAB
Conversion Rules. In some cases this is not possible, for example, when existing MATLAB code is
used in conjunction with a third-party product like Excel.

The following table shows the array formatting flags.

A Array Formatting Flags
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Array Formatting Flags

Flag Description
InputArrayFormat Defines the array formatting rule used on input arrays.

An input array is a VARIANT array, created by the client, sent as
an input parameter to a method call on a compiled COM object.
Valid values for this flag are mwArrayFormatAsIs,
mwArrayFormatMatrix, and mwArrayFormatCell.

mwArrayFormatAsIs passes the array unchanged.

mwArrayFormatMatrix (default) formats all arrays as matrices.
When the input VARIANT is of type VT_ARRAY| type, where type
is any numeric type, this flag has no effect. When the input
VARIANT is of type VT_VARIANT|VT_ARRAY, VARIANTs in the
array are examined. If they are single-valued and homogeneous in
type, a MATLAB matrix of the appropriate type is produced
instead of a cell array.

mwArrayFormatCell interprets all arrays as MATLAB cell
arrays.

InputArrayIndFlag Sets the input array indirection level used with the
InputArrayFormat flag (applicable only to nested arrays, i.e.,
VARIANT arrays of VARIANTs, which themselves are arrays). The
default value for this flag is zero, which applies the
InputArrayFormat flag to the outermost array. When this flag is
greater than zero, e.g., equal to N, the formatting rule attempts to
apply itself to the Nth level of nesting.

OutputArrayFormat Defines the array formatting rule used on output arrays. An
output array is a MATLAB array, created by the compiled COM
object, sent as an output parameter from a method call to the
client. The values for this flag, mwArrayFormatAsIs,
mwArrayFormatMatrix, and mwArrayFormatCell, cause the
same behavior as the corresponding InputArrayFormat flag
values.

OutputArrayIndFlag (Applies to nested cell arrays only.) Output array indirection level
used with the OutputArrayFormat flag. This flag works exactly
like InputArrayIndFlag.

AutoResizeOutput (Applies to Excel ranges only.) When the target output from a
method call is a range of cells in an Excel worksheet and the
output array size and shape is not known at the time of the call,
set this flag to True to resize each Excel range to fit the output
array.

TransposeOutput Set this flag to True to transpose the output arguments. Useful
when calling a MATLAB Compiler component from Excel where
the MATLAB function returns outputs as row vectors, and you
want the data in columns.
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Data Conversion Flags
In this section...
“CoerceNumericToType” on page A-12
“InputDateFormat” on page A-13
“OutputAsDate As Boolean” on page A-13
“DateBias As Long” on page A-13

CoerceNumericToType
This flag tells the data converter to convert all numeric VARIANT data to one specific MATLAB type.

VARIANT type codes affected by this flag are

VT_I1

VT_UI1

VT_I2

VT_UI2

VT_I4

VT_UI4

VT_R4

VT_R8

VT_CY

VT_DECIMAL

VT_INT

VT_UINT

VT_ERROR

VT_BOOL

VT_DATE

Valid values for this flag are

mwTypeDefault

mwTypeChar

mwTypeDouble

mwTypeSingle
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mwTypeLogical

mwTypeInt8

mwTypeUint8

mwTypeInt16

mwTypeUint16

mwTypeInt32

mwTypeUint32

The default for this flag, mwTypeDefault, converts numeric data according to the rules listed in
“Data Conversion Rules” on page A-2.

InputDateFormat
This flag tells the data converter how to convert VARIANT dates to the MATLAB dates. Valid values
for this flag are mwDateFormatNumeric (default) and mwDateFormatString. The default converts
VARIANT dates according to the rule listed in VARIANT Type Codes Supported. The
mwDateFormatString flag converts a VARIANT date to its character vector representation. This flag
only affects VARIANT type code VT_DATE.

OutputAsDate As Boolean
This flag instructs the data converter to process an output argument as a date. By default, numeric
dates that are output parameters from compiled MATLAB functions are passed as Doubles that need
to be decremented by the COM date bias (693960) as well as coerced to COM dates. Set this flag to
True to convert all output values of type Double.

DateBias As Long
This flag sets the date bias for performing COM to the MATLAB numeric date conversions. The
default value of this property is 693960, which represents the difference between the COM Date type
and the MATLAB numeric dates. This flag allows existing MATLAB code that already performs the
increment of numeric dates by 693960 to be used unchanged with the MATLAB Compiler
components. To process dates with such code, set this property to 0.
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Troubleshooting

B



Errors and Solutions
In this section...
“Excel Add-Ins Errors and Suggested Solutions” on page B-3
“Required Locations to Develop and Use Components” on page B-5
“Microsoft Excel Errors and Suggested Solutions” on page B-5
“Function Wizard Problems” on page B-6

View errors you may encounter using MATLAB Compiler, probable causes for these errors, and
suggested solutions.
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Excel Add-Ins Errors and Suggested Solutions
Errors, Warnings, Cause and Suggested Solutions

Message Probable Cause Suggested Solution
MBUILD.BAT: Error: The
chosen compiler does not
support building COM
objects.

The chosen compiler does
not support building COM
objects.

Rerun mbuild -setup -client
mbuild_com and choose a supported
compiler.

Error in
component_name.class_name:
Error getting data
conversion flags.

Usually caused by
mwcomutil.dll not being
registered.

Open a DOS window, change folders to
matlabroot\bin\win64 (matlabroot
represents the location of MATLAB on your
system), and run the command
mwregsvr mwcomutil.dll.

See “Register Add-Ins and COM
Components” on page 2-12 for full details.

Error in VBAProject:
ActiveX component can't
create object.

• Project DLL is not
registered.

• An incompatible MATLAB
DLL exists somewhere on
the system path.

If the DLL is not registered, open a DOS
window, change folders to <projectdir>
\distrib (<projectdir> represents the
location of your project files), and run the
command:
mwregsvr <projectdll>.dll.

See “Register Add-Ins and COM
Components” on page 2-12 for full details.

Error in VBAProject:
Automation error The
specified module could not
be found.

This usually occurs if
MATLAB is not on the system
path. This error message
occurs if you have more than
one version of MATLAB on
your system path.

Anytime you have multiple versions of
MATLAB, ensure that the newest version
of MATLAB appears on your path first. You
can verify that the newest version of
MATLAB is on the path first by typing
path at the DOS prompt. See the table
“Required Locations to Develop and Use
Components” on page B-5.

LoadLibrary
("component_name.dll")
failed - The specified
module could not be found.

You may get this error
message while registering
the project DLL from the
DOS prompt. This usually
occurs if MATLAB is not on
the system path.

See the table “Required Locations to
Develop and Use Components” on page B-
5.

Cannot recompile the M file
xxxx because it is already
in the library
libmmfile.mlib.

The name you have chosen
for your MATLAB file
duplicates the name of a
MATLAB file already in the
library of precompiled
MATLAB files.

Rename the MATLAB file, choosing a name
that does not duplicate the name of a
MATLAB file already in the library of
precompiled MATLAB files.
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Message Probable Cause Suggested Solution
Arguments may only be
defaulted at the end of an
argument list.

You have modified the VB
script generated for MATLAB
Compiler and have not
provided one or more
arguments used in the
modified script.

Provide a value for any argument that
requires an explicit value. Arguments that
accept defaults appear at the end of the
argument list.

Unable to use accessibility screen-
readers or assistive technologies,
such as JAWS®,

Required files
JavaAccessBridge.dll
and
WindowsAccessBridge.dl
l no longer added
automatically to your
Windows path.

Add the following DLLs to your Windows
path:

JavaAccessBridge.dll
WindowsAccessBridge.dll

Error in
class.method.version

This is a generic message,
but is sometimes seen when
there are conflicts in
architecture versions of
MATLAB and Microsoft
Excel.

See “Deployment Target Architectures and
Compatibility” on page 2-4 for detailed
information.

Error:
Error IMWDispatchDriver
"Method Load of object
IMWDispatchDriver failed"

Different versions of the
MATLAB Runtime and
MATLAB results in the
IMWDispatchDriver error.

Check for the current versions of MATLAB
and the MATLAB Runtime. Verify the
MATLAB version by typing the MATLAB
path in DOS prompt. If the versions do not
match update and install the new version
of the MATLAB Runtime that matches the
current MATLAB version.

Error in VBA project:
Method xxx of object
'IClass1' failed

Multiple versions of MATLAB
running on the system
results in this error.

Register the mwcomutil.dll and
mwcommgr.dll registry files. Open a DOS
window, cd to matlabroot\bin\win64
(matlabroot represents the location of
MATLAB on your system), and run the
command
mwregsvr mwcomutil.dll
mwregsvr mwcommgr.dll

Warning: File not found.
Excel primary interop
assembly is not found.

Visual Studio does not have
Visual Studio Tools

Install Visual Studio Tools while installing
Visual Studio to access all the files and
package deployable archive with Excel
Integration target.

B Errors and Solutions

B-4



Required Locations to Develop and Use Components
Component and Target Machine

Component Development Machine Target Machine
MATLAB Runtime Make sure that matlabroot\bin

\win64 appears on your system path
ahead of any other MATLAB
installations.
(matlabroot is your root MATLAB
folder.)

Verify that
<MATLAB_RUNTIME_INSTALL_DIR>
\<ver>\runtime\<arch> appears on
your system path. For more information,
see “Set MATLAB Runtime Path for
Deployment”

Microsoft Excel Errors and Suggested Solutions
Error, Cause, and Solutions

Message Probable Cause Suggested Solution
The macros in this project are disabled.
Please refer to the online help or
documentation of the host application to
determine how to enable macros.
Note: Wording may vary depending
upon the version of Excel you are
running.

The macro security for Excel
is set to High.

Set Excel macro security to Medium on
the Security Level tab by doing the
following:

• For Microsoft Office 2003:

1 Click
Tools > Macro > Security.

2 For Security Level, select
Medium.

• For Microsoft Office 2007:

1 Click the 2007 Office button on
the Microsoft Office ribbon

( ).
2 Click Excel Options > Trust

Center > Trust Center
Settings > Macro Settings.

3 In Developer Macro Settings,
select Trust access to the
VBA project object model.

• For Microsoft Office 2010:

1 Click File > Options > Trust
Center > Trust Center
Settings > Macro Settings.

2 In Developer Macro Settings,
select Trust access to the
VBA project object model.
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Function Wizard Problems
Problems, Cause, and Suggested Solutions

Problem Probable Cause Suggested Solution
The Function Wizard Help does not
appear.

The Function Wizard Help file
(mlfunction.chm) is not in the
same folder as the Function Wizard
add-in (mlfunction.xla).

Copy the Help file
(mlfunction.chm) into the same
folder as the add-in.

The Function Wizard did not
automatically import your .bas file,
and you have to create your macro
manually

The Function Wizard has
malfunctioned with an unspecified
error

1 Open Excel
2 Do one of the following:

• If you use Microsoft Office
2007 or 2010, click
Developer > Macros.

• If you use Microsoft Office
2003, click Tools > Macros
> Macro.

3 From the Visual Basic Editor,
select File > Import and select
the created VBA file from the
<project_dir>\distrib
folder.

Tip You may need to enable the
Developer menu item before
performing this step.

If you are using Office 365:

1 Click File.
2 Click Options and select

Customize Ribbon.
3 Under Customize the

Ribbon:, select Main Tabs and
check the Developer check
box.

If you are using Microsoft Office
2007 or 2010:

1 Click the Office button on the

Microsoft Office ribbon ( )
or, in Office 2010, click File to
display the Office Backstage
View.

2 Click Excel Options.
3 In the Top Options for

Working With Excel area,
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Problem Probable Cause Suggested Solution
You get an error when trying to
create a macro with the Function
Wizard

select Show Developer tab in
the Ribbon.

The message Failed to start
MATLAB appears instead of
Starting MATLAB... when
MATLAB is invoked by the Function
Wizard.

This message may appear if you
manually terminate the MATLAB
session that is invoked from the
Function Wizard. As a result, you
can no longer use the wizard's
MATLAB related features in your
current Excel session.

Save your work and restart
Microsoft Excel.

When I use CTRL + arrow keys to
select ranges with the Function
Wizard, once I select a function and
begin to select the function inputs,
keyboard navigation no longer
works in excel.

This behavior results from a bug in
Microsoft Excel.

If you must use arrow keys to select
ranges, apply the following fix from
the Microsoft Web site: https://
mskb.pkisolutions.com/kb/291110.
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Deployment Product Terms
A

Add-in — A Microsoft Excel add-in is an executable piece of code that can be actively integrated into
a Microsoft Excel application. Add-ins are front-ends for COM components, usually written in some
form of Microsoft Visual Basic.

Application program interface (API) — A set of classes, methods, and interfaces that is used to
develop software applications. Typically an API is used to provide access to specific functionality. See
MWArray.

Application — An end user-system into which a deployed functions or solution is ultimately
integrated. Typically, the end goal for the deployment customer is integration of a deployed MATLAB
function into a larger enterprise environment application. The deployment products prepare the
MATLAB function for integration by wrapping MATLAB code with enterprise-compatible source code,
such as C, C++, C# (.NET), F#, and Java code.

Assembly — An executable bundle of code, especially in .NET.

B

Binary — See Executable.

Boxed Types — Data types used to wrap opaque C structures.

Build — See Compile.

C

Class — A user-defined type used in C++, C#, and Java, among other object-oriented languages, that
is a prototype for an object in an object-oriented language. It is analogous to a derived type in a
procedural language. A class is a set of objects which share a common structure and behavior.
Classes relate in a class hierarchy. One class is a specialization (a subclass) of another (one of its
superclasses) or comprises other classes. Some classes use other classes in a client-server
relationship. Abstract classes have no members, and concrete classes have one or more members.
Differs from a MATLAB class

Compile — In MATLAB Compiler and MATLAB Compiler SDK, to compile MATLAB code involves
generating a binary that wraps around MATLAB code, enabling it to execute in various computing
environments. For example, when MATLAB code is compiled into a Java package, a Java wrapper
provides Java code that enables the MATLAB code to execute in a Java environment.

COM component — In MATLAB Compiler, the executable back-end code behind a Microsoft Excel
add-in. In MATLAB Compiler SDK, an executable component, to be integrated with Microsoft COM
applications.

Console application — Any application that is executed from a system command prompt window.

D

Data Marshaling — Data conversion, usually from one type to another. Unless a MATLAB deployment
customer is using type-safe interfaces, data marshaling—as from mathematical data types to
MathWorks® data types such as represented by the MWArray API—must be performed manually, often
at great cost.
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Deploy — The act of integrating MATLAB code into a larger-scale computing environment, usually to
an enterprise application, and often to end users.

Deployable archive — The deployable archive is embedded by default in each binary generated by
MATLAB Compiler or MATLAB Compiler SDK. It houses the deployable package. All MATLAB-based
content in the deployable archive uses the Advanced Encryption Standard (AES) cryptosystem. See
“Additional Details”.

DLL — Dynamic link library. Microsoft's implementation of the shared library concept for Windows.
Using DLLs is much preferred over the previous technology of static (or non-dynamic) libraries,
which had to be manually linked and updated.

E

Empties — Arrays of zero (0) dimensions.

Executable — An executable bundle of code, made up of binary bits (zeros and ones) and sometimes
called a binary.

F

Fields — For this definition in the context of MATLAB Data Structures, see Structs.

Fields and Properties — In the context of .NET, Fields are specialized classes used to hold data.
Properties allow users to access class variables as if they were accessing member fields directly,
while actually implementing that access through a class method.

I

Integration — Combining deployed MATLAB code's functionality with functionality that currently
exists in an enterprise application. For example, a customer creates a mathematical model to forecast
trends in certain commodities markets. In order to use this model in a larger-scale financial
application (one written with the Microsoft .NET Framework, for instance) the deployed financial
model must be integrated with existing C# applications, run in the .NET enterprise environment.

Instance — For the definition of this term in context of MATLAB Production Server software, see
MATLAB Production Server Server Instance.

J

JAR — Java archive. In computing software, a JAR file (or Java Archive) aggregates many files into
one. Software developers use JARs to distribute Java applications or libraries, in the form of classes
and associated metadata and resources (text, images, etc.). Computer users can create or extract JAR
files using the jar command that comes with a Java Development Kit (JDK).

Java-MATLAB Interface — Known as the JMI Interface, this is the Java interface built into MATLAB
software.

JDK — The Java Development Kit is a product which provides the environment required for
programming in Java.

JMI Interface — see Java-MATLAB Interface.

JRE — Java Run-Time Environment is the part of the Java Development Kit (JDK) required to run Java
programs. It comprises the Java Virtual Machine, the Java platform core classes, and supporting files.
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It does not include the compiler, debugger, or other tools present in the JDK™. The JRE™ is the
smallest set of executables and files that constitute the standard Java platform.

M

Magic Square — A square array of integers arranged so that their sum is the same when added
vertically, horizontally, or diagonally.

MATLAB Runtime — An execution engine made up of the same shared libraries. MATLAB uses these
libraries to enable the execution of MATLAB files on systems without an installed version of MATLAB.

MATLAB Runtime singleton — See Shared MATLAB Runtime instance.

MATLAB Runtime workers — A MATLAB Runtime session. Using MATLAB Production Server
software, you have the option of specifying more than one MATLAB Runtime session, using the --
num-workers options in the server configurations file.

MATLAB Production Server Client — In the MATLAB Production Server software, clients are
applications written in a language supported by MATLAB Production Server that call deployed
functions hosted on a server.

MATLAB Production Server Configuration — An instance of the MATLAB Production Server
containing at least one server and one client. Each configuration of the software usually contains a
unique set of values in the server configuration file, main_config (MATLAB Production Server).

MATLAB Production Server Server Instance — A logical server configuration created using the mps-
new command in MATLAB Production Server software.

MATLAB Production Server Software — Product for server/client deployment of MATLAB programs
within your production systems, enabling you to incorporate numerical analytics in enterprise
applications. When you use this software, web, database, and enterprise applications connect to
MATLAB programs running on MATLAB Production Server via a lightweight client library, isolating
the MATLAB programs from your production system. MATLAB Production Server software consists of
one or more servers and clients.

Marshaling — See Data Marshaling.

mbuild — MATLAB Compiler SDK command that compiles and links C and C++ source files into
standalone applications or shared libraries. For more information, see the mbuild function reference
page.

mcc — The MATLAB command that invokes the compiler. It is the command-line equivalent of using
the compiler apps.

Method Attribute — In the context of .NET, a mechanism used to specify declarative information to
a .NET class. For example, in the context of client programming with MATLAB Production Server
software, you specify method attributes to define MATLAB structures for input and output processing.

mxArray interface — The MATLAB data type containing all MATLAB representations of standard
mathematical data types.

MWArray interface — A proxy to mxArray. An application program interface (API) for exchanging
data between your application and MATLAB. Using MWArray, you marshal data from traditional
mathematical types to a form that can be processed and understood by MATLAB data type mxArray.
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There are different implementations of the MWArray proxy for each application programming
language.

P

Package — The act of bundling the deployed MATLAB code, along with the MATLAB Runtime and
other files, into an installer that can be distributed to others. The compiler apps place the installer in
the for_redistribution subfolder. In addition to the installer, the compiler apps generate a
number of lose artifacts that can be used for testing or building a custom installer.

PID File — See Process Identification File (PID File).

Pool — A pool of threads, in the context of server management using MATLAB Production Server
software. Servers created with the software do not allocate a unique thread to each client connection.
Rather, when data is available on a connection, the required processing is scheduled on a pool, or
group, of available threads. The server configuration file option --num-threads sets the size of that
pool (the number of available request-processing threads) in the master server process.

Process Identification File (PID File) — A file that documents informational and error messages
relating to a running server instance of MATLAB Production Server software.

Program — A bundle of code that is executed to achieve a purpose. Programs usually are written to
automate repetitive operations through computer processing. Enterprise system applications usually
consist of hundreds or even thousands of smaller programs.

Properties — For this definition in the context of .NET, see Fields and Properties.

Proxy — A software design pattern typically using a class, which functions as an interface to
something else. For example, MWArray is a proxy for programmers who need to access the
underlying type mxArray.

S

Server Instance — See MATLAB Production Server Server Instance.

Shared Library — Groups of files that reside in one space on disk or memory for fast loading into
Windows applications. Dynamic-link libraries (DLLs) are Microsoft's implementation of the shared
library concept for Microsoft Windows.

Shared MATLAB Runtime instance — When using MATLAB Compiler SDK, you can create a shared
MATLAB Runtime instance, also known as a singleton. When you invoke MATLAB Compiler with the -
S option through the compiler (using either mcc or a compiler app), a single MATLAB Runtime
instance is created for each COM component or Java package in an application. You reuse this
instance by sharing it among all subsequent class instances. Such sharing results in more efficient
memory usage and eliminates the MATLAB Runtime startup cost in each subsequent class
instantiation. All class instances share a single MATLAB workspace and share global variables in the
deployed MATLAB files. MATLAB Compiler SDK creates singletons by default for .NET assemblies.
MATLAB Compiler creates singletons by default for the COM components used by the Excel add-ins.

State — The present condition of MATLAB, or the MATLAB Runtime. MATLAB functions often carry
state in the form of variable values. The MATLAB workspace itself also maintains information about
global variables and path settings. When deploying functions that carry state, you must often take
additional steps to ensure state retention when deploying applications that use such functions.
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Structs — MATLAB Structures. Structs are MATLAB arrays with elements that you access using
textual field designators. Fields are data containers that store data of a specific MATLAB type.

System Compiler — A key part of Interactive Development Environments (IDEs) such as Microsoft
Visual Studio.

T

Thread — A portion of a program that can run independently of and concurrently with other portions
of the program. See pool for additional information on managing the number of processing threads
available to a server instance.

Type-safe interface — An API that minimizes explicit type conversions by hiding the MWArray type
from the calling application.

W

Web Application Archive (WAR) —In computing, a Web Application Archive is a JAR file used to
distribute a collection of JavaServer pages, servlets, Java classes, XML files, tag libraries, and static
web pages that together constitute a web application.

Webfigure — A MathWorks representation of a MATLAB figure, rendered on the web. Using the
WebFigures feature, you display MATLAB figures on a website for graphical manipulation by end
users. This enables them to use their graphical applications from anywhere on the web, without the
need to download MATLAB or other tools that can consume costly resources.

Windows Communication Foundation (WCF) — The Windows Communication Foundation™ is an
application programming interface in the .NET Framework for building connected, service-oriented,
web-centric applications. WCF is designed in accordance with service oriented architecture
principles to support distributed computing where services are consumed by client applications.
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